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WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to 
personal injury or death, property damage, or economic loss. 

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 
temperatures. 

FactoryTalk Batch Getting Results Guide 
 

Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 
 

 

 

IMPORTANT Identifies information that is critical for successful application and understanding of the product. 
 

Labels may also be on or inside the equipment to provide specific precautions. 
 

 

 

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash 
will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and 
for Personal Protective Equipment (PPE). 

 

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are not in 
alignment with the movement toward inclusive language in technology. We are proactively collaborating with industry peers to 
find alternatives to such terms and making changes to our products and content. Please excuse the use of such terms in our 
content while we implement these changes. 
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Summary of changes in FactoryTalk Batch Getting Results Guide 
 

 

This publication contains the following new or updated information. This list 
includes substantive updates only and is not intended to reflect all changes. 

 

Topic Reason for change 

FactoryTalk Batch on page 15 Functional change 
FactoryTalk Batch View on page 59 Functional change 
FactoryTalk Batch View HMI Controls on page 113 Functional change 
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About this manual 

 
 
 
 
 
 

Document organization 

 
 
 
 
 
 
 

Legal Notices 

Preface 

This information was developed to introduce you to the basics of automated 
batch manufacturing and the FactoryTalk® Batch product components. This 
manual is one of a set of related manuals that describe installing, 
programming, and operating the FactoryTalk® Batch system. 

To review FactoryTalk Batch release notes and latest information regarding 
product compatibility refer to the Product Compatibility and Download 
Center (PCDC). 

 
 
 
 

 
The information in this document is presented in an order that should 
minimize the effort required to obtain a basic overview of Batch. 

The following subjects are presented in this document: 

• FactoryTalk Batch Documentation 
• Modular Batch Automation 
• FactoryTalk Batch Components 
• FactoryTalk Batch Server 
• FactoryTalk Batch Equipment Editor 
• FactoryTalk Batch Recipe Editor 
• FactoryTalk Batch View 
• FactoryTalk Event Archiver 
• ActiveX Controls 
• PC-Based Phases 
• Glossary of Terms 

Rockwell Automation publishes legal notices, such as privacy policies, license 
agreements, trademark disclosures, and other terms and conditions on the 
Legal Notices page of the Rockwell Automation website. 

 

End User License Agreement (EULA) 
You can view the Rockwell Automation End User License Agreement (EULA) 
by opening the license.rtf file located in your product's install folder. 

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf 

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
https://www.rockwellautomation.com/global/legal-notices/overview.page
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Open Source Software Licenses 
The software included in this product contains copyrighted software that is 
licensed under one or more open-source licenses. 

You can view a full list of all open-source software used in this product and 
their corresponding licenses by opening the oss_license.txt file located your 
product's OPENSOURCE folder on your hard drive. This file is divided into 
these sections: 

• Components 
Includes the name of the open-source component, its version number, 
and the type of license. 

• Copyright Text 
Includes the name of the open-source component, its version number, 
and the copyright declaration. 

• Licenses 
Includes the name of the license, the list of open-source components 
citing the license, and the terms of the license. 

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\<product 
name>\Release Notes\OPENSOURCE\oss_licenses.txt 

You may obtain Corresponding Source code for open-source packages 
included in this product from their respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: http://www.rockwellautomation.com/global/about- 
us/contact/contact.page. Please include "Open Source" as part of the request 
text. 

 
 

Additional resources Following is a comprehensive list of documentation for the FactoryTalk® 
Batch products from Rockwell Automation. 

 

Installation, Quick Start, and Getting Results Guides 
 

Resource Description 

FactoryTalk Batch Components Installation and 
Upgrade Guide 
(BATCH-IN002) 

Provides information and procedures for FactoryTalk Batch system installation. 
Includes information for FactoryTalk Batch Material Manager, FactoryTalk Event 
Archiver, and associated FactoryTalk Batch Client and Server components. 

FactoryTalk Batch View Quick Start 
Guide (FTBVS-QS001) 

Provides information about using FactoryTalk Batch View to create, view, and 
command control recipes, acknowledge prompts and signatures, view equipment 
phases and diagnostic information, and view profile information. 

http://www.rockwellautomation.com/global/about-us/contact/contact.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
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Resource Description 

FactoryTalk Batch View HMI Controls Quick 
Start Guide 
(BATCH-QS001D) 

Provides a general overview of FactoryTalk Batch View HMI Controls. 

FactoryTalk Batch eProcedure® Getting Results 
Guide (BWEPRO-GR011) 

Explains the basics of FactoryTalk Batch eProcedure. 

FactoryTalk Batch Getting Results 
Guide (BATCH-GR011) 

Introduces the basics of automated batch manufacturing and the FactoryTalk Batch 
product components. 

FactoryTalk Batch Material Manager Getting Results 
Guide 
(BWMTR-GR011) 

Introduces the basics of FactoryTalk Batch Material Manager. 

 

User Guides 
Resource Description 

FactoryTalk Batch Material Editor User 
Guide (BWMTR-UM001) 

Provides access to information and procedural instructions required to configure 
materials and the containers to hold them. The material data is stored in the 
material database, which is used to create material-based recipes. This 
information is intended as a reference for formulators. 

FactoryTalk Batch Equipment Editor User 
Guide (BATCH-UM004) 

Provides information on creating and maintaining an equipment database (area 
model). The area model is available to all other FactoryTalk Batch programs, 
including the Recipe Editor, Batch View, and Phase Simulator. 

FactoryTalk Batch PhaseManager™ User 
Guide (BATCHX-UM011) 

Describes the integration of the FactoryTalk Batch software with the Studio 5000 
Logix Designer® application and the Logix 5000™ family of controllers. 
The integration simplifies the configuration and maintenance of the FactoryTalk 
Batch automation system, provides better communication between the 
FactoryTalk Batch Server and the Logix 5000 controller, and significantly reduces 
the programming effort required to develop the phase logic code that resides in 
your Logix 5000 controller. 

FactoryTalk Batch Recipe Editor User 
Guide (BATCH-UM006) 

Provides instructions on using FactoryTalk Batch Recipe Editor to create and 
configure master recipes for use in batch automation. The interface is based on 
IEC 61131-3 sequential function charts to organize recipes graphically into 
procedures, unit procedures, operations, and phases. Build recipes using either 
the SFC format or a table-based format. 

FactoryTalk Batch View HMI Controls User 
Manual (FTBVS-UM003) 

Provides details about using FactoryTalk Batch View HMI Controls to monitor and 
interact with the production process within a FactoryTalk View SE Display Client. 

FactoryTalk Batch View User 
Manual (FTBVS-UM002) 

Provides information and procedural instructions for using FactoryTalk Batch View 
in a modern and intuitive portal into a comprehensive batching solution for 
effective operations, leveraging its own web server using HTML5 technology to 
provide connectivity into a FactoryTalk Batch Server. 

FactoryTalk Event Archiver User Guide (BATCH- 
UM012) 

Provides information and instructions specific to the FactoryTalk Event Archiver. 
Intended for use by system administrators and production supervisors. 

 
Administrator Guides 

Resource Description 
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FactoryTalk Batch Administrator 
Guide (BATCH-UM003) 

Provides instructions for configuring security and services, and implementation and 
use of components not typically accessed or used by batch operators, such as the 
FactoryTalk Batch Server. 
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Resource Description 

FactoryTalk Batch eProcedure Administrator 
Guide (BWEPRO-UM011) 

Provides procedures specific to FactoryTalk Batch eProcedure, such as implementing 
security and configuring the user-defined area Active Server Page. 
Included are instructions for tasks specific to FactoryTalk Batch, such as configuring 
security and services to support FactoryTalk Batch eProcedure. Provides instructions 
on the implementation and use of components not typically accessed or used by 
batch 
operators, such as the FactoryTalk Batch Server. 

FactoryTalk Batch Material Manager Administrator 
Guide 
(BWEPRO-UM011) 

Provides information and instructions specific to FactoryTalk Batch Material Manager. 
Intended for use by system administrators and database administrators. 

 

Reference Guides 
Resource Description 

FactoryTalk Batch Material Server API Technical 
Reference 
(BWMTR-RM001) 

Provides access to information regarding the interface between the FactoryTalk Batch 
Material Server and the FactoryTalk Batch Material Editor and FactoryTalk Batch. It is 
intended to be used as a reference information by custom interface developers. 

FactoryTalk Batch PCD Programming 
Reference Manual 
(BATCH-RM004) 

Provides information and instructions about the FactoryTalk Batch PCD interface 
design. It is intended to be used as a reference guide for PCD programmers. 

FactoryTalk Batch Server API Reference 
Manual (BATCH-RM003) 

Provides information regarding the interface between the FactoryTalk Batch Server 
and FactoryTalk Batch View — the Server Application Programming Interface (API). It 
is intended to be used as a reference guide by custom interface developers. 

FactoryTalk Batch System Files Reference 
Manual (BATCH-RM005) 

Provides the technical information for configuration and maintenance of a 
FactoryTalk Batch system. It can be used as a reference information for 
implementation engineers and system administrators. 

FactoryTalk Batch eProcedure Instruction File 
Design Reference Manual 
(BWEPRO-RM001) 

Includes information about the building of instruction files for use in equipment 
database creation and recipe development. This information is intended to be used 
as a reference by instruction file authors. 

View or download publications at 
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact your local Allen-Bradley® distributor or 
sales representative. 

https://www.rockwellautomation.com/literature
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Chapter 1 
 
 

FactoryTalk Batch 

 
As part of the FactoryTalk family, the FactoryTalk Batch components increase 
overall plant efficiency by delivering the visibility, control, and reporting you 
need to optimize manufacturing. With coordinated execution, you can reduce 
scrap and rework and improve product quality and consistency. Through real- 
time management of equipment utilization, you can maximize your return on 
assets. By implementing optimized recipes and procedures, you can increase 
your plant capacity. By using electronic, paperless operations, you can 
improve your productivity. You also reduce compliance costs by using 
electronic batch record implementation, paperless manufacturing, and 
quality sign-offs. By lifting the compliance burden from manufacturing, you 
reduce inventory levels and cycle times, which greatly improves customer 
service. 

The FactoryTalk Batch components help you optimize plant floor operations, 
giving you quick return on your net assets. New product definitions are 
deployed quickly into manufacturing. Production order information is 
accurate. Business and plant-level control systems are tightly coordinated and 
multiple sites operate as a team. FactoryTalk Batch components are an open, 
configurable set of products that help you define, manage, monitor, and 
control manufacturing at local, remote, or contractor plants. You can deploy 
any of the FactoryTalk Batch components wherever you need them, one at a 
time or all at once, to improve productivity and plant control. The FactoryTalk 
Batch components include: 

• FactoryTalk Batch Server 
• FactoryTalk Batch Recipe Editor 
• FactoryTalk Batch Equipment Editor 
• FactoryTalk® Batch View 
• FactoryTalk Batch View HMI Controls 
• FactoryTalk Event Archiver 
• FactoryTalk Batch Network Editor 
• FactoryTalk Batch Enterprise Integration Server 
• eProcedure® Server and Client components 
• FactoryTalk Batch Material Manager 

 

What is FactoryTalk Batch? 
 

To see the true value of a FactoryTalk Batch solution, become familiar with 
Modular Batch Automation and how it relates to the ISA S88.01 International 
Batch Control Standard. The next section is a brief overview of modular batch 
automation. 
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Modular Batch Automation 

 
 
 
 
 
 
 
 
 
 
 
 

 
FactoryTalk Batch 
Equipment Editor example 

In the late 1980s, the Instrument Society of America (ISA) started the SP88 
committee to establish a set of standards for batch control. One of the most 
important terms that has been associated with this standard is Modular Batch 
Automation (MBA). Using the modular approach, a batch process is defined 
by a sequence of small modules rather than by a large, cumbersome, 
monolithic program. The initial step in implementing MBA is to separate the 
batch process into two models: Equipment and Procedural. This separation 
provides for a more efficient means of developing and modifying an 
automated batch process. Modularizing your equipment and procedures 
allows you to create re-usable components. 

This diagram shows the relationship between the S88.01 models and the 
FactoryTalk Batch Editors. The FactoryTalk Batch Equipment Editor and 
FactoryTalk Batch Recipe Editor are tied together at the Phase level. 

 

 

As an example, you create a reactor unit in the FactoryTalk Batch Equipment 
Editor. The reactor unit, which is displayed here, contains six phases that are 
used to perform individual actions (adding various ingredients, mixing- 
heating-transferring the contents of the reactor, etc.). Once the unit and its 
associated phases are defined in the FactoryTalk Batch Equipment Editor, you 
are ready to use the FactoryTalk Batch Recipe Editor to create operations for 
this reactor to execute. 
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FactoryTalk Batch Recipe 
Editor example 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Who uses FactoryTalk 
Batch? 

To continue the example in the FactoryTalk Batch Recipe Editor, you create 
two operations, Reaction_1 and Clean_In_Place, which are shown below. The 
Reaction_1 operation transfers Material A into the reactor, agitates the 
contents for 15 minutes at 5 RPM, and then dumps the contents into Storage 
Unit A. The Clean_in_Place operation transfers water into the reactor, agitates 
the contents for 60 minutes at 7 RPM, and then dumps the contents as Waste 
Water. 

Both operations use the same phases but in a different way. You control how 
the phase operates through the use of parameters, such as speed and time as 
shown in the AGITATE:1 phase. 

 

For more information regarding how FactoryTalk Batch applies the ISA S88.01 
concepts, contact your Rockwell Sales Representative. For a copy of the S88.01 
document, write to: ISA, 67 Alexander Drive, P.O. Box 12277, Research 
Triangle Park, NC 27709 

 

FactoryTalk Batch organizes information for a number of different 
occupational roles: 

• Process Engineer: Uses the FactoryTalk Batch Equipment Editor to 
create an area model that captures all capabilities of the specific plant. 

• Control Systems Engineer: Understands the specific control system 
being used and links the control system with FactoryTalk Batch. 

• Formulator: Uses the FactoryTalk Batch Recipe Editor to create master 
recipes that run against the area model of the plant. 

 

IMPORTANT Separation of the Equipment and Procedural models allows for greater 
protection of a company’s intellectual property. When implementing a project 
with FactoryTalk Batch, engineers responsible for configuring the equipment 
in the plant don’t need access to the recipes. They are only responsible for 
designing equipment-specific phases (optimizing the physical capabilities of 
the plant). The 

 recipes remain in the hands of the formulators (usually company employees).  
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• Operator: Uses the FactoryTalk Batch View and/or ActiveX controls to 
schedule, start, and stop batches. Also uses a third-party human 
machine interface (HMI) software package to view the physical plant 
(pumps, valves, etc.). Can also review past batches and make 
parameter adjustments online. 

• The facility operator is the user of the designated equipment. 
• The operator is the recipient of requests for parameter data 

deferred to the operator. 
• The operator is the default owner of a resource if the facility 

operator is manually arbitrating between resources. 

• MIS Administrator: Interacts with the uploaded event journals to 
create batch reports and monitor material usage. The FactoryTalk 
Event Archiver can upload batch data to a Microsoft SQL database. 

Make sure that all user accounts have been created and given the necessary 
permissions before attempting the procedures in this guide. For more 
information, see the FactoryTalk Batch Components Installation and Upgrade 
Guide. 

 
 

Reference guidelines and 
standards 

The following is a list of reference documents that may be consulted for more 
complete information. 

• NAMUR Guidelines "Normen Arbeitsgemeinschaft für Mess-ûnd 
Regeltechnik in der Chemischen Industrie" 
Standard that defines the terminology used to describe modular batch 
automation’s component parts. 

• IEC 61131-3 "Programmable Controllers, Programming Languages" 
Standard that describes sequential function charts. 

• ISA’s S88.01 "Batch Control, Models and Terminology" 
Standard which describes the standard terminology used to describe 
modular batch automation's component parts. 

• ISA’s ANSI/ISA–95.00.01–2000 "Enterprise-Control System 
Integration Part 1: Models and Terminology" 
Standard that describes the relevant functions in the enterprise and 
the control domain and which objects are normally exchanged 
between these domains. 

• ISA’s ANSI/ISA–95.00.02–2001 "Enterprise-Control System 
Integration Part 2: Object Model Attributes" 
Standard that defines the details of the interface content between 
manufacturing control functions and other enterprise functions. 
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FactoryTalk Batch 
Components 

FactoryTalk Batch Server 

 
 
 
 
 
 

 
FactoryTalk Batch Recipe 
Editor 

FactoryTalk Batch comes with several components that interact with each 
other to design, create, configure and run batch recipes. 

 

The FactoryTalk Batch Server is the engine that runs FactoryTalk Batch. It is 
the component that controls system information, phases and recipes. The 
server allows integration with process-connected devices (PCDs) and third- 
party software packages. Prior to opening FactoryTalk Batch View, the 
FactoryTalk Batch Server must be running and remain active during all batch 
functions. 

The FactoryTalk Batch Server operates as a Windows service, which means 
that the FactoryTalk Batch Server can be configured to start automatically and 
that control of the FactoryTalk Batch Server can be given to the Windows 
Service Manager. Because the FactoryTalk Batch Server runs as a service, it 
does not require an operator to log on to run. Therefore, logging on or off 
Windows during operation does not disrupt the performance of the 
FactoryTalk Batch Server. 

 

The FactoryTalk Batch Recipe Editor is used to graphically create and 
configure recipes. 

• The interface is based on IEC 61131-3 sequential function charts (SFC) 
that graphically organizes recipes into procedures, unit procedures, 
operations and phases along with any applicable comments. 

• In addition to the SFC view, the FactoryTalk Batch Recipe Editor offers 
a table view. Table-based recipes provide a mechanism for creating 
simple recipes that do not require a complex recipe structure or 
elaborate transition expressions. Additionally, you can view table- 
based recipes and edit all recipe parameters without having to navigate 
between steps. 

• The FactoryTalk Batch Recipe Editor allows you to specify sequences of 
phases. The actual phase logic must be configured in the process- 
connected device (PCD) while the interface to the PCD must be 
configured in the FactoryTalk Batch Equipment Editor. 

• Recipe reports can be generated in SFC and/or descriptive format. 
• If Recipe Approvals are enabled in the underlying area model, approval 

signoffs are executed in the FactoryTalk Batch Recipe Editor. 
• When Recipe Version Control is enabled, a version of a recipe (a read- 

only, numbered snapshot of a recipe) can be saved and protected from 
further editing. New work-in-progress (WIP) copies of a version allow 
the recipe author to continue to make changes and updates to a recipe. 
When a versioned recipe no longer matches the underlying area 
model, or references a deleted or non-existent sub-recipe, it is marked 
as obsolete. 
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FactoryTalk Batch 
Equipment Editor 

 
 
 
 
 
 
 
 
 
 
 
 

 
FactoryTalk Batch View 

The FactoryTalk Batch Equipment Editor is a graphical interface through 
which a database of process equipment is defined and maintained (an area 
model). 

• Components defined in the FactoryTalk Batch Equipment Editor are 
used to interface with process-connected devices (PCDs) in the facility. 
During recipe configuration, the area model provides a list of available 
units and phase classes. 

• Configure phases and commands to trigger an electronic signature 
request when a report or recipe parameter is out of range (parameter 
deviation), or when specific commands are executed on a batch (such 
as Abort Batch or Active Step Change). 

• During recipe verification, the area model confirms that the 
designated equipment is capable of executing the procedures. 

• During recipe execution, resource arbitration functions use the area 
model to allocate equipment based on recipe and operator requests. 

• The area model is available to all other FactoryTalk Batch applications. 

In addition to the area model, the FactoryTalk Batch Equipment Editor allows 
configuration of the following: 

• Communication functions 
• Electronic signatures 
• Enumeration sets 
• Data servers 
• Recipe approvals 
• Recipe version control 
• FactoryTalk Event Archiver functions 

 
Use FactoryTalk® Batch View to initiate and control the batch process. A batch 
is a running control recipe. The material produced by a single execution of a 
recipe is also considered a batch. 

• Use Batches to create, view, and command a control recipe, observe 
the execution of a single recipe, and bind units for class-based recipes. 
Once a control recipe is created, it remains in the Batches list until it is 
removed or until the FactoryTalk Batch Server is restarted with a cold 
boot. A graphical representation of a running batch and its associated 
data is displayed. 

• Use Prompts to alert operators to value requests for parameters, unit 
binding, material binding, and signatures or manual instructions. A 
control recipe cannot complete execution until the operator provides 
the requested information. In most cases, pending requests for 
information (value prompts, signatures, or manual instructions) are 
not acknowledged until a user either provides the information or stops 
or aborts the control recipe. 
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FactoryTalk Event Archiver 

 
 
 
 
 

FactoryTalk Batch Network 
Editor 

 
 

 
FactoryTalk eProcedure 
Server 

• Value prompts alert operators to requests for parameter values, unit 
binding, and material phase/container binding. 

• Signatures are requests for signoffs that require user permissions 
and optional comments. When a signature is generated against a 
control recipe, acknowledge the signature by completing the 
associated signoffs. The requested user information in a signature 
is determined by the signature template defined in the area model. 

• Instructions are individual steps of a manually executed phase. As a 
batch executes, the instruction for each active step appears. 
Instructions execute in the order specified within the master recipe. 

• Use Equipment for an equipment-centric view of the defined area 
model. There are three levels of equipment: process cell, unit, and 
phase. 

• Use Diagnostics to view server and service status, server performance, 
server statistics, arbitration, and journals. 

• Use Profile to change the default language, view assigned groups, 
enable or disable the minimal view, and view authorization settings 

For more information on using these features, see FactoryTalk Batch View 
Help. 

The FactoryTalk Event Archiver’s purpose is to translate the FactoryTalk Batch 
tab-delimited ASCII electronic batch record files to a user-specified file type. 
These electronic batch record files are maintained separately for each batch 
created and viewed with a word processor or spreadsheet. Many plants have 
standardized on one of the many commercially available Relational Database 
Management System (RDBMS) software packages. We recommend using a 
high-performance database, such as SQL Server, due to their better 
robustness and performance. The Archiver collects data from each electronic 
batch record file and stores it in the specified RDBMS database format. 

 

The FactoryTalk Batch Network Editor is a utility that indicates where other 
FactoryTalk Batch and FactoryTalk Batch Material servers are located on the 
network. This network configuration allows for ease of integration with other 
FactoryTalk Batch components and simplifies the process of reconfiguring a 
multi-computer system. If FactoryTalk Batch Material Manager is also 
installed the FactoryTalk Batch Network Editor is also used to indicate the 
location of the material database. 

 

The FactoryTalk eProcedure Server provides the services to the FactoryTalk 
Batch Server to enable the use of HTML instruction files. Prior to connecting 
a client to FactoryTalk eProcedure, FactoryTalk eProcedure Server must be 
running and remain active during all batch functions. 
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FactoryTalk Batch Material 
Server 

FactoryTalk Batch Material Manager is used to track material consumption in 
batch recipes. It consists of two components: Material Server and Material 
Editor. 

The Material Editor provides an interface to help you create the material 
database, which consists of material, lot, sublot, container, and storage 
location data. The Material Server provides the communication between the 
material database and the FactoryTalk Batch Server. During a batch run, 
information about available containers is presented to the operator for 
binding decisions. Binding is the process of mapping steps within a control 
recipe to actual equipment in a plant. After a batch is run, quantities 
consumed or distributed are updated in the material database for use in 
inventory tracking. 

The Material Server consists of a group of components that work together to 
service various applications. The primary applications that the Material Server 
services are the Material Editor, FactoryTalk Batch Server, FactoryTalk Batch 
Recipe Editor, and FactoryTalk Batch Equipment Editor. Any third-party 
application can also use custom solutions based on the exposed Material 
Object Model (MOM). 

 

The Material Editor provides an interface to help you create the material 
database, which consists of material, lot, sublot, container, and storage 
location data. The Material Server provides the communication between the 
material database and the FactoryTalk Batch Server. During a batch run, 
information about available containers is presented to the operator for 
binding decisions. Binding is the process of mapping steps within a control 
recipe to actual equipment in a plant. After a batch is run, quantities 
consumed or distributed are updated in the material database for use in 
inventory tracking. 

 

The Material Server consists of a group of components that work together to 
service various applications. The primary applications that the Material 
Server services are the Material Editor, FactoryTalk Batch Server, FactoryTalk 
Batch Recipe Editor, FactoryTalk Batch Equipment Editor, and the Storage 
Container ActiveX control. Any third-party application can also use custom 
solutions based on the exposed Material Object Model (MOM). 
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Chapter 2 
 
 

FactoryTalk Batch Server 

 
For ease of understanding, and for tutorial purposes, this guide refers to 
configuring and using the sample files that are installed with FactoryTalk 
Batch. The SampleDemo folders contain complete area models and recipes for 
a simulated plant. Before running the demonstrations, you must add a 
FactoryTalk Security user, configure the FactoryTalk Batch Server to 
recognize the required project directories, select the initialization path and 
file name, and then start the FactoryTalk Batch Server and the FactoryTalk 
Batch Phase Simulator. 

Tip: This guide outlines the configuration and use of the SampleDemo1 demonstration files. 
Because these files are used as an example throughout the guide, it is recommended that you 
follow the directions for using this demonstration step by step. 

 

FactoryTalk Batch Server 
overview 

 
The FactoryTalk Batch Server is the engine that runs FactoryTalk Batch. It is 
this component that allows integration with the process-connected devices 
(PCDs) and third-party software packages. 

The FactoryTalk Batch Server operates as a Windows Service, which means 
you can configure the Server to start automatically and give control of the 
Server service to the Windows Service Manager. Because the FactoryTalk 
Batch Server runs as a service, logging on or off Windows during operation 
does not disrupt the operation of the Server. 

Using the FactoryTalk Batch Service Manager, you can control the FactoryTalk 
Batch Server manually, select the boot method for the Server, and configure 
the Server to run in Demo mode. Use the FactoryTalk Batch Equipment Editor 
to configure the FactoryTalk Batch Server. 

The FactoryTalk Batch Server coordinates the following functions: 

• Creating a Batch: Transforms the configured recipe into an executable 
working recipe. 

• Executing a Recipe: Communicates with the process-connected 
devices to execute phases. 

• Arbitrating Equipment: Allocates resources based on recipe and 
operator requirements. 

• Collecting Data: Gathers and stores production information for 
reporting and archiving. 

• Performing Client Communications: Transfers data between the 
process-connected devices (PCDs), operator displays, Human Machine 
Interfaces (HMIs), databases, and various other software packages. 
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See the FactoryTalk Batch Equipment Editor User Guide and the FactoryTalk Batch 
Administrator Guide for more detailed information about the FactoryTalk Batch 
Server. 

 

Sample demonstration setup 

 
 

 
Add sample FactoryTalk 
Security users 

 
The installation process placed the SampleDemo1 and SampleDemo2 folders in 
the BATCHCTL share on your hard drive. Within each of these SampleDemo 
folders are four subfolders that contain the files for the area model. To run the 
sample demonstrations, add a FactoryTalk Security user, configure the 
FactoryTalk Batch Server to locate the area model, and then verify the recipes 
in the area model. 

 

For the sample demonstrations file, create FactoryTalk user accounts for an 
operator and an engineer. Create these user accounts in the FactoryTalk 
Directory. 

 

To add sample FactoryTalk Security users: 
1. Select Start > Rockwell Software > FactoryTalk Administration 

Console. The Select FactoryTalk Directory dialog box opens. 
 

 IMPORTANT Administrator privileges are required to perform this procedure.  
 

2. Select Network to add this user account to the FactoryTalk Network 
Directory, and select OK. 

3. If not already logged on to the FactoryTalk Network Directory, the Log 
On to FactoryTalk dialog box opens. In User name, type the user name 
for the Administrator that was configured when the FactoryTalk 
Services Platform was installed. 

 

4. In Password, type the password for the Administrator. 
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5. Verify the Directory and select OK. The FactoryTalk Administration 
Console window opens and displays the specified FactoryTalk 
Directory. 

6. Expand Users and Groups. 
7. Right-click the Users folder, and select New > User to create a new 

FactoryTalk Security user account in FactoryTalk Directory. 
 

8. The New User dialog box opens and displays the General tab. In the 
User name box, type OPER. 

 

9. In Full name, type Operator. 
10. In Password, type password, and confirm it by re-entering password 

in the Confirm Password box. 
11. Select Create. 
12. Repeat steps 7-11, but this time in the User Name field, enter ENG and 

in the Full Name field, enter Engineer. 
13. Keep the FactoryTalk Administration Console open to configure 

permissions for these FactoryTalk Security users in the next exercise. 
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Configure sample 
permissions for FactoryTalk 
Security users 

After creating the FactoryTalk security users, set up access modes for each 
FactoryTalk Batch component to specify which users are permitted to view or 
perform actions. Configure security settings in the FactoryTalk 
Administration Console. To tighten security in the client, remove the All 
Users group from the Full Edit policy setting. 

 
To configure sample permissions for FactoryTalk Security users: 

1. In the FactoryTalk Administration Console Explorer pane, navigate to 
System > Policies > Product Policies > Batch > Equipment Editor > 
Access Modes. 

2. Right-click Access Modes, and then select Properties. The Access 
Modes Properties dialog box opens. 

 

3. In the Full Edit row, select the Configure Security browse button. The 
Configure Securable Action dialog box opens. 

4. Select Add. The Select User and Computer dialog box opens. 
5. In the Filter Users box, select Show All. 
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6. In Users, select ENG. 
 

7. Select OK. The Configure Securable Action dialog box is updated, 
showing ENG in the list of Users with the Allow checkbox selected. 

 

8. Select OK to close the Configure Securable Action dialog box. 
9. In the Access Modes Properties dialog box, select View Only. 
10. In the View Only row, select the Configure Security browse button. 

The Configure Securable Action dialog box opens. 
11. Select Add. The Select User and Computer dialog box opens. 
12. In the Filter Users box, select Show All. 
13. In Users, select OPER. 
14. Select OK. The Configure Securable Action dialog box is updated, 

showing OPER in the list of Users with the Allow checkbox selected. 
15. Select OK to close the Configure Securable Action dialog box. 
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16. Select OK to close the Access Modes Properties dialog box. 

See the FactoryTalk Batch Administrator Guide for more information on security. 
 
 

Configure the sample 
FactoryTalk Batch Server 

To set up the sample demonstrations, configure the FactoryTalk Batch Server 
to locate the folders that contain the demonstration files and to the \Restart 
and bin folders where the FactoryTalk Batch Server writes data upon system 
failure. Configure the FactoryTalk Batch Server in the FactoryTalk Batch 
Equipment Editor. 

 

To configure the sample FactoryTalk Batch Server: 
1. Select Start > Rockwell Software > Equipment Editor. The FactoryTalk 

Batch Equipment Editor opens (log on to FactoryTalk if prompted). 
IMPORTANT Administrator privileges are required to perform this 

procedure. 
 

2. Select Options > Server Options. The Server Options dialog box opens 
to the Project Settings tab. 

 

3. In the Project Directories area, select the Primary Journal browse 
button. The Select Directory dialog box opens. 

4. From the Look in list, select the SampleDemo1\Journals folder, and 
then select Open. 

5. Select the Error Logging browse button. The Select Directory dialog 
box opens. 

6. From the Look in list, select the SampleDemo1\Logs folder, and then 
select Open. 

7. Click the Instructions browse button. The Select Directory dialog box 
opens. 

 

IMPORTANT In order for the eProcedure Server to start, you must define the instruction 
path and an instruction file for each instruction-based phase in the area 
model. (See the FactoryTalk Batch Equipment Editor User Guide for 
instructions on defining instruction-based phases.) 

 

8. Select the Equipment Database browse button. The Select Equipment 
Database dialog box opens. 
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9. From the Look in list, open the SampleDemo1\ Recipes folder, select 
the ice_cream1.cfg file, and then select Open. 

10. In the Store Recipes Using area, select Binary Files, and then select the 
Recipe Directory browse button. The Select Directory dialog box 
opens. 

11. From the Look in list, select the SampleDemo1\Recipes folder, and 
then select Open. 

12. Select the Restart Control tab. 
 

13. Select the Primary Path browse button. The Select Directory dialog 
box opens. 

14. From the Look in list, select the SampleDemo1\Restart folder, and 
then select Open. 

15. Select the Secondary Path browse button. The Select Directory dialog 
box opens. 

16. From the Look in list, select the Bin folder. 
17. Select the Batch Reporting tab. Leave Never (No Queue) as the default 

reporting application. 
 

18. Select OK to close the Server Options dialog box. 
19. Select File >Exit to exit the FactoryTalk Batch Equipment Editor. 

Tip: These steps set up the FactoryTalk Batch Server to run the tutorial steps in this 
manual. There are many other settings to consider when setting up the FactoryTalk Batch 
system. (See the FactoryTalk Batch Administrator Guide for more information on the 
Server Options 
dialog box.) 
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Rebuild the recipe directory To run the demonstration recipes, you must rebuild the recipe directory and 
verify the recipes in the area model using the FactoryTalk Batch Recipe 
Editor. 

 
 

IMPORTANT Administrator privileges are required to perform this procedure. 
 

 

To rebuild the recipe directory: 
1. Select Start > Rockwell Software > Recipe Editor. The FactoryTalk 

Batch Recipe Editor reads the area model. 
Tip: If you are logged in with an account that does not have administrator privileges, right-click 
Recipe Editor and select More > Run as administrator to run under elevated privileges. 

2. If prompted, log on to FactoryTalk. If a message displays asking you to 
verify the recipes, select Cancel. 

3. Select File > Rebuild Recipe Directory. When the rebuild is complete, 
select OK, and then select Yes to verify the recipes. 

4. When the recipe verification is complete, select Accept to save the 
recipes, and then select Close. 

5. Select File > Exit to exit the FactoryTalk Batch Recipe Editor. 
 

Start the FactoryTalk Batch 
Server service 

 
The FactoryTalk Batch Service Manager communicates with the Windows 
Services of the selected computer to determine available services. There may 
be a noticeable delay as communications are established, marked by the 
cursor displayed as an hourglass. If the FactoryTalk Batch Service Manager 
cannot communicate with the selected computer’s Windows Services, a 
message box is displayed stating that the FactoryTalk Batch Service Manager 
failed to connect to the specified computer. 

The FactoryTalk Batch Phase Simulator must be running to test FactoryTalk 
Batch in a demo environment. For more information, see The FactoryTalk 
Batch Phase Simulator in the FactoryTalk Batch Administrator Guide. 

 

IMPORTANT The FactoryTalk Batch Server cannot start if Security Authority is enabled and there is a 
mismatch between the Security Authority Identifiers (SAIs) in the area model and the 
FactoryTalk Network Directory. For information on your recovery options, see 
Troubleshooting in the FactoryTalk Batch Equipment Editor User Guide. 

 

 

To start the FactoryTalk Batch Server service: 
1. Select Start > Rockwell Software > Batch Service Manager. The Batch 

Service Manager opens. 
2. Select Select Computer. The Select Computer dialog box opens.  

IMPORTANT Administrator privileges are required to perform this procedure. 
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3. In the Enter the object name to select area, enter the name of the 
computer where the FactoryTalk Batch Server is installed (or select the 
Advanced button to search for a computer). 

4. Select OK to close the Select Computer dialog box. 
5. From the Service list, select FactoryTalk Batch Server. 
6. (optional) Select Allow Demo Mode if you want to run FactoryTalk 

Batch in demo mode. If you run FactoryTalk Batch in the demo mode, 
be aware that the Server stops after 2 hours of operation. 

7. Select the method to use for restarting the server after a service halt. 

• Cold Boot: Restarts the server in a cold state. All journal data or 
recipe content is erased upon startup. If Security Authority is 
enabled, SAIs in a secured area model and any secured recipes must 
match the current Network FactoryTalk Directory SAI. 

• Warm Boot: Restarts the server, restoring the set of batches that 
were on the batch list when the server previously terminated. No 
validation for Security Authority is performed. 

• Warm All Boot: Restarts the server only if it is able to restore all of 
the batches to the batch list. No validation for Security Authority is 
performed. 

8. Select the Start/Continue button to start the service. Wait for the 
status to change to RUNNING and the light is green. 

9. Select the Server Details button. The FactoryTalk Batch Server Details 
dialog box opens. 

10. Select the PCD Communications tab. The Data Server Status box 
displays the status of the conversation. Make sure that conversation is 
GOOD. 

11. Select Start. The tag verification process begins. When tag verification 
is COMPLETED, select OK, or select Stop to end the verification 
process and then select OK. 

Tip: If the number of COM servers exceeds the viewable area within the Data Server Status 
box, a scroll bar displays, enabling you to scroll through the list. 

12. Select Close. The Batch Service Manager dialog box closes. 
Tip: If software component conversation becomes LOST while running in Demo mode, 
make sure that the simulator is running and try starting the server(s) again. 

 

Batch Service Manager 
dialog box - Server options 

 
The following methods are available for restarting the FactoryTalk Batch 
Server after a service halt: 

Cold Boot Restarts the FactoryTalk Batch Server in a cold state. All journal data or recipe 
content is erased upon startup. If Security Authority is enabled, SAIs in a 
secured area model and any secured recipes must match the current Network 
FactoryTalk Directory SAI. 

Warm Boot Restarts the FactoryTalk Batch Server, restoring the set of batches that 
were on the batch list when the FactoryTalk Batch Server previously 
terminated. No validation for Security Authority is performed. 

Warm All Boot Restarts the FactoryTalk Batch Server only if it is able to restore all of the 
batches to the batch list. No validation for Security Authority is performed. 
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Start the sample 
FactoryTalk Batch Phase 
Simulator 

 
 
 
 
 
 
 
 
 
 
 
 
 

Verify PCD communications 

FactoryTalk Batch comes with a phase logic simulation program, referred to 
as the FactoryTalk Batch Phase Simulator used to simulate the batch process 
without connecting to a PCD. The Phase Simulator imitates the functionality 
of a data server and can communicate with the FactoryTalk Batch Server 
using OPC communication protocol. The Phase Simulator is a powerful tool 
for testing, experimentation and demonstration purposes. In this guide, run 
the sample demonstration using the Phase Simulator. 

Tip: If the Phase Simulator is required and OPC protocol is used for communications, the 
FactoryTalk Batch Server automatically starts the Phase Simulator. Check the Windows taskbar to 
see if the Phase Simulator is started. 

To run the sample demonstration correctly, open the ice_cream1.sim file in 
the Phase Simulator. 

 
To start the sample FactoryTalk Batch Phase Simulator: 

1. If the Phase Simulator is already running, maximize it from the 
Windows taskbar. If the Phase Simulator is not running, select Start > 
Rockwell Software > Simulator. The FactoryTalk Batch Phase 
Simulator opens. 

 

 IMPORTANT Administrator privileges are required to perform this procedure.  

2. Select File > Open. The Open Simulator Configuration File dialog box 
opens. 

3. From the Look in list, open the Program Files > Rockwell Software > 
Batch > SampleDemo1 > Recipes folder. Select the ice_cream1.sim file, 
and then select Open. 

4. Minimize the FactoryTalk Batch Phase Simulator window. 

 
Use the following instructions to verify PCD communications. 

 

 IMPORTANT Administrator privileges are required to perform this procedure.  
 

To verify PCD communications: 
1. Select Start > Rockwell Software > Batch Service Manager. The 

FactoryTalk Batch Service Manager opens. 
2. Make sure FactoryTalk Batch Server is selected in the Service box. 
3. Select Server Details. The FactoryTalk Batch Server Details dialog box 

opens. 
4. Select the PCD Communications tab. The Data Server Status area 

displays the status of the conversation with the OPC_SIM data server 
(Phase Simulator), which should be PHASES GOOD. 

5. In the Tag Verify area, select Start to begin the verify process. The tag 
verification process takes several minutes. 

6. When the Status box shows COMPLETED, select OK to close the 
FactoryTalk Batch Server Details dialog box. 
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Learn about FactoryTalk 
Batch 

The rest of this document is designed to give you a tour through the 
FactoryTalk Batch components using the sample demo. Proceed through the 
next chapters to learn about: 

• FactoryTalk Batch Equipment Editor 
• FactoryTalk Batch Recipe Editor 
• FactoryTalk Batch View 
• FactoryTalk Event Archiver 
• FactoryTalk Batch View HMI Controls 
• PC-Based Phases 
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Chapter 3 
 
 

FactoryTalk Batch Equipment Editor 

 
The FactoryTalk Batch Equipment Editor is the component to configure the 
equipment and associated functions to produce your facility’s area model. The 
components defined in the FactoryTalk Batch Equipment Editor interface 
with the process-connected devices (PCDs) in the facility. 

As outlined in the ISA S88.01 Batch Control Standard, the area model of a 
plant is separated into the following physical components: 

• Process Cell 
• Unit 
• Phase 
• Control Module 

To build the area model, configure each of these components. In addition to 
the area model, the FactoryTalk Batch Equipment Editor allows specification 
of communication functions, enumeration sets, data servers, FactoryTalk 
Event Archiver functions, and configuration of FactoryTalk Batch Server 
options. 

In this section, open a sample file to examine a configured area model for an 
ice cream plant. 

 

Open the FactoryTalk Batch 
Equipment Editor with a 
sample user 

 
Use the following instructions to open the FactoryTalk Batch Equipment 
Editor with the sample user, ENG. 

 

To open the FactoryTalk Batch Equipment Editor with a sample user: 
1. Select Start > Rockwell Software > Equipment Editor. A blank 

FactoryTalk Batch Equipment Editor window opens. The Equipment 
Editor Login dialog box also opens if FactoryTalk Security is 
configured. 

2. In the User Name field, enter ENG. (This is the FactoryTalk Security 
user with Full Edit permissions you created in the FactoryTalk Batch 
Server introduction section.) 

3. In the Password field, enter password and select OK. (This is the 
password you created for the ENG user in the FactoryTalk Batch 
Server introduction section.) 
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Open a sample area model 

 
 
 
 
 
 
 
 

The FactoryTalk Batch 
Equipment Editor window 

 
 
 
 
 
 
 

Navigate within the area 
model 

The definition for an area model is contained in a configuration file (.cfg) that 
you build using the FactoryTalk Batch Equipment Editor. In this exercise, you 
will look at a configuration file, ice_cream.cfg, which was installed with 
FactoryTalk Batch. 

 

To open a sample area model: 
1. From the File menu, select Open, or select the Open toolbar button. 

The Open dialog box opens. 
2. Select ice_cream.cfg, and then select Open to open the file. The Classes 

View area displays the icon that represents the PARLOR process cell 
class, which is used to create the process cells shown in the Design 
View area. The WEST_PARLOR process cell displays in the Design 
View area. 

 
The FactoryTalk Batch Equipment Editor window is divided into two main 
areas: Classes View and Design View. 

• The Classes View displays the existing cell classes, unit classes, phase 
classes, or operation sequence classes in the active area model. The 
column heading reflects the active level. Double-click or right-click an 
icon to open the Edit dialog box for the item. 

• The Design View is used to construct the area model and display the 
layout of the active level. In the select mode, double-click an item to 
display the layout of the next lower level. Right-click the item to open 
the Edit dialog box. 

The FactoryTalk Batch Equipment Editor also has a menu bar and toolbar. 
Take a moment to examine the menus and the tooltips for each toolbar icon. 
(See the FactoryTalk Batch Equipment Editor User Guide for more information on 
the menus and toolbar icons.) 

 

To navigate within the area model, use the Go Down and Go Up toolbar 
buttons. Double-clicking an icon in the Design View takes you down through 
the area model. 

 

To navigate within the area model: 
1. Double-click the WEST_PARLOR icon in the Design View. The Design 

View displays the units that make up the selected process cell. The 
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Classes View displays all the unit classes defined in the area model 
that you can add to the process cell structure. 

 

2. Double-click the WP_MIXER1 unit icon in the Design View. The 
Design View displays the phases that make up the selected unit. The 
Classes View area displays all the phase classes defined in the area 
model that you can add to the unit structure. 

 

The Location Bar displays the unit and process cell in which you are 
working, which currently is the WP_MIXER1 unit within the 
WEST_PARLOR process cell. If the Location Bar is not displayed in 
your window, select Location Bar from the View menu. 

 

Create and configure a 
phase class 

 
A phase class is a reusable process-oriented function, such as Heat, Mix, or 
Add. A phase instance occurs when a phase class is added to the Design View. 

A phase class describes what is to occur in the recipe, but not how to do it. 
When a phase class is added to the Design View, the resultant phase serves as 
a link to the engineered logic in the phase logic that contains the instructions 
for how to do it. 
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Tip: Control modules (the logic for pumps, valves, etc.) are configured in the process-connected 
device (PCD). 

 

View a sample phase class 
configuration 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Create a sample phase class 

 
Use the following instructions to view the sample phase class configuration. 

 

To view a sample phase class configuration: 
1. Right-click the ADD_SUGAR phase class icon in the Classes View. The 

Edit Phase Class dialog box opens to the General tab. 
2. Select each tab and examine the settings that were defined for the 

ADD_SUGAR phase class. 

• The General tab configures the general attributes of the phase class, 
such as the phase class name, phase class type, the number of phase 
class message partners, and the number of tags associated with the 
phase class. Select an icon to graphically represent all phases based 
on the phase class throughout the area model. Additionally, enable 
or disable the use of control strategies and material-based recipes 
for the phase class. 

Tip: The use of material-based recipes requires the installation of FactoryTalk Batch 
Material Manager. 

• The Parameters tab contains a list of parameters associated with 
the phase class. Create, edit and delete phase class parameters, as 
well as configure verification methods for parameter values. The 
parameters allow FactoryTalk Batch to send data to a PCD. 

• The Reports tab contains a list of report parameters associated with 
the phase class. Additionally, add new reports, edit, and delete 
reports from the list, as well as configure verification methods for 
report values. The report parameters allow the PCD to send data to 
FactoryTalk Batch. 

• The Messages tab contains a list of messages associated with the 
phase class. Phase class messages are typically used for journal entry 
purposes and for troubleshooting phase logic problems. In some 
instances, the message may be displayed to the operator. A phase 
class message has two pieces of data associated with it: name and 
message ID. 

• The Control Strategies tab, which is only available if Control 
Strategies is enabled on the General tab, is used to add, edit, or 
delete control strategies. 

3. Select Cancel to close the dialog box. 

 
Phase classes are created and configured using the Create Phase Class dialog 
box. 
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To create a sample phase class: 
1. From the Class menu, select New Phase Class. The Create Phase Class 

dialog box opens to the General tab. 
2. In the Name box, type ADD_WATER. 
3. In the Icon list, select an icon to represent the ADD_WATER phase 

class. 
4. Select Parameter/Tag Locking, if necessary. Select Apply. 
5. Select the Parameters tab, and then select the Add Parameter button. 

A new parameter is added to the list. 

a. In the Name box, type ADD_AMOUNT. 

b. In the Default box, type 50. 

c. In the Enum/E.U. box, type KG. 

d. Select Apply. 

6. Select the Reports tab, and then select the Add Report button. A new 
report parameter is added to the list. 

a. In the Name box, type AMOUNT_ADDED. 

b. In the Enum/E.U. box, type KG. 

c. Select Apply. 

7. Select OK. The new phase class displays in Classes at the bottom of the 
list. 

 

Create and configure phases 

 
 
 
 
 
 

View a sample phase 
configuration 

 
When a phase class is added to a unit it becomes a phase. Only one instance of 
a specific phase class to each unit, with the exception of material-enabled 
phase classes. When a phase is required in multiple units, share it between the 
units or add another instance of a phase class with a different name. 

There are many options for configuring phases. As a minimum, modify each 
tag in the phase to indicate the tag’s addressable location in the process- 
connected device (PCD). 

When using material-enabled phase classes, you can have multiple phases 
based on the same phase class within a single unit. For each phase, define the 
material containers with which the phase is associated. Phases mapping to the 
same phase class have independent resource IDs. 

 

Use the following instructions to view a sample phase configuration. 
 

To view a sample phase configuration: 
1. Right-click the WP_ADD_CREAM_M1 icon in the Design View. The 

Edit Phase dialog box opens to the General tab. 
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2. Select each tab and examine the settings defined for the 
WP_ADDCREAM_M1 phase. 

• The General tab allows you to configure general attributes of the 
phase, such as the name, equipment ID, and automatic 
upload/download. 

• The Arbitration tab displays a list of the equipment for which 
ownership is required by this phase in order to begin execution. 

• The Cross Invocation tab configures the cross invocation strings, 
which indicate the addition of an item to the FactoryTalk Batch 
View and ActiveX controls’ shortcut menus, including the caption 
for each menu item and what data is passed to the specified 
automation server when the menu item is selected. 

• The Tags tab displays a list of all tags to define for the phase. You 
can set a server for each tag and the scan rate. 

• The Parameter Limit Tags tab is used to enable the FactoryTalk 
Batch Equipment Editor to determine and build the tags required to 
download the parameter limits and verification configuration 
details to the phase logic if Parameter/Tag Locking is enabled. Or, if 
Parameter/Tag Locking is disabled, you can select the appropriate 
set of parameter limit tags for each parameter. 

• The Report Limit Tags tab is used to enable the FactoryTalk Batch 
Equipment Editor to determine and build the tags required to 
download the report limits and verification configuration details to 
the phase logic, if Parameter/Tag Locking is enabled. Or, if 
Parameter/Tag Locking is disabled, you can select the appropriate 
set of report limit tags for each parameter. 

• The Containers tab is used to configure which containers the phase 
can select material from, and which containers it can distribute 
material into. The Containers tab is visible with material-enabled 
phases only, which requires the installation of FactoryTalk Batch 
Material Manager. 

3. Select Cancel to close the dialog box. 
 

View a sample FactoryTalk 
Batch tags 

 
FactoryTalk Batch uses phase tags to connect and talk to the phase logic in the 
PCD. Phase logic is code that issues real-time commands to actual devices in 
the plant. These tags also determine the size of the FactoryTalk Batch Server 
needed for a particular process. 

 
To view a sample FactoryTalk Batch tags: 

1. Double-click the WP_AGITATE_M1 icon. The Edit Phase dialog box 
opens. 

2. Select the Tags tab. The Phase Tags list shows the various tags 
associated with the WP_AGITATE_M1 phase. 
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3. Double-click the COMMAND tag. The Edit Phase Tag dialog box opens. 

The Item Name box contains the tag address defined in the PCD. 
Notice that the COMMAND tag is associated with the Phase Simulator 
(OPC_SIM). 

4. Click Cancel twice to close the dialog boxes. 
 

Create a sample phase 

 
 
 
 
 
 
 
 
 
 
 
 

Create a sample signature 
template 

 
To create a phase, place a phase class icon in the Design View, assign it to a 
data server, and then configure the phase. 

 
To create a sample phase: 

1. Select the ADD_WATER phase class icon in the Classes View, place the 
cursor in the Design View where you want to place the phase, and 
then left-click. The Edit Phase dialog box opens to the General tab. 

2. From the Data Server list, select the OPC_SIM data server and then 
select Apply. 

The FactoryTalk Batch Equipment Editor assigns a name and an 
equipment ID to the phase. Since automatic upload and download is 
enabled in the phase class, automatic upload and download is also 
enabled in the phase, but you can selectively disable this feature. 

3. In the Name box, type WP_ADD_WATER_M1 to match the other 
phase names in the unit. 

In normal use, you would now configure tags for this phase, but since 
you are using the Phase Simulator for this example, it is not necessary. 

4. Select OK. A default phase is created and it is assigned to the Phase 
Simulator (OPC_SIM). While the icon is selected, drag it around the 
Design View. 

 
Before you can set up your phases and recipes to require electronic 
signatures, you must establish a set of signature templates. Each signature 
template defines the number of signoffs required, the meaning of those 
signoffs, whether comments are included with the signoff, and which security 
permissions an operator must have to complete the signoff. 

Tip: The following exercises require you to save the area model. If you want to preserve the 
original area model, exit the FactoryTalk Batch Equipment Editor without saving the changes, 
and copy the SampleDemo1.cfg file to a different location before proceeding with the 
following steps. 

 

To create a sample signature template: 
1. If you closed the FactoryTalk Batch Equipment Editor, open it and 

then open the SampleDemo1.cfg area model. 
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2. From the Edit menu, select Signature Templates. The Edit Signature 
Templates dialog box opens. 

3. Select the New Template button. The Create Signature Template 
dialog box opens. 

 

4. In the Template Name field, type CommandsTemplate and select OK 
(the Template Index is optional). The Create Signature Template 
dialog box closes and the new template is listed in the Signature 
Templates list on the Edit Signature Templates dialog box. 

5. In the Signoffs Required drop-down, select 1 (this is the number of 
signatures that must be obtained for this signature template). 

6. Select the Signoffs tab. 
7. In the Template Name field, make sure CommandsTemplate is 

selected. 
8. From the Signoff dropdown, select 1 (this represents the Signoff you 

are going to configure.) 
9. In the Meaning field, type Authorizes commands. 
10. From the Comment drop-down, select Optional. 
11. In the Security Permissions area, select the Add button. The Select 

User or Group dialog box opens. 
 

12. In the Filter box, select Show all. 
13. Select OPER and select OK. (See the FactoryTalk Batch Administrator 

Guide for more information on security.) 
14. Select OK to save the Create Signature Template dialog box. (See the 

FactoryTalk Batch Equipment Editor User Guide for more information on 
creating and configuring Signature Templates.) 
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Use signature templates 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use signature templates 
with recipe approvals 

Signature templates can be used to request signoffs for reports and 
parameters, and can be configured to request a signoff when specified 
commands are generated from within the FactoryTalk Batch View. 

The template you created in the previous section, CommandsTemplate, will be 
used to generate a signature request when the START command is issued 
from the FactoryTalk Batch View application. This requires that you enable 
Command Verification Policies. 

 
To use signature templates: 

1. Select Command Policies from the Edit menu. The Edit Command 
Verification Policies dialog box opens. 

 

2. Select the Start checkbox. The Select Signature Template dialog box 
opens. 

3. Since CommandsTemplate is the only template currently defined, it is 
selected by default. Select OK. CommandsTemplate should display in 
the Signature Template box next to the Start command. 

4. Select OK to close the dialog box. 
5. Select Save from the File menu to save the area model. This is required 

because you will be using the Signature feature later in this guide. 
 

Signature templates are used to provide signoffs for the Recipe Approvals 
process. The Recipe Approvals process: 

• Validates the development and maintenance of batch recipes. 
• Safeguards design workflow in a formalized manner. 
• Confirms each recipe is validated by authorized personnel before 

being released to production. 

Additional signature templates may be required for the recipe approval 
process--configuration for these is the same as for other signature templates. 
Assigning signature templates to recipe approval steps is handled in the 
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Tip: If your account has been granted View Only access rights under FactoryTalk Policies, 
the dialog box opens but OK is disabled--any changes you make are not saved. 

FactoryTalk Batch Equipment Editor Recipe Approvals Configuration dialog 
box. Approval signoffs are executed in the FactoryTalk Batch Recipe Editor. 

 
To use signature templates with recipe approvals: 

1. In the FactoryTalk Batch Equipment Editor, select Recipe Approvals 
Configuration from the Edit menu to open the Recipe Approvals 
Configuration dialog box. 

 

2. Select from available signature templates using the Browse  
button to the right of each Approval and Revert field for the step you 
want to configure. You may need to configure additional signature 
templates for the approval roles in your process. 

Configure Approval and Revert signoffs for at least these three steps: 

• The first listed step (labeled Begin Approval by default). 
• Release Recipe as Step (for both the Approval Process and the 

Expedited Process steps). 
• Release Recipe to Production (for both the Approval Process and the 

Expedited Process steps). 

Once valid signoffs are configured for these steps, the Enable Recipe 
Approvals checkbox is no longer grayed out. 



Chapter 3 FactoryTalk Batch Equipment Editor 

Rockwell Automation Publication# BATCH-GR011F-EN-P - May 
 

45 

 

 

3. (optional) Check the box  to the left of one or more of the three 
optional steps to enable and configure more approval steps if needed. 
These step labels are user-modifiable. 

4. Check the Enable Recipe Approvals box. Once you have enabled recipe 
approvals, either the formal process of three to six steps, or the 
expedited approval process of two steps, is available for execution in 
the FactoryTalk Batch Recipe Editor. Either approval process must be 
completed for the recipe to be marked as Release Recipe to 
Production, at which point it is added the FactoryTalk Batch Server to 
the Batch List in FactoryTalk Batch View, ActiveX Controls, and/or 
eProcedure. 

See Configure recipe approval steps in the FactoryTalk Batch Equipment Editor 
User Guide for more information on recipe approvals configuration. 

See Approve a recipe in the FactoryTalk Batch Recipe Editor User Guide for more 
information on recipe approval. 

 

Enable recipe version 
control 

 
 
 
 
 
 

Enable recipe and area 
model security 

 
A versioned recipe is a saved, read-only snapshot of the recipe taken at a 
particular point in time. Recipe version control is useful when you, or a team 
of authors, need to store and protect revisions of a recipe during its 
development. 

Recipe version control is enabled in the Options > Server Options menu in the 
FactoryTalk Batch Equipment Editor. Enforcement of version naming is 
handled by the FactoryTalk Batch Recipe Editor. To enable versioning, follow 
the instructions given in Enable recipe version control in the FactoryTalk Batch 
Administrator Guide. 

For information on using recipe versioning, see Work with recipe versions in 
the FactoryTalk Batch Recipe Editor User Guide. 

 

A recipe or an area model can be secured to a Security Authority Identifier 
(SAI) in the FactoryTalk Network Directory. When secured, a recipe or an area 
model cannot be viewed, modified, or used under a different FactoryTalk 
security authority identifier. 

Recipes are secured using the Recipe > Security Authority command in the 
FactoryTalk Batch Recipe Editor. For more information on using recipe 
security, see Security authority overview in the FactoryTalk Batch Recipe Editor 
User Guide. 

Area models are secured to a SAI using the Edit > Security Authority 
command in the FactoryTalk Batch Equipment Editor. For more information 
on using area model security, see Security authority overview in the 
FactoryTalk Batch Equipment Editor User Guide. 
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Share equipment 

 
 
 
 
 

 
Exit the FactoryTalk Batch 
Equipment Editor 

 
 
 
 

FactoryTalk Batch 
Equipment Editor summary 

Both the WP_MIXER1 and WP_MIXER2 units require the ADD_WATER 
phase. Rather than create two identical phases, you can share the phase 
between the units. 

 

To share equipment: 
1. Select Go Up to return to the Unit level. 
2. Double-click the WP_MIXER2 icon. 
3. Select Share Unit. The Share Phase Between Units dialog box opens. 
4. Expand WP_MIXER1, and then select WP_ADD_WATER_M1. 
5. Select OK. 

 
Use the following instructions to exit the FactoryTalk Batch Equipment 
Editor. 

 

To exit the FactoryTalk Batch Equipment Editor: 
1. From the File menu, select Exit. 
2. Select No to discard any changes you made to the .cfg file. This does 

not discard any previously saved changes. 
 

In this section, you: 

• Opened the FactoryTalk Batch Equipment Editor. 
• Examined the FactoryTalk Batch Equipment Editor window. 
• Opened an area model. 
• Created a phase class. 
• Created a signature template. 
• Enabled a command verification policy. 
• Examined phase tags. 
• Created a phase. 

(See the FactoryTalk Batch Equipment Editor User Guide for more information 
about the FactoryTalk Batch Equipment Editor.) 
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Chapter 4 
 
 

FactoryTalk Batch Recipe Editor 

 
The FactoryTalk Batch Recipe Editor is used to create and configure master 
recipes. The FactoryTalk Batch Recipe Editor lets you use tables, sequential 
function charts, or both, to graphically organize procedural information into 
unit procedures, operations, and phases. This FactoryTalk Batch component is 
used primarily by recipe formulators to create or edit recipes (sequences of 
steps) and formula values (parameters, set point values, etc.). 

All recipes are configured and displayed using the ISA S88.01 Batch Control 
Standards, which define the Procedure, Unit Procedure, and Operation 
(Phase) layers for the procedural model. 

 

In this section, you open a sample file to examine and edit a recipe for French 
Vanilla ice cream. 

Tip: This chapter provides a brief glance at the recipe-building capabilities of the FactoryTalk 
Batch Recipe Editor. See the FactoryTalk Batch Recipe Editor User Guide for more information on 
completing, importing, approving, versioning, exporting, and maintaining recipes. 

 

Open the FactoryTalk Batch 
Recipe Editor 

 
Use the following instructions to open the FactoryTalk Batch Recipe Editor. 

 

To open the FactoryTalk Batch Recipe Editor: 
1. Select Start > Rockwell Software > Recipe Editor. A blank FactoryTalk 

Batch Recipe Editor window displays. The Recipe Editor Login dialog 
box also opens if security is configured. 

2. Enter a FactoryTalk Security user name and password and select OK. If 
a recipe verification box displays, select Yes to verify all the recipes in 
the Area Model’s recipe directory. 

3. When this is complete, select Close. 
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FactoryTalk Batch Recipe 
Editor window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open a recipe 

The FactoryTalk Batch Recipe Editor component allows you to construct 
recipes by sequencing phases graphically. The actual phase logic resides in the 
process control device and is configured separately using controller-specific 
programming software. The phases are configured in the FactoryTalk Batch 
Equipment Editor. 

 

The FactoryTalk Batch Recipe Editor window consists of the following 
components: 

• The Procedure View pane occupies the left side of the FactoryTalk 
Batch Recipe Editor window and contains a hierarchical list of the 
current recipe components. Selecting a component from the list 
displays the corresponding step(s) in the Recipe Construction pane. 

• The Recipe Construction pane occupies the right side of the 
FactoryTalk Batch Recipe Editor window and is used to construct 
master recipes. The Recipe Construction pane allows you to construct 
and view recipe structures using a sequential function chart (SFC) or a 
table. Both the SFC View and the Table View can be displayed 
exclusively, or the Recipe Construction pane can be tiled to display 
both views at the same time. Selecting a component within either view 
will highlight the corresponding item in the Procedure View pane. 

The FactoryTalk Batch Recipe Editor also has a menu bar, toolbar, and a 
Recipe Construction toolbox. Take a moment to examine the menus and the 
tooltips for each toolbar icon and toolbox tool. See the FactoryTalk Batch Recipe 
Editor User Guide for more information on the menus, toolbar icons, and 
toolbox tools. 

 

In this section, you will edit an existing recipe. Step-by-step instructions for 
building a recipe are located in the FactoryTalk Batch Recipe Editor User Guide. 

 

To open a recipe: 
1. From the File menu, select Open Top Level. The Open [Type] Recipe 

dialog box opens. In this case [Type] is BINARY. (Other recipe storage 
types are XML and RDB.) 



Chapter 4 FactoryTalk Batch Recipe Editor 

Rockwell Automation Publication# BATCH-GR011F-EN-P - May 
 

49 

 

 

2. From the Select the recipe to open list, select CLS_FRENCHVANILLA. 
In the right column, notice the information about the recipe and the 
Release Recipe as Step and Release Recipe To Production checkboxes. 

3. Select Open. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Tip: When Recipe Approvals are disabled, the Release Recipe as Step and Release Recipe 
to Production checkboxes display the state of these properties, but are inactive. These 
properties are set in the Recipe > Header Data dialog box. 
When Recipe Approvals are enabled, these properties are treated as two steps in the 
approval process, and are set as part of the approval signoff process. 
When Release Recipe as Step is true (box is checked), the recipe can be used by other 
recipes. When Release Recipe to Production is true, the recipe is shown in the Recipe List 
in FactoryTalk Batch View, eProcedure, and ActiveX Controls. This allows batches to be 
created from the recipe. 
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Review the recipe structure 

 
 
 
 
 
 
 
 

View hidden information 

 
 
 
 
 
 
 
 
 

Change the recipe view 

The ISA S88.01 recipe structure of CLS_FRENCHVANILLA is displayed on the 
left side in the Procedure View pane. The SFC version of the 
CLS_FRENCHVANILLA recipe structure is displayed on the right side in the 
Recipe Construction pane. 

 

Some of the information displayed within the Procedure View pane is too 
large for the window, resulting in the information being hidden. 

 

There are two ways to view the hidden information: 
• Hover over the item to view the entire name in a tooltip. 

 

• Move the cursor over the split bar between the Procedure View pane 
and the Recipe Construction pane. When the pointer changes into a 
horizontal double-headed arrow, select and drag the split bar to the 
right or left. 

 

 

By default, the SFC version of the recipe structure displays in the Recipe 
Construction pane. 

 
To change the recipe view: 

1. Select Table to view the table version of the recipe structure. Size the 
columns if necessary to view the contents. 

2. Select Tile to view both the SFC and table views simultaneously. 
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Move down through SFC 
levels 

Like the FactoryTalk Batch View, the FactoryTalk Batch Recipe Editor allows 
you to view all of the SFC levels by double-clicking the SFC step or selecting 
the step from the Procedure View area. 

 
To move down through SFC levels: 

1. Select SFC to view the SFC. 

Notice the letters BPC in the right corner of the status bar. These 
letters signify that you are currently viewing the Batch Procedure 
(BPC) level of the recipe. 

 

2. Double-click the CLS_SWEETCREAM_UP:1 step in the SFC to move to 
the Unit Procedure (UPC) level. 

 

Notice that the blue highlight in the Procedure View indicates the 
selected level and that the letters UPC display in the lower right corner 
of the window. 
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3. Double-click the CLS_SWEETCREAM_OP:1 step in the SFC to move to 
the Unit Operation (UOP) level. All of the phases within the 
CLS_SWEETCREAM_OP:1 unit operation display. 

 

 
 

Move up through SFC levels 

 
 
 
 
 

Add steps 

 
Add a sequential step in the 
sample operation level 

Selecting the initial step sends you up through the SFC levels. You also can 
select a level in the Procedure View pane. 

 
To move up through SFC levels: 

1. Double-click the initial step of the CLS_SWEETCREAM_OP:1 
Operation at the top of the SFC to return to the Unit Procedure level. 

2. Double-click the initial step of the CLS_SWEETCREAM_UP:1 Unit 
Procedure at the top of the SFC to return to the Batch Procedure level. 

 

You build a recipe by adding steps. The FactoryTalk Batch Recipe Editor 
automatically adds and configures the transitions between the steps. 

 

Use the following instructions to add a sequential step in the operation level. 
 

To add a sequential step in the sample operation level: 
1. With the Selection Tool selected, double-click the 

CLS_SWEETCREAM_UP:1 unit procedure in the Procedure View. 
The CLS_SWEETCREAM_OP:1 operation displays. 

2. Double-click the CLS_SWEETCREAM_OP:1 operation. The recipe 
steps within the operation display. 

3. Select the ADD_MILK:1 STATE = COMPLETE transition at the bottom 
of the operation. 
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4. Select Add Step in the Recipe Construction Toolbox. A new step and 
transition are added below the selected transition and the Select Phase 
dialog box opens. 

5. Select XFR_OUT, and then select OK. The new step is defined as 
XFR_OUT:1 and the transition below the step is defined as 
XFR_OUT:1.STATE = COMPLETE. 

 

The recipe elements in CLS_SWEETCREAM_OP:1 automatically 
rearrange to make room for the new step and transition. This auto- 
arrange functionality of the FactoryTalk Batch Recipe Editor greatly 
simplifies both the recipe creation and modification processes and 
also increases the overall readability of the recipe. 

 

Add a parallel step in the 
sample operation level 

 
Use the following instructions to add a parallel step in the operation level. 

 

To add a parallel step in the sample operation level: 
1. While still in the CLS_SWEETCREAM_OP:1 operation, select the 

TEMP_CTL:1 step. 
2. Select Add Parallel. A new step is added in parallel to the selected step 

and the Select Phase dialog box opens. 
3. Select ADD_EGG, and then select OK. The new step is now defined as 

ADD_EGG:2 and the transition below the step is automatically re- 
defined as ADD_EGG:2.STATE = COMPLETE AND 
TEMP_CTL:1.STATE = COMPLETE AND ADD_CREAM:1.STATE = 
COMPLETE to reflect the new parallel structure. 
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Assign step formula values 
to the sample operation 
level 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add recipe comments to the 
sample operation 

Once a step is added to an operation, you can assign formula values, which 
involves specifying the values and selecting the parameter to display for the 
selected step. 

 

To assign step formula values to the sample operation level: 
1. While still in the CLS_SWEETCREAM_OP:1 operation, select the 

ADD_EGG:2 step. 
2. Select Value Entry. The Parameter Value Entry/Report Limit Entry 

dialog box opens listing the parameters associated with the step. The 
only parameter is ADD_AMOUNT. 

3. Type 100 in the Value box, and then select Display so the value displays 
on the SFC. 

 

4. Select OK to return to the FactoryTalk Batch Recipe Editor window. 

Next, you decide to change the parameter for TEMP_CTL:1 so that the 
operator can enter the amount when the batch is run. 

5. Select the TEMP_CTL:1 step, and then select Value Entry. The 
Parameter Value Entry/Report Limits Entry dialog box opens listing 
the parameters associated with the step. There are two parameters: 
HOLD_TIME and TEMP_SP. You want the operator to decide how long 
to hold the mixture. 

6. From the Origin list for the HOLD_TIME parameter, select Operator 
to indicate that the operator enters the amount when the recipe is run. 

 

7. Select OK to return to the FactoryTalk Batch Recipe Editor window. 

 
Recipe commenting provides you with a tool to create and edit comments for 
viewing at design and run time. With this feature, important information can 
be inserted into the recipe and associated with a step, transition, or entire 
recipe. 

 

To add recipe comments to the sample operation: 
1. While still in the CLS_SWEETCREAM_OP:1 operation, select Text Box 

Tool. The cursor changes to a text tool. 
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2. Move the cursor to the right of the AGITATE:1 step and select. A text 
box labeled C1 is placed in the SFC. 

3. Select Link, and move the cursor (now a +) back to the C1 text box. 
4. Select anywhere in the box, hold the mouse button, and drag the 

cursor to the AGITATE:1 step. AGITATE:1 now appears in the bottom 
half of the text box indicating the C1 text box is associated with the 
AGITATE:1 step. 

5. Choose the Selection Tool and double-click inside the text box. Type 
Reduce the agitation speed to 20 RPM if the mixture begins to 
separate. 

 

6. Select outside the text box when the comment is complete. 
 

Remove steps 

 

 
Add a continuous loop to the 
sample unit procedure 

 
When you remove a step from the recipe, the FactoryTalk Batch Recipe Editor 
will reconfigure the links and transitions accordingly. However, sometimes 
the links and transitions are complex and you may have to redo the links and 
reconfigure the transitions manually. 

 

FactoryTalk Batch is capable of performing looping at all levels of the 
procedural model. Not only is this a powerful recipe management tool, it is a 
simple task to complete. 

 

To add a continuous loop to the sample unit procedure: 
1. Select Go Up on the toolbar twice to move to the 

CLS_SWEETCREAM_UP:1 unit procedure. 
2. Select Transition Tool. Place the pointer to the right of the existing 

transition labeled CLS_SWEETCREAM_UP:1.STATE = COMPLETE, 
and then select to add an undefined transition. 

3. Select the Link Tool button. 
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4. Select and drag the pointer from the step labeled 
CLS_SWEETCREAM_UP:1 to the new TRUE transition. Release the 
mouse button to add the link. 

 

IMPORTANT All loops and transitions must branch to the right side of the sequential function 
chart as shown. 

 

5. Select and drag the pointer from the TRUE transition to the last step of 
the unit procedure (CLS_FRENCHVANILLA_UP:1). This completes the 
loop structure. 

 

6. Select the Selection Tool button, and then double-click the new TRUE 
transition. 

7. Select the Common Expressions folder. 
8. Double-click Step.State = Complete. 
9. In the upper part of the dialog box, highlight = (equal sign) in the 

expression, and then select the GREATER THAN OR LESS THAN 
button. 

The transition should now read CLS_SWEETCREAM_UP:1.STATE <> 
COMPLETE. This transition makes sure that the 
CLS_SWEETCREAM_UP:1 operation will continue to run until it 
reaches a COMPLETE state. 

10. Select OK. 
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Verify the recipe 

 
 
 
 
 
 

Remove a sequential step 
from the sample operation 

 
 
 
 

Remove a parallel step from 
the sample operation 

After a recipe is created or edited, it needs to be verified to make sure it was 
configured properly and that it will run against a particular set of equipment 
(the area model). 

 

To verify the recipe: 
1. Select the Verify button. The Verification Process Results dialog box 

opens. The result should be: CLS_FRENCHVANILLA >> Verification 
of recipes has completed. 

2. Select Close. 

 
Use the following instructions to remove a sequential step. 

 

To remove a sequential step from the sample operation: 
1. While still in the CLS_SWEETCREAM_OP:1 operation, select the 

XFR_OUT:1 step. 
2. Select the Remove Step button. The XFR_OUT:1 step is removed, 

including its links and the following transition. The SFC automatically 
rearranges to adjust for the removed step. 

 

Use the following to remove a parallel step from the sample operation. 
 

To remove a parallel step from the sample operation: 
1. While still in the CLS_SWEETCREAM_OP:1 operation, select the 

ADD_EGG:2 parallel step. 
2. Select the Remove Step tool. The ADD_EGG:2 parallel step is removed, 

including its links, and the following transition is re-configured. The 
SFC automatically rearranges to adjust for the removed step. 

Tip: Because transitions that follow parallel structures can be complex, the transition may not 
reconfigure automatically. If the transition following the removed parallel step requires 
reconfiguration, you must configure the transition manually. 
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FactoryTalk Batch Recipe 
Editor summary 

In this section, you: 

• Opened the FactoryTalk Batch Recipe Editor. 
• Examined the FactoryTalk Batch Recipe Editor window. 
• Opened a recipe. 
• Resized the Procedure View pane. 
• Navigated through the SFC and Procedure View hierarchy. 
• Added a sequential step to a recipe. 
• Added a parallel step to a recipe. 
• Assigned formula values. 
• Added a comment. 
• Removed steps. 
• Built step transitions. 
• Added a continuous loop. 
• Verified the recipe. 
• Exited the FactoryTalk Batch Recipe Editor. 

This chapter provided a brief overview of the capabilities of the FactoryTalk 
Batch Recipe Editor module. (See the FactoryTalk Batch Recipe Editor User Guide 
for more information on the FactoryTalk Batch Recipe Editor.) 
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Chapter 5 
 
 

FactoryTalk Batch View 

 
This section describes how to use FactoryTalk Batch View. 

FactoryTalk Batch View is used to initiate and control the batch process and to 
view running batches. It has a graphical user interface with easy to use 
windows and buttons and, like most of the FactoryTalk Batch components, is 
based primarily on input from ISA’s S88.01 Batch Control Standard. 

This chapter takes you through the FactoryTalk Batch View initial connection 
and using the FactoryTalk Batch View interface. 

 

 

Set up a remote FactoryTalk 
Batch View client 

Following are instruction on how to set up a remote FactoryTalk Batch View 
client. 

 

To set up a remote FactoryTalk Batch View client 
1. On the remote client, open a browser. 
2. Enter the URL for the FactoryTalk Batch View Server. 
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Tip: The URL must be in the form of https://[node].[port].com. For 
example: https://MyBatchViewServer.MyDomain.com 
• [node]: The computer on which the FactoryTalk Batch Server and FactoryTalk Batch 

View Server are installed. The node value is either the IP address or the fully qualified 
node name. 

• [port]: The default port number is 443. If the FactoryTalk Batch View Service is installed 
on a different port, launch the client on the FactoryTalk Batch View Server machine to 
identify the port number in the URL. The port number is not shown in the URL if the 
default port number 
(443) is in use. 

 
 

For example: 

• https://192.168.0.10 (IP address and the default port of 443) 
• https://192.168.0.10:4431 (IP address and a port number other than 

the default port of 443) 
• https://Win2019DC-ABC.domain1234.com (a fully qualified machine 

name and default port number) 

3. On the FactoryTalk Batch View login page, enter your user name and 
password, and then select Log On. 

 

HTTPS certificates 

 
 
 
 
 

Single session self-signed 
certificates 

 
The FactoryTalk Batch View application uses a self-signed certificate created 
during the product installation on the server. Modern web browsers are 
designed to warn users when encountering self-signed certificates because 
they are not signed by a certificate authority (CA). Self-signed certificates do 
provide for secure, encrypted data transmission, but are not signed by a CA. 

When using FactoryTalk Batch View for the first time in a browser, accept a 
self-signed certificate for a given session, or configure the browser to always 
trust the certificate. 

 

When using FactoryTalk Batch View for the first time in a browser, accept a 
self-signed certificate for a given session. 

 
Google Chrome 

1. In the address bar, go to the URL generated during installation of the 
FactoryTalk Batch View server. 

2. Select Advanced. 
3. Select Proceed. 

 
Microsoft Edge 

1. In the address bar, go to the URL generated during installation of the 
FactoryTalk Batch View server. 

2. Select Advanced. 
3. Select Continue. 
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Apple Safari 
1. In the address bar, go to the URL generated during installation of the 

FactoryTalk Batch View server. 
2. Select Continue. 

 

Mozilla Firefox 
1. In the address bar, go to the URL generated during installation of the 

FactoryTalk Batch View server. 
2. Select Advanced. 
3. Select Add Exception. 
4. Select Confirm the Exception. 

 
 

 

Trusting self-signed 
certificates 

You can configure your browser to trust the FactoryTalk Batch View self- 
signed certificate so that you are not prompted to accept the certificate the 
next time you use the browser with FactoryTalk Batch View. 

 
  Tip:Instructions may vary slightly based on browser updates. 

Google Chrome 

This procedure applies to Google Chrome version 56. 

1. In Google Chrome, go to the URL generated during installation of the 
FactoryTalk Batch View server. 

2. Open Developer tools by selecting Ctrl + Shift + I. 
3. Select the Security tab. 
4. Select View Certificate. 
5. In the Certificate dialog box, select the Details tab, and select Copy to 

File to start the Certificate Export Wizard. 

a. In the Certificate Export Wizard, select Next. 

b. Select DER encoded binary X.509 (.CER), and select Next. 

c. Browse to the location where you want to export the file, and enter a 
file name. Select Save, and then select Next. 

d. Select Finish. 

e. In the Certificate Export Wizard message, select OK. 

f. In the Certificate dialog box, select OK. 

6. In the Chrome browser, open Settings, and select Privacy and security. 
7. Select Security. 
8. Scroll down the page and select Manage certificates. 
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9. In the Certificates dialog box, select the Trusted Root Certification 
Authorities tab, and then select Import. 

10. In the Certificate Import Wizard, follow these steps: 

a. Select Next. 

b. Select Browse and select the certificate file you saved, and then 
select Open. 

c. Select Next. 

d. Select Place all certificates in the following store and verify that the 
Certificate store shows Trusted Root Certification Authorities. 

e. Select Next, and then select Finish. 

f. Select OK, and then select Close. 

11. Restart the Chrome browser. 
 

Microsoft Edge 
1. In Microsoft Edge, enter the URL generated during installation of the 

FactoryTalk Batch View server. 
2. Open Developer tools by selecting Ctrl + Shift + I. 
3. Select the Security tab. 
4. Select View Certificate. 
5. In the Certificate dialog box, select the Details tab, and select Copy to 

File to start the Certificate Export Wizard. 

a. In the Certificate Export Wizard, select Next. 

b. Select DER encoded binary X.509 (.CER) and select Next. 

c. Browse to the location where you want to export the file, and enter a 
file name. Select Save, and then select Next. 

d. Select Finish. 

e. In the Certificate Export Wizard message, select OK. 

f. If the Security Warning dialog box is displayed, select Yes to install 
the certificate. 

g. In the Certificates dialog box, select OK. 

6. In the Microsoft Edge browser, open Settings, and select Privacy and 
services. 

7. Under Privacy, select Manage certificates. 
8. In the Certificates dialog box, select the Trusted Root Certification 

Authorities tab, and then select Import. 
9. In the Certificate Import Wizard, follow these steps: 

a. Select Next. 
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b. Select Browse and select the certificate file you saved, and then 
select Open. 

c. Select Next. 

d. Select Place all certificates in the following store and verify that the 
Certificate store shows Trusted Root Certification Authorities. 

e. Select Next, and then select Finish. 

f. If the Security Warning dialog box is displayed, select Yes to install 
the certificate. 

g. In the Certificates dialog box, select Close. 

 
Apple Safari 

1. In the address bar, go to the URL generated during installation of the 
FactoryTalk Batch View server. 

2. Select Show Certificate. 
3. Select Always trust <URL> when connecting to <URL>. 
4. Select Continue. 

 
Mozilla Firefox 

1. In the address bar, go to the URL generated during installation of the 
FactoryTalk Batch View server. 

2. Select Advanced. 
3. Select Add Exception. 
4. Select Permanently store this exception, then select Confirm the 

Exception. 
 
 

 

Prompts Use Prompts to alert operators to value requests for parameters, unit binding, 
material binding, and signatures or manual instructions. A control recipe 
cannot complete execution until the operator provides the requested 
information. In most cases, pending requests for information (value prompts, 
signatures, or manual instructions) are not acknowledged until a user either 
provides the information or stops or aborts the control recipe. 

• Value prompts alert operators to requests for parameter values, unit 
binding, and material phase/container binding. 

• Signatures are requests for signoffs that require user permissions and 
optional comments. When a signature is generated against a control 
recipe, acknowledge the signature by completing the associated 
signoffs. The requested user information in a signature is determined 
by the signature template defined in the area model. 
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• Instructions are individual steps of a manually executed phase. As a 
batch executes, the instruction for each active step appears. 
Instructions execute in the order specified within the master recipe. 

 

Acknowledge a prompt 

 
 
 
 
 
 

Instructions 

 
 
 
 

 
Execute an instruction 

 
Prompts alert operators when requests for parameter values are issued. 
Acknowledge prompt(s) to complete control recipe execution. 

 

To acknowledge a prompt 
1. Select Prompts. 
2. Select the prompt to acknowledge. 
3. Enter the value and select Acknowledge . 
4. If the prompt has associated signature(s), sign off on the prompt to 

complete the acknowledgment. 
 

Instructions represent the individual steps of a phase that the user can take 
action to answer. Instructions include: 

• Processing instructions 
• Recipe parameter values and entry of values 
• Valid HTML components 
• Run-time data 
• Batch ID, recipe, and phase originating the instruction 

Instructions are identified by type to show the status. Present instructions 
appear enabled, while Past and Future instructions appear disabled. 

 

Instructions execute as part of an active recipe step. They represent the 
individual steps of a phase. As a batch executes, the current manual 
instruction for each active step displays. Instructions execute in the order 
specified within the master recipe. 

If you have more than one active recipe step, instructions are displayed for all 
active recipe steps. 

 

To locate and execute the instruction 
1. Select Prompts. 
2. (optional) Use the Filter bar to filter and display only the instructions 

to execute. 
3. Locate and select the instruction to execute. 
4. Follow the directions provided in the instruction. 
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Sign an instruction 

 
 
 
 
 
 

Cancel an instruction 
signature request 

Use these steps to sign an instruction. 
 

To sign an instruction 
1. Select Prompts. 
2. Select the instruction. 
3. Select the signature request. 
4. Enter a valid user ID and password for each required signoff. 
5. If required, enter a comment. 
6. Select Sign. The signature appears after the instruction. 

 
Use the following instructions to sign a instruction to cancel a signature 
request. 

 

IMPORTANT Canceling a signature request undoes the request for the signature and the action that 
generated the signature. 

 
 

 

To cancel a signature request 
1. Select Prompts. 
2. Select the instruction. 
3. Select the signature request. 
4. Select Cancel. 
5. Select Yes to cancel the signature request. 

 

Reactivate an instruction 
 

Reactivate past instructions in a phase that is currently RUNNING that does 
not have pending, reactivated steps. Reactivate one instruction at a time. If 
the Reactivate command was configured with a signature template in 
FactoryTalk Batch Equipment Editor, the signature request displays in the 
instruction being reactivated. 

 

Prerequisites 
• If Past instructions do not appear in the Prompts list, select the box to 

the right of the Filter bar, and clear Hide Past. 
• Ensure property security privileges for the step to reactivate. 

 
To reactivate an instruction 

1. Select a valid past instruction, and then select Reactivate. 
2. Change any incorrect values. 
3. If a signature request displays, enter the required User ID and 

password, and a comment, if required, and then select Sign. 
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4. Select OK. 
 

Signatures 

 
 
 
 
 
 
 
 

 
Acknowledge a signature 

 
 
 
 
 
 
 

Cancel a signature request 

 
Signatures are used to secure control over runtime FactoryTalk Batch 
processes by configuring signature requirements. These signature events are 
then recorded in an electronic batch record, which includes the name of the 
signer, the date and time the signature was executed, and the meaning 
associated with the signature. 

The types of signatures may include report parameter verification for 
automated and manual phases, recipe parameter change verification, 
eProcedure step verification, batch and phase command verification, and a 
general usage signature that will allow a phase to request a signature 
whenever needed. 

FactoryTalk Batch Equipment Editor is used to configure signature templates 
that consist of signoffs, meanings, security permissions, and comment 
requirements. Once configured, signature templates can be associated with 
command verification policies to control specific batch processes. 

For more information, see Signature template in the FactoryTalk Batch 
Equipment Editor User Guide. 

 

When a control recipe requires a signature for a batch action, acknowledge 
the signature by completing the signoffs. 

 

To acknowledge a signature 
1. Select Prompts. 
2. Select the signature request. 

  Tip: If there are multiple signoffs, select the appropriate signoff. 

3. Enter the user name and password for each signoff. 
4. (optional) Enter comments. 

  Tip: If the signature template in the area model requires comments, this step is required. 

5. Select Sign. 

 
Cancel a signature to not sign off on a control recipe. The requested batch 
action does not complete. Signatures are cancelled both manually and by the 
FactoryTalk Batch Server. 

Tip: Canceling a signature request applies to all batch commands and actions except for a control 
recipe ABORT command, because that command completes before the signature is signed. 
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To cancel a signature request 
1. Select Prompts. 
2. Select the signature request. 
3. Select Cancel. 
4. Select Yes. 

 

Batches 

 
 
 

Create a control recipe 

 
 
 
 
 
 
 
 
 
 
 
 
 

Command a batch 

 
Use Batches to create, view, and command a control recipe, observe the 
execution of a single recipe, and bind units for class-based recipes. Once a 
control recipe is created, it remains in the Batches list until it is removed or 
until the FactoryTalk Batch Server is restarted with a cold boot. A graphical 
representation of a running batch and its associated data is displayed. 

 

Use Batches to add a control recipe from a master recipe. The Batches list 
displays control recipes that are ready to run, are running, or are complete. 

 
To create a control recipe 

1. Select Batches. 

2. Select Add . 
3. Select a master recipe. 
4. (optional) If the recipe contains a material class-based phase, select the 

material you want to use in this particular batch, and then select Next. 
5. Enter a unique batch ID. 

Tip: The Batch ID box accepts non-unique IDs. When duplicate batch IDs are used, it is 
difficult to associate prompts with the correct batch when viewed in Prompts. 

6. (optional) Perform any of the following: 

• To run a batch at a percentage other than 100%, in the Batch Scale 
box, enter the percentage. 

• To change the description of the batch, in the Description box, enter 
a new description. 

• Select the equipment for the control recipe in the Unit Bindings 
area. 

• To assign or change a formula value, enter new values in Formula 
Values. 

7. Select OK  to add the control recipe to the Batches list. 

 
Commands perform actions on a batch. These commands are supported: 

• Abort 
• Start 
• Stop 
• Remove 
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• Restart 
• Hold 
• Resume 

Issue control recipe commands from the Batches list, the Detail section, or the 
Summary section. Enabled command buttons appear for commands that are 
valid for the current conditions of a batch. The command buttons in the Detail 
and Summary sections affect the selected step in O-AUTO mode. 

If a command policy is configured in the FactoryTalk Batch Equipment 
Editor, the FactoryTalk Batch Server does not execute the command until the 
signature is complete. The Abort command executes immediately, before 
signatures complete. 

 

To command a batch 
1. Select Batches. 
2. (optional) To view the control recipe details before performing a 

command, select a batch. 
3. Select the command to execute. 

Tip: While commanding a batch, prompts requiring action may appear in the Prompts area. 
Respond to the prompts to continue processing the batch. 

 

Clear failure messages 

 
 
 
 
 

Change the active step 

 
Failure messages appear when a command is not run successfully on a batch 
or due to phase failures, unexpected execution conditions, or communication 
problems. To run the batch again, clear the failure messages first. 

 

To clear failure messages 
• Select Clear Failures in the Batches list, the Detail section, or the 

Summary section. 

 
Use Batches > Detail to change an active step. The active step is the step 
currently in progress in the batch. Changing the active step is permitted only 
when the recipe level that contains the active step is in manual mode. 

 

To change the active step 
1. Select Batches. 
2. Select a batch. 
3. In the Batch Detail display, select the recipe level that contains the 

active step, and then select Manual. 
  Tip: If Manual is not visible, verify that the user profile has permission for manual recipe control. 

4. Select Change Active Step. 



Chapter 5 FactoryTalk Batch View 

Rockwell Automation Publication# BATCH-GR011F-EN-P - May 
 

69 

 

 

Tip: Steps in the HELD state cannot be deactivated as the active step. 
 

5. To deactivate a step, select the step. The step appears in the Steps to 
deactivate list. 

Tip: Steps to be deactivated should be in one of the Terminal states such as STOPPED, ABORTED, 
COMPLETED, etc. 

6. To activate a step, select a step. The step appears in the Steps to 
activate list. 

  Tip: Only steps in the IDLE state can be selected to be made active. 

7. Select Execute. 
8. To change the active step, select Yes. 

 

Monitor a batch 
 

You can monitor the execution status of a control recipe using either a 
Sequential Function Chart (Detail section) or table format (Summary 
section). Command buttons are enabled based on the current condition of the 
batch. 

Tip: The Detail section sometimes displays recipe comments. Recipe comments contain read-
only notes, instructions, or information added in the Recipe Editor. Recipe comments include: 
• Comment Name. The name generated by the Recipe Editor in the form C#, where the 

number is incremented so that each comment has a unique name within the scope of the 
recipe. 

• Comment. The comment text. 
• Association (optional). The name of a step or transition the comment is associated with. 

 

To monitor a batch 
1. Select Batches. 
2. Select a batch. 
3. To watch the batch, execute in a: 

• Sequential Function Chart (SFC) format and view steps and 
transitions, select Detail. 

• Table format, select Summary. 

4. (optional) To see the batch description or equipment information, 
select General. 

 

Override a parameter 
expression value 

 
 

When there is an issue with the evaluation of a parameter expression, the 
operator can override the expression by assigning a new value and can clear 
the override value. 

 

IMPORTANT It is strongly recommended that this command be used in conjunction with a 
command signature or FactoryTalk Security to require authorization before an 
expression value can be overridden. See the FactoryTalk Batch Administrator Guide 
for information on configuring FactoryTalk Security on Batch View commands, or the 
FactoryTalk Batch Equipment Editor User Guide for information on configuring 
Electronic Signature 

 Templates and Command Policies.  



Chapter 5 FactoryTalk Batch View 

70 Rockwell Automation Publication# BATCH-GR011F-EN-P - May 
 

 

 

 

Force a transition to fire 

 
 
 
 
 
 
 
 
 

Valid states and modes 

The Force Transition command immediately fires an active transition. For 
example, if a transition expression references the report parameter and the 
value is preventing the transition from firing, use the Force Transition option 
to force the transition to fire. 

 

To force a transition to fire 
1. Select Batches. 
2. Select the running batch. 
3. In the Batch Detail display, select the active or armed transition. 

Tip: The Force Transition command is: 
• Available at the procedure, unit procedure, and operation levels. 
• Not available in Manual mode or when Force Transition is in a HELD state. 

4. Select Force Transition. 
5. (optional) If forcing the transition requires a signature, complete the 

confirmation or electronic signature. 
 

The following states and modes are valid for a step. Valid states for a step 
include: 

• READY 
• IDLE 
• RUNNING 
• RESTARTING 
• HOLDING 
• HELD 
• STOPPING 
• STOPPED 
• ABORTING 
• ABORTED 
• COMPLETE 
• DOWNLOADING 
• UPLOADING 

Step and transition states are color coded: 
 

Batch State Color 

READY Gray 
IDLE Gray 
RESTARTING Green 
HOLDING Yellow 
STOPPING Blue 
ABORTING Magenta 
COMPLETE Gray 
RUNNING Green 
STARTING Green 
HELD Dark Yellow 
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Batch State Color 

STOPPED Dark Blue 
ABORTED Dark Magenta 
DOWNLOADING Green 
UPLOADING Green 

Each valid step can be in one of four modes: 

• O_AUTO (Operator Auto): The batch sequences normally. Commands 
are sent to a recipe level in the O_AUTO mode. O_AUTO is a valid mode 
for all recipe levels. A recipe step in O_AUTO mode can be commanded 
by an operator. 

• P_AUTO (Procedure Auto): The batch sequences normally. Commands 
cannot be sent to a recipe level in the P_AUTO mode. P_AUTO is a valid 
mode for all recipe levels. A recipe step in P_AUTO mode is 
commanded by the higher-level procedure it belongs to. 

• S_AUTO (Semi Auto): The batch sequences normally, but pauses at a 
True transition and waits for the RESUME command. The RESUME 
command is issued to a recipe level that is in the S_AUTO mode. 
S_AUTO is a valid mode for all recipe levels. 

• MANUAL: The batch sequencing is stopped. Commands are sent to 
lower recipe level steps. The change active step command is only valid 
on a recipe level that is in manual mode. MANUAL is not a valid mode 
for the phase level. 

 

Place a batch in auto mode 

 
 
 
 
 
 
 

 
Place a batch in semi-auto 
mode 

 
A batch that is in semi-auto or manual mode must be placed in auto mode to 
resume normal execution. 

 

To place a batch in auto mode 
1. Select Batches. 
2. Select a batch. The batch opens to the Detail section. 

Tip: To place the entire batch in auto mode, select the highest recipe level such as the 
operation, unit procedure, or procedure and place it in auto mode. 

3. Select Summary or Detail, and then select the item to place in auto 
mode. 

4. Select Auto. The mode changes to Auto. 
Tip: Depending on the situation, the batch may resume normal execution. Or, in the case of 
Failures/Warm all server restarts, the procedure changes to Manual mode. In these cases, 
after switching to Auto, a restart may be required or failures (if they exist) must be cleared 
before restarting. 

 
 

Place a batch in semi-auto mode to control the execution of steps in a specific 
recipe level. Place a batch level in semi-auto mode when the batch is in 
manual or auto mode. When a batch is placed in semi-auto mode, all higher 
level steps are placed in manual mode, and all lower level steps are placed in 
auto mode. 
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To place a batch in semi-auto mode 
1. Select Batches. 
2. Select a batch. The batch opens to the Detail section. 
3. Select Summary or Detail. 
4. Select the batch level to place in semi-auto mode. 
5. Select Semi-auto. 
6. To continue execution, select the step to resume and select Resume. 

The step transitions to the RUNNING state. 
7. Select Resume for each subordinate step. 
8. Place the batch in auto mode to continue normal execution or perform 

semi-auto processing at another batch level. 
 

Place a batch in manual 
mode 

 
 
 
 
 
 
 
 
 
 

 
View sequential function 
charts of the current batch 

 
Use manual mode to stop automatic sequencing of a batch. A batch in manual 
mode allows any lower-level active steps to complete without automatically 
transitioning to the next step. 

For example, to determine which step to execute through changing an active 
step, place a batch in manual mode. Two things happen when placing a batch 
level in manual mode: 

• Any higher-level recipes that contain the batch level you put into 
manual mode, also go into manual mode. 

• Any lower-level steps contained by the batch level in manual mode go 
into O-AUTO mode. 

 

To place a batch in manual mode 
1. Select Batches. 
2. Select a batch. The batch opens to the Detail section. 
3. Select Summary or Detail. 
4. Select the batch level containing the steps to be manually commanded. 
5. Select Manual. The active step completes, but the transition does not 

fire, even if its expression evaluates to True. The step transitions to the 
COMPLETE state. 

6. To resume execution, place the batch in auto mode. 
 

Batches > Detail displays the sequential function charts (SFCs) view of the 
selected batch. 

When no steps or transitions are selected, view the recipe and report 
parameters of the batch level on the Params and Reports tabs. Select a step to 
view that step’s recipe and report parameters. 
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To view sequential function charts of a batch 
1. View the recipe and report parameters by selecting a step or selecting a 

breadcrumb in the banner above the SFC chart. Navigate to different 
levels of the batch by selecting the down arrow on the associated step. 

 Tip: The displayed SFC chart is resizable. 

2. View the transition details by selecting the transition expression. For 
an active or armed transition, the current and expected values are 
displayed separately in the Detail section. 

Tip: The values update dynamically as long as the transition expression is selected. 
 

 

View and manage system 
elements from the Batch 
Detail 

 
 

View arbitration information 
from the Batch Detail 

 
 
 
 
 

Acquire a system element 
from the Batch Detail 

You can view, acquire, release, and reorder system elements from Batch 
Detail > Arbitration. 

If a batch is attempting to acquire a system element that is already owned, the 
execution status of the transition is set to Acquiring. 

When a system element is released, it is acquired by the next system element 
in the queue, in the order shown in the Needed By list. 

 

To navigate to details of a system element, select a batch and use Batch Detail 
> Arbitration. 

 
To view arbitration information from the Batch Detail 

1. Select Batches. 
2. Select the batch that contains the system element to be viewed. 
3. In the Batch Detail display, select the Arbitration tab. 
4. In the Owns, Owned By, Needs, or Needed By lists, select the  

menu, and select View <system element>. 

 
A system element is acquired either when it is not owned or the number of 
current owners is fewer than the defined maximum number of owners. Only 
the current owner can release a system element. 

Tips: 
• Only authorized users (acting as the operator) can acquire a system element, as 

configured in FactoryTalk Batch Security settings. 
• A request to acquire an owned system element is queued. When the system element is released, 

the next system element in the queue acquires that system element automatically. 
 
 

To acquire a system element from the Batch Detail 
1. Select Batches. 
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2. Select that batch that has the system element to be acquired. 
3. In the Batch Detail display, select the Arbitration tab. 
4. In the Owns area, select the  menu next to the system element to 

acquire, and select Acquire. 
5. In the Authorize message, select Yes. 

If the system element is available, the current operator gains 
ownership of it. If the system element is not available, the current 
operator is added to the Needed By list at the end of the system 
element queue. 

 
 

Release a system element 
from the Batch Detail 

 
 
 
 
 
 
 

Reorder the Needed By 
queue from the Batch Detail 

Release a system element after previously acquiring it to make it available to 
other processes. 

Tip: Only authorized users (acting as the operator) can release a system element, as configured in 
FactoryTalk Batch Security settings. 

 
 

To release a system element from the Batch Detail 
1. Select Batches. 
2. Select the batch that has the system element to be released. 
3. In the Batch Detail display, select the Arbitration tab. 
4. In the Owns area, select the  menu next to the system element, and 

select Release. 
5. In the Authorize message, select Yes. 

 
To change the priority order for a system element waiting to acquire another 
system element, use Arbitration > Needed By. 

For example, Batch 1, Batch 2, and Batch 3 all request to acquire Unit 1, in that 
order. Batch 1 acquires Unit 1, Batch 2 is the first in the Needed By queue, and 
Batch 3 is last. A process change requires that Batch 3 needs to run before 
Batch 2. Reorder the Unit 1 Needed By queue so Batch 3 is next in the queue. 

 
To reorder the Needed By queue from the Batch Detail 

1. Select Batches. 
2. Select the batch that has the system element whose queue needs to be 

reordered. 
3. In the Batch Detail display, select the Arbitration tab. 
4. Select the system element. 
5. In the Needed By section, select the system element to be reordered. 
6. Select the Up or Down arrow. 
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Equipment 

 
 
 
 
 
 
 
 
 
 

 
View process cells, units, 
and phases or operation 
sequences in list view or 
diagram view 

 
 
 
 
 

Process cell 

Use Equipment for an equipment-centric view of the defined area model. The 
FactoryTalk Batch Equipment Editor defines the equipment that appears. 

There are three levels in Equipment displayed: process cell, unit, and phase or 
operation sequence. Each level includes run-time data and other information 
for each resource. From the phase level, you can view phase-specific 
information and run phases or operation sequences manually, independent of 
recipes. 

In Equipment, view the area model hierarchy using different views: 

• List view (default): Each item lists different values depending on the 
window size: either mobile or desktop size. More fields are available in 
desktop size. 

• Diagram view: Process cells, units, and phases or operation sequences 
appear as graphical elements in the area model. 

• Zoom in, zoom out, and zoom to fit buttons on the top left of the 
diagram view. 

• The top right of the diagram view describes which equipment level 
is being viewed: process cells, units, or phases/operation sequences. 

• Phase Summary view: View all phases or operation sequences for all 
units in all process cells at once in a list type view. 

 

There are several ways to view Equipment process cells, units, and phases or 
operation sequences. 

 

To view process cells, units, and phases or operation sequences 
1. Select Equipment. 
2. To the right of the Filter box, select a display type: 

• Select List to view the Equipment levels as a list of items. 
• Select Diagram to view the Equipment levels as graphical elements 

in the area model. 
• Select Phase Summary to view all phases or operation sequences at 

once in a list-type view. 
 

The Process Cell area includes each process cell in the selected area. The 
process cells are visible in two views: List view (default) and Diagram view. 
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Tips: 
• At the Process Cell level, the state counts indicate the number of active and inactive units in 

that process cell. 
• A unit is considered active if it contains one or more phases or operation sequences 

in the Running, Held, Stopped, or Aborted states. 
• A unit is considered inactive if all of its phases or operation sequences are in the Idle or 

Complete states. 
• The batch count increments only if a phase or operation sequence is executing as a step in a 

batch on the Batches list. 
• The Batch count number in Equipment may differ from the number in the Batches list because: 

• Equipment displays the actual bound equipment in the count number. 
• The Batches list number indicates the equipment requirement but not the bound equipment. 
• For example: If two running batches on the Batches list require the same phase, only one 

batch at a time can be bound to the phase. In Equipment, for the unit or process cell, the 
Batches count (in the List view) or the Active Batches count (in the Diagram view) displays a 
value of 1, even though there are two batches on the Batches list. 

 

List view 
• Process cell name. 
• Unit state count: 

• Active (Running, Held, Stopped, or Aborted) count. 
• Inactive (Idle or Complete) count. 

• Phase failure count, if phase failures exist. 
• Prompts count, if prompts exist. 

  Tip: The Prompts count includes unacknowledged prompts, signatures, and instructions. 

• Batches count. 
• Batch ID and batch state. 
• Process cell menu (appears after selecting the  menu): 

• Navigate Down: Navigates to the Units level. 
• Phases With Failures: Navigates to Phase Summary view and 

displays only phases belonging to the associated process cell that 
has failures. 

• Phases With Prompts: Navigates to Phase Summary view and 
displays only phases or operation sequences belonging to the 
associated process cell that has prompts. 

• Display Batches: If the process cell has associated batches, navigates 
to the Batches list and displays only batches associated with the 
process cell. 

• Display Prompts: If the process cell has associated prompts, 
navigates to Prompts and displays only prompts associated with the 
process cell. 

 

Diagram view 
• Process cell name. 
• Unit state count: 
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• Active (Running, Held, Stopped, or Aborted) count. 
• Inactive (Idle or Complete) count. 

• Phase failure count, if phase failures exist. 
• Prompts count, if prompts exist for the phases associated with the 

selected process cell. Selecting the Prompts count opens the Prompts 
page, which displays the prompts associated with that process cell. 

• Active batches count. Selecting the Active batches link opens the 
Batches list and displays only the batches associated with the process 
cell. 

• Hyperlinks, if configured, display near the process cell name. Selecting 
a hyperlink opens a new window. 

 

Unit 
 

The Unit area includes each unit in the selected Process Cell. The units are 
visible in two views: List view (default) and Diagram view. 

Tips: 
• At the Unit level, the state count indicates the number of active and inactive phases or 

operation sequences in that unit. The state is a rollup value that reflects the least to most 
critical phase state in the unit, in this order: Running, Held, Stopped, Aborted. 
• A phase or operation sequence is considered active if it is in the Running, Held, Stopped, or 

Aborted states. 
• A phase or operation sequence is considered inactive if it is in the Idle or Complete state. 

• The active batch count increments only if a phase or operation sequence is executing as a step 
in a batch on the Batches list. 

• The Batch count number in Equipment may differ from the number in the Batches list because: 
• Equipment displays the actual bound equipment in the count number. 
• The Batches list number indicates the equipment requirement but not the bound equipment. 
• For example: If two running batches on the Batches list require the same phase, only one 

batch at a time can be bound to the phase. In Equipment, for the unit or process cell, the 
Batches count (in the List view) or the Active Batches count (in the Diagram view) displays a 
value of 1, even though there are two batches on the Batches list. 

 

List view 
• Unit name and state. 
• Phase state count: 

• Active (Running, Held, Stopped, or Aborted) count. 
• Inactive (Idle or Complete) count. 

• Phase failure count, if phase failures exist. 
• Prompts count, if prompts exist for the phases associated with the 

selected unit. 
  Tip: The Prompts count includes unacknowledged prompts, signatures, and instructions. 

• Active batches count. 
• Batch ID and batch state. 
• Unit menu (appears after selecting the  menu): 

• Navigate Down: Navigates to the Phases level. 
• Navigate Up: Navigates to the Process Cell level. 
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• Phases With Failures: Navigates to Phase Summary view and 
displays only phases belonging to the associated unit that has 
failures. 

• Phases With Prompts: Navigates to Phase Summary view and 
displays only phases or operation sequence belonging to the 
associated unit that has prompts. 

• Display Batches: If the unit has associated batches, navigates to the 
Batches list and displays only batches associated with the unit. 

• Display Prompts: If the unit has associated prompts, navigates to 
Prompts and displays only prompts associated with the unit. 

 
Diagram view 

• Unit name and state. 
• Phase state count: 

• Active (Running, Held, Stopped, or Aborted) count. 
• Inactive (Idle or Complete) count. 

• Phase failure count, if phase failures exist. 
• Prompts count, if prompts exist for phases associated with the selected 

unit. Selecting the Prompts count opens the Prompts page and 
displays only prompts associated with that unit. 

• Active batches count. Selecting the Active batches link opens the 
Batches list and displays only the batches associated with that unit. 

• Flow path between units 
• Hyperlinks, if configured, display near the unit name. Selecting a 

hyperlink opens a new window. 
 

Phase 
 

The Phase area includes each phase contained in a Unit. View phases as a list 
or diagram. The phases are visible in two views: List view (default) and 
Diagram view. 

 

List view 
• Phase or operation sequence name. 
• Phase or operation sequence state. 
• Phase or operation sequence sub state name (Pausing and Paused). 
• Owner. 
• Step index only displays if the phase is not idle. 
• Mode only displays if the phase or operation sequence is acquired. 
• Phase failure count, if phase failures exist, selecting the phase displays 

the failure message near the phase name. 
• Prompts count, if prompts exist for the selected phase or operation 

sequence. Selecting a phase or operation sequence opens a command 
menu to the left of the phase list, which includes a Prompts link. 
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Selecting the Prompts link opens the Prompts page, which displays the 
prompts associated with that phase 

  Tip: The Prompts count includes unacknowledged prompts, signatures, and instructions. 

• Batch ID and batch state. Selecting the Batch ID link navigates to 
Batches > Detail for a regular batch or to Batches > Summary for a 
batch associated with Manual Phase Control or Manual Operation 
Sequence Control. 

• Phase menu (appears after selecting the  menu): 

• Navigate Up: Navigates to the Units level. 
• Display Batches: Navigates to Batches > Detail for a regular batch or 

to Batches > Summary for a batch associated with Manual Phase 
Control or Manual Operation Sequence Control. 

• Display Prompts: Navigates to Prompts and displays only prompts 
associated with the phase or operation sequence. 

 

Diagram view 
• Phase or operation sequence name. 
• Phase or operation sequence state count. 
• ActiveStep index displays only if phase or operation sequence is not 

IDLE. 
• Mode only displays if the phase or operation sequence is acquired. 
• Phase errors, if they exist, display failure text in a popup window if the 

Failure icon is selected. 
• Prompts count, if prompts exist for the selected phase. Selecting the 

Prompts count opens the Prompts page, which displays the prompts 
associated with that phase 

  Tip: The Prompts count includes unacknowledged prompts, signatures, and instructions. 

• Batch ID and batch state if a batch is assigned to a phase or operation 
sequence. Selecting the Batch ID navigates to Batches > Detail for a 
regular batch or to Batches > Summary for a batch associated with 
Manual Phase Control or Manual Operation Sequence Control. 

• Hyperlinks, if configured, display near the phase name. Selecting a 
hyperlink opens a new window. 

 

Manual phase control 
 

Use Equipment to view phase-specific information and command phases 
manually, independent of recipes. This forces the phase logic to execute. A 
phase can only be acquired when it is not currently owned. A phase must be 
acquired to use manual phase control. Manual phase control is useful for 
testing a recipe before releasing it to production. 
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Manually command a phase 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Manually command a 
material-based phase 

Manually controlling a phase creates a default batch ID. This ID is based on 
the control recipe that currently owns the unit. If no control recipe exists, the 
batch ID is the default BATCH_ID. 

 

To command a phase using manual phase control 
1. Select Equipment. 
2. Navigate to Phases and select the phase to control. 
3. Select Acquire . 

4. Select Start . 
5. If prompted, confirm the command. 
6. Click Yes to start the phase. 
7. Enter a unique batch ID when prompted and select OK. The phase 

displays the current step index, the active state, the owner, and the 
mode. The phase transitions to the RUNNING state and then to the 
COMPLETED state after all steps execute. 

8. If prompts display for the phase: 

a. Select Prompts. 

b. In Prompts, select the prompt and enter the appropriate value 

c. Select Acknowledge. 

Tip: If prompts are present, a x Prompts link displays in the left sidebar navigation. 
Selecting the Prompts link goes to the Prompts list, displaying only the prompts for that 
phase. 

9. When the phase completes, select Reset  to reset the phase. 

10. Select Release  to release the selected phase. 

 
Command a material-based phase using manual phase control in Equipment. 

WARNING: If communication with the Material Server fails while in Equipment, and the 
material policy option is configured for Switch to Manual, all containers associated with the 
phase display. The list is not filtered by the selected material. Use extreme caution when 
operating without the Material Server. Failure to select the correct container or phase pair 
could result in a hazardous 

 situation, depending on the material.  
 

To command a material-based phase using manual control 
1. Select Equipment. 

2. Select the material-enabled phase to acquire and select Acquire . 
3. If prompted, confirm the command. 

Tip: The manual phase control session requests ownership of the phase (and OPERATOR 
will appear in the phase’s Needed By list). The phase must be released by the control 
recipe, and then the operator acquires the phase. 

4. Select Start . 
5. If prompted, confirm the command. 



Chapter 5 FactoryTalk Batch View 

Rockwell Automation Publication# BATCH-GR011F-EN-P - May 
 

81 

 

 

6. If the phase is configured as both a material distribution and addition, 
from the Feed Type list, select the type for the phase. 

Tip: If the phase is not configured as both a material distribution and addition, the configured 
Feed Type for the material phase cannot change. 

7. Select a material to use from the Material list, and select Continue. 
8. Enter a unique batch ID. 
9. (optional) If a phase has a control strategy, select the strategy from the 

Control Strategy box. 
10. Select a container, and select OK. The batch state displays 

DOWNLOADING. 
Tip: If the phase has automatic uploads and downloads, Prompts shows the prompt(s) to 
acknowledge. 

11. If prompts generate for the phase, select Prompts. 
Tip: If prompts are present, an x Prompts link displays in the left sidebar navigation. 
Selecting the Prompts link goes to the Prompts list, displaying only the prompts for that 
phase. 

12. In Prompts, select the prompt, enter the appropriate value, and select 

Acknowledge . 

13. Once the phase completes, select the phase, and then select Reset . 

14. With the phase still selected, select Release . 
 

Manually command a phase 
with control strategies 

 
Command a phase with control strategies using manual phase control in 
Equipment. A control strategy identifies a subset of the phase class reports 
and parameters configured on a phase class to use at run-time. 

 

To command a phase with control strategies using manual control 
1. Select Equipment. 
2. Navigate to Phases and select the desired phase. 
3. Select Acquire . 
4. If prompted, confirm the command. 

Tip: The manual phase control session requests ownership of the phase (and OPERATOR 
will appear in the phase’s Needed By list). The phase must be released by the control 
recipe, and then the operator acquires the phase. 

5. Select Start . 
6. If prompted, confirm the command. 
7. Enter a unique batch ID when prompted. 
8. Select the strategy from the Control Strategy box, then select OK.  

IMPORTANT If Automatically Download Parameters Upon Start is selected when control 
strategies are configured for the phase instance in FactoryTalk Batch 
Equipment Editor, the FactoryTalk Batch Server downloads these parameters 
before the FactoryTalk Batch Server issues a START command to the phase. 
After verifying the download, the FactoryTalk Batch Server starts the phase. 
The batch state displays DOWNLOADING until the parameters are downloaded 
and acknowledged 

 in Prompts.  

9. If prompts generate for the phase, select Prompts. 
Tip: If prompts are present, a x Prompts link displays in the left sidebar navigation. 
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Selecting the 
Prompts link 
goes to the 
Prompts list, 
displaying only 
the prompts for 
that phase. 
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10. In Prompts, select the prompt, enter the appropriate value, and select 

Acknowledge . 

11. Once the phase completes, select the phase, and then select Reset . 

12. With the phase still selected, select Release . 
 

Manually command a phase 
in semi-auto mode 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hyperlinks 

 
Manually step through a phase using the SEMI-AUTO mode. The phase logic 
must set the Paused bit where appropriate. These programmed break points 
determine where the phase pauses while in semi-auto processing. 

 

To manually command a phase in semi-auto mode 
1. Select Equipment. 
2. Navigate to Phases and select the phase. 
3. Select Acquire . 

4. Select Start . 
5. If prompted, confirm the command. 
6. Click Yes to start the phase. 
7. Enter a unique batch ID when prompted and select OK. The phase 

displays the current step index, the active state, the owner, and the 
mode. The phase transitions to the RUNNING state and then to the 
COMPLETED state after all steps execute. 

8. Select Semi-Auto  to initiate phase processing. 
9. If prompts generate for the phase: 

a. Select Prompts. 

b. In Prompts, select the prompt and enter the value. 

c. Select Acknowledge . 

Tip: If prompts are present, a x Prompts link displays in the left sidebar navigation. 
Selecting the Prompts link goes to the Prompts list, displaying only the prompts for that 
phase. 

10. Select Resume  to restart phase execution. 

11. Select Auto  to return the phase to the AUTO mode. 

12. Once the phase completes, select Reset  to reset the phase. 

13. Select Release  to release the selected phase. 

 
Equipment includes up to five hyperlinks for each process cell, unit, and 
phase displayed. In the diagram view, view the hyperlinks near the equipment 
icon. 

Using the Equipment View Hyperlink feature with FactoryTalk Batch View 
requires changing the location of the files to link to the appropriate 
FactoryTalk Batch View directory. 
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Tip: The hyperlink descriptors and defaults are defined in the FactoryTalk Batch Equipment 
Editor. For more information, see the FactoryTalk Batch Equipment Editor User Guide. 

 

To create a hyperlink folder in the FactoryTalk Batch View directory 
1. In File Explorer, navigate to the FactoryTalk Batch View web root 

directory. If FactoryTalk Batch View is installed in the default 
location, this is: C:\Program Files (x86)\Rockwell Software\Batch View 
Server\Bin\wwwroot 

2. Create a new folder and enter a name for the folder, such as 
Project_Files. 

3. Place the files to be linked in this folder. 
4. In FactoryTalk Batch Equipment Editor, ensure that the path 

configured for the hyperlink matches the directory path set in step 2 
(such as /Project_Files/<file name>). 

5. Repeat steps 2-4 if using more than one folder for hyperlink files, such 
as Images or Video. 

 

View results of an area 
model update 

 
When an online area model is updated on the FactoryTalk Batch Server, 
FactoryTalk Batch View displays the changes and alerts the operator to the 
update. 

• During the online area model update, the FactoryTalk Batch View 
Server drops all but the essential connection to the FactoryTalk Batch 
Server. The operator cannot interact with the system and may see a 
Server Communication Error: Online Area Update message. 

• After the online area model update is complete, an Information 
message alerts the operator that the online area model was updated. 

When communication between the FactoryTalk Batch Server and FactoryTalk 
Batch View is lost and then restored, work in FactoryTalk Batch View is largely 
uninterrupted. 

However, in these circumstances, the operator is navigated to the top level 
location in the user interface: 

 

Before the update, if an operator is viewing the: After the update, the operator will be viewing the: 

• Batch Detail display • Batches list 
• Prompts/Acknowledge Signature Signoff page • Prompts list 
• Manual Instructions page • Prompts list 
• Diagnostics tab with Server, Statistics, 

Journals, or Arbitration selected 
• Diagnostics tab with Status selected 

• Process Cell, Unit, or Phase/Operation 
Sequence detail levels in the Equipment 
view 

• Top Area level 

• Help for a specific topic • Top level Help page 
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Diagnostics 

 
 
 
 
 
 
 

View server information 

 
 
 
 
 
 
 
 

View the status of servers 
and services 

Use Diagnostics to view server and service status, server performance, server 
statistics, batch event journals, and arbitration information. 

• Status - view version and connection information for the FactoryTalk 
Batch View, FactoryTalk Batch Server, FactoryTalk Services, 
eProcedure Server, and FactoryTalk Activation. Displays the status of 
configured data servers and services. 

• Server - view server performance, hardware, and software 
information. 

• Statistics - view information on connections, equipment model file 
name and save time, and perform tag verification. 

• Journals - view a list of all available event journals. 
• Arbitration - view, acquire, release, and reorder system elements. 

 
View the server performance, hardware, and software for the FactoryTalk 
Batch Server to troubleshoot server issues. 

 

To view the server information 
1. Select Diagnostics. 
2. Select Server. 
3. View the appropriate server information. 

• Uptime: View the uptime for the operating system, FactoryTalk Batch 
Server, and the FactoryTalk Batch View Service. 

• Memory: View the total amount of memory used, the amount of free 
memory available, and the amount of memory being used by the 
FactoryTalk Batch View Service. 

• Disk: View the total amount of disk space and the amount of free disk 
space available. 

 

The Status tab displays status and version information for services used by 
the application and the status for each data server used by the Batch Server. 

 
To view the status of servers and services 

1. Select Diagnostics. 
2. Select Status. 
3. View the appropriate server or service. 

• Services: View the status of the FactoryTalk Batch View Service, the 
FactoryTalk Batch Server, eProcedure Server, FactoryTalk Services, 
and FactoryTalk Activation. 

• Data Servers: View the status of the configured data servers, and 
the status of the Material Server. 
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Tips: The status of each service and data server is indicated by the color: 
• Green: Communication is good. 
• Yellow: Communication is suspect. 
• Orange: Communication is bad. 
• Red: Communication is lost. 

 

View statistics 

 
 
 
 
 
 

View connections 

 
 
 
 
 
 

 
View equipment model 
information 

 
The Statistics tab displays the following information: 

• Connection(s): Monitors the number of Component Object Model 
(COM) and OLE for Process Control (OPC) conversations taking place 
between the FactoryTalk Batch Server and client software, such as the 
FactoryTalk Batch View service, FactoryTalk Batch View, and HMI 
Controls. 

• Equipment Model: Displays the file name and the last saved time. 
• Tag Verification: Reads the current value of tags defined in the area 

mode and displays the number of verified tags, bad tags, and 
unverified tags. 

 

The Connections area monitors the number of Component Object Model 
(COM) and OLE for Process Control (OPC) conversations taking place 
between the FactoryTalk Batch Server and client software, such as the 
FactoryTalk Batch View service, FactoryTalk Batch View, and HMI Controls. 
Viewing the connections is helpful troubleshooting connection issues with the 
FactoryTalk Batch Server 

 

To view the connections 
1. Select Diagnostics. 
2. Select Statistics. 
3. View the item count, OPC connections, and COM connections in the 

Connections area. 

 
View the filename and timestamp of the equipment model in use. 

 

To view the equipment model information 
1. Select Diagnostics. 
2. Select Statistics. 
3. View the equipment model information: 

• File: File name of the equipment model. 
• Last Save Time: Last time the equipment model was saved. 
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Verify tags 

 
 
 
 
 
 

View and manage system 
elements from the 
Diagnostics page 

 
 

 
View arbitration information 
from the Diagnostics page 

 
 
 
 

Acquire a system element 
from the Diagnostics page 

Tag verification displays the number of verified tags, bad tags, and unverified 
tags. During tag verification, the count of tags verified, bad, and unverified 
displays. When tag verification completes, the count of verified and bad tags 
displays. 

 

To verify tags 
1. Select Diagnostics. 
2. Select Statistics. 
3. Select Start. 

  Tip: To abort tag verification, select Abort instead of Start. 

 
When you need to have an overall view or to manage system elements for an 
area, use Diagnostics > Arbitration. 

Diagnostics > Arbitration provides a method for displaying arbitration 
information from different perspectives. System elements have a limited 
number of owners based on their definition in the area model. System 
elements are acquired when they are not currently owned, or the number of 
current owners is fewer than the defined maximum number of owners. Only 
the current owner can release a system element. 

 

To navigate to details of a system element, use Diagnostics > Arbitration. 

 
To view arbitration information from the Diagnostics page 

1. Select Diagnostics. 
2. Select Arbitration. 
3. In Choose a System Element, select a type to filter the available 

options. 
4. In the System Element list, select the system element to be viewed. 

 
A system element can be acquired when it is not currently owned, or when the 
number of current owners is fewer than the defined maximum number of 
owners. 

Tips: 
•  Only authorized users (acting as the operator) can acquire a system element, as 

configured in FactoryTalk Batch Security settings. 
• A request to acquire an owned system element is queued. When the system element is released, 

the next system element in the queue acquires that system element automatically. 
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To acquire resources as an operator 
1. Select Diagnostics. 
2. Select Arbitration. 
3. In Choose a System Element, select a type to filter the available 

options. 
4. In the System Element list, select the system element to be acquired. 
5. In the  menu, select Acquire. 

If the system element is available, the current operator gains 
ownership of the system element. Otherwise, the current operator is 
added to the Needed By list at the end of the system element queue, 
and the system element is added to the operator's Needs list. 

 
 

Release a system element 
from the Diagnostics page 

 
 
 
 
 
 

 
Reorder the Needed By 
queue from the Diagnostics 
page 

Only the current owner of a system element of can release it. When finished 
commanding a system element, release it to make it available for other 
processes. 

Tip: Only authorized users (acting as the operator) can release a system element, as configured in 
FactoryTalk Batch Security settings. 

 
 

To release a system element from the Diagnostics page 
1. Select Diagnostics. 
2. Select Arbitration. 
3. In Choose a System Element, select a type to filter the available 

options. 
4. In the System Element list, select the system element to be released. 
5. In the  menu, select Release. 

 
To change the priority order for a system element waiting to acquire another 
system element, use Arbitration > Needed By. 

For example, Batch 1, Batch 2, and Batch 3 all request to acquire Unit 1, in that 
order. Batch 1 acquires Unit 1, Batch 2 is the first in the Needed By queue, and 
Batch 3 is last. A process change requires that Batch 3 needs to run before 
Batch 2. Reorder the Unit 1 Needed By queue so Batch 3 is next in the queue. 

 
To reorder the Needed By queue from the Diagnostics page 

1. Select Diagnostics. 
2. Select Arbitration. 
3. In Choose a System Element, select a system element type to filter the 

available options. 
4. In the System Element list, select the system element whose queue 

needs to be reordered. 
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5. In the Needed By section, select the system element. 
6. Select the Up or Down arrow. 

 

Material Server 
communications 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Reestablish communication 
with the Material Server on 
manual batches 

 
The Material Server Not in Use warning displays when commanding a 
material-enabled phase when communication with the Material Server has 
been lost. Reestablish communication with the Material Server, depending 
upon the FactoryTalk Batch Server configuration for material policies when 
communication with the Material Server is lost: 

• If the Material Policy on loss of communication is configured to 
Failure and Hold in the FactoryTalk Batch Server options, the 
FactoryTalk Batch Server automatically resumes communication with 
the Material Server when available. The Material Server status 
indicator changes to Good or green in Diagnostics > Status. Batches 
that were HELD continue to run. 

• If the Material Policy on loss of communication is configured to 
Switch to Manual in the FactoryTalk Batch Server options, reestablish 
communication with the Material Server when it becomes available 
again. When the Material Status indicator changes to Suspect or 
yellow, attempt reconnection to the Material Server. 

Tip: The status of each service and data server is indicated by the color: 
• Green: Communication is good. 
• Yellow: Communication is suspect. 
• Orange: Communication is bad. 
• Red: Communication is lost. 

All material-based decisions or selections made by the operator without 
communications with the Material Server are reported in Diagnostics > 
Journals as Loss of Material Server and Loss of Material Tracking events. 
When the material database becomes available, manually reconcile the event 
journal with the material journal and update the material database with the 
Amount, Lot, and Label information for material inventory. See the 
FactoryTalk Batch Material Editor User Guide for more information. 

After restoring communication with the Material Server, any material-based 
steps in a HELD state must finish executing to the COMPLETE state before 
further processing occurs. 

 

When the Material Status indicator changes to Suspect, attempt reconnection 
to the Material Server. 

 

IMPORTANT After restoring communication with the Material Server, manually reconcile the batch 
event journal with the material database. All Loss of Material Tracking and Loss of 
Material Server events indicate material steps that took place without Material Server 
communication. Use this information to manually update the Amount, Lot, and Label 
information for the material inventory in the material database. See the FactoryTalk 
Batch 

 Material Editor User Guide for more information.  
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Tip: The status of each service and data server is indicated by the color: 
• Green: Communication is good. 
• Yellow: Communication is suspect. 
• Orange: Communication is bad. 
• Red: Communication is lost. 

 

To reestablish communication with the Material Server on manual 
batches 

1. Select Diagnostics, then Status. 
2. In the Data Servers area, select Reconnect. 

Tip: Reconnect displays next to the Material Server status when the status changes to 
Suspect. 

 

Journals 

 
 
 
 
 

View the journal 

 
 
 
 
 

Sort and filter journal 
columns 

 
Journals displays the electronic batch record for a specific batch. The 
electronic batch record contains information about the events that occur 
during batch execution or phase execution. FactoryTalk Batch automatically 
creates the electronic batch record. 

View the electronic batch record while the batch or phase is running or after 
processing is complete. To specify the event types included in the electronic 
batch record, use the FactoryTalk Batch Equipment Editor Server Options 
dialog box. See the FactoryTalk Batch Equipment Editor User Guide for more 
information. 

 

View information about the events for batch or phase execution in the 
electronic batch record. 

 

To view the journal 
1. Select Diagnostics. 
2. Select Journals. 
3. Select the appropriate batch. The event journal for the batch appears. 

Tip: The journal is also available by selecting Batches > General and selecting the 
<batch create id>.evt file. 

 
 

Filter a journal to limit the data returned. Journal columns sort the data in 
ascending or descending order, with the highest order given to numbers and 
special characters, followed by alphabetical order. The default journal column 
is Time. A batch may run on three different units. By filtering on a specific 
unit, only data for the requested unit appears. 

 

IMPORTANT If FactoryTalk Batch Material Manager and FactoryTalk Batch eProcedure are not 
installed, the associated journal columns do not display. 
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To sort and filter journal columns 
1. Select Diagnostic > Journals and select a journal. 
2. To sort, select a column and then the column arrows. 
3. To filter, enter a parameter in a selected column. 

Tip: If a column does not appear, verify that the column is configured to display. 
 

 

Arbitration 

 
 
 
 
 
 
 
 
 
 
 
 
 

System elements in 
Arbitration 

When the FactoryTalk Batch Server uses system elements to execute recipes, 
it is called Arbitration. In FactoryTalk Batch View, the Arbitration view allows 
a user to interact with the arbitration process. An operator can see the status 
of system elements and can acquire, release, and reorder requests to acquire 
those system elements. System elements include process cells, units, phases, 
operation sequences, resources, batches, and the operator. 

When a system element receives a request to be acquired, the FactoryTalk 
Batch Server, on behalf of that system element, issues a request to acquire its 
own dependent system element or elements. Once the requested system 
element acquires its own dependent system elements, it can then be acquired 
by the operator or batch resource user. 

Tip: Only authorized users (acting as the operator) can acquire and release a system element, as 
configured in FactoryTalk Batch Security settings. 

Batches can request ownership of any system element that can be acquired, 
including process cells, units, phases, operation sequences, and resources. 
Batches cannot request ownership of another batch or the operator. 

The operator can request ownership of process cells, units, phases, operation 
sequences, and resources. The operator cannot request ownership of a batch. 

In FactoryTalk Batch View, the Arbitration view is available in these scenarios: 

• To provide an overall view and manage resources for an area, use 
Diagnostics > Arbitration. 

• To observe the execution of a single control recipe, use Batches > Batch 
Detail > Arbitration. 

 
System elements that can be arbitrated include: 

• Process cell. A logical grouping of equipment required for the 
production of one or more batches. 

• Unit. Consists of a collection of associated equipment and phases that 
can carry out one or more major processing activities. The operator 
can view equipment that a unit acquires, needs, or owns. 

• Phase. Represents a process action implemented as logic coordinating 
the use of equipment resources. Typically, phases are implemented as 
Equipment Phase Programs using the Phase Manager capability in 
Logix Designer and execute in a ControlLogix controller. 
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• Operation sequence. Coordinates the execution of phases. It is 
analogous to an operation recipe, except that the operation sequence 
executes in the ControlLogix controller, while an operation recipe 
executes in the FactoryTalk Batch Server. 

• Resource. Can be configured to have a dependency on another piece of 
equipment or another system element. 

• Batch. A process that leads to the production of finite quantities of 
material by subjecting quantities of input materials to a defined order 
of discontinuous processing actions that use one or more pieces of 
equipment. Requests ownership of units, operation sequences, phases, 
and resources. 

• Operator. Makes informed decisions about the use of equipment and 
control recipes for an area of the plant to keep the production process 
operating smoothly. It can request ownership of process cells, units, 
phases, operation sequences, and resources. 

 

How Arbitration works 
 

To own a system element, an operator or batch acquires it. When a phase or 
operation sequence system element is acquired, it can be commanded to 
change state. Sometimes, making a system element unavailable to the rest of 
the batch system is sufficient when managing simultaneously running 
batches. When use of a system element is complete, that system element is 
released. 

System elements are configured to have a maximum number of users. 
Acquiring a system element may make it unavailable to the rest of the 
FactoryTalk Batch system. 

For example, a storage tank can fill two units at a time via a piping manifold. 
The piping manifold between the tank and units is configured as an 
equipment resource, having a maximum of two owners. If three units need to 
draw material from the tank, the first two units that request to acquire the 
piping manifold are granted ownership. The third unit’s request to acquire 
the piping manifold is denied and is queued. After one of the owning units 
releases ownership of the piping manifold, the third unit gains ownership. 

When a system element requests ownership of another system element that is 
already at maximum ownership, the requesting system element is added to 
the Needed By list. When a system element is released by a prior owner, the 
next system element in the Needed By list automatically becomes its owner. If 
the Needed By list is empty, the system element is available to the next 
request to acquire it. 

Tips: 
• If a system element is already owned, attempting to acquire a system element increments 

the number of its requesters. 
• Units, phases, and operation sequences can have only one owner. 
• An operator can reorder the list of system elements in the Needed By list of a system element. 

To view and manage system elements, use these Arbitration options: 
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• Owns. A list of system elements that have been requested and are now 
owned. 

• Owned By. A list of system elements that own another system 
element. Units, phases, and operation sequences can be owned by 
only one system element at a time. Process cells and resources have 
configured maximum number of owners. 

• Needs. A list of requested system elements waiting to be acquired. The 
system element has an arbitration dependency on another system 
element. 

• Needed By. A list of system elements that have requested to acquire 
another system element and are waiting to do so. 

 

Use filters to search 
 

Filter to display prompts, signatures, control recipes, and equipment that 
meets the filter criteria. 

A filter expression can contain more than one AND or OR, and any 
combination of AND and OR operators. 

To narrow a search, use operators. To create a flexible and powerful filter, 
combine operators into expressions. Logical operators in expressions are 
applied in this order: 

1.  ( ) 
2. AND 
3. OR 

When multiple operators of the same precedence are used, they are applied 
from left to right. For example, b:A OR b:B AND b:C OR b:D evaluates in 
this order: 

• b:B AND b:C (AND takes precedence over OR) = Result 1 
• b:A OR Result 1 (first OR encountered from left to right) = Result 

2 
• Result 2 OR b:D (the next OR encountered from left to right) = final 

result 
Tips: 
• A space between filters is an implicit AND. For example, someString someString2 

is the same as someString AND someString2. 
• A search on someString includes all search fields. For example, a someString 
search would also contain results for recipe:someString, whereas a 
recipe:somestring search would limit someString results to the recipe 
field only. 

• A search can contain parentheses (and) to change the order of operation. 
• Do not use parentheses within an exact-match search string. For example: 
recipe:"some(st)ring" 

 
 

To use filters to search 
1. In the Filter box, enter keywords and operators. 
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The Filter box changes to orange, filter text displays to the right of the 
filter, and the number of filtered items out of total number of items. 
For example, 2/4 displays in parentheses beside the Clear Filter icon. 
To filter on: Use this operator: Example: 

Two or more 
keywords 

AND (all capital letters) vanilla AND speed 
returns a list of items that include the 
strings vanilla and speed. 

One of several 
keywords 

OR (all capital letters) vanilla OR speed 
returns a list of items that include the 
strings vanilla or speed. 

Exact keywords " " (quotation marks) "high limit" returns a list of 
items that include the string high 
limit. Quotation marks indicate 
the beginning and end of an exact 
phrase. The search returns matches 
only when a phrase is identical to the 
phrase within 
the quotation marks. 

 
 
 
 
 

Filter shortcuts for prompts 
and signatures 

2. Use shortcuts to help filter the list: 

• Filter shortcuts for prompts and signatures on page 93 
• Filter shortcuts for control recipes on page 94 
• Filter shortcuts for monitoring a batch on page 94 
• Filter shortcuts for master recipes on page 95 
• Filter shortcuts for equipment on page 95 
• Filter shortcuts for journals on page 96 

3. (optional) To clear the filter and show all entries, select Clear Filter. 

 
Use the following shortcuts to help filter the list of prompts, signatures, and 
instructions. 

The Filter box filters the list of prompts, signatures, and instructions using 
text containing alphanumeric characters, full words, fragments of a word, or a 
single letter or number. Use operators and filters for precise filtering. For 
example: description:premium AND recipe:vanilla. 

• To filter the displayed items by using the description, use 
description:descriptiontext, desc:descriptiontext, or 
d:descriptiontext. 

• To filter the displayed items by using the recipe name, use 
recipe:recipename or r:recipename. 

• To filter the displayed items by using the equipment units, use 
units:unitname or u:unitname. 

• To filter the displayed items by using the phase name, use 
phases:phasename or p:phasename. 

• To filter the displayed items by using the process cell, use 
processcells:processcellname or pc:processcellname. 

• To filter the displayed items for all signatures, use type:e or t:e. To 
filter the displayed items for all prompts, excluding signatures, use 
type:o or t:o. To filter the displayed items for all instruction 
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prompts, use type:m or t:m. To filter the displayed items for the 
instruction prompt state, select the box to the right of the Filter bar 
and select the state. 

• To filter the displayed items by using the batch ID, use 
batchid:batchname or b:batchname. 

• To filter the displayed items by using the create ID, use 
createid:createid or c:createid. 

 

Filter shortcuts for control 
recipes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Filter shortcuts for 
monitoring a batch 

 
Use the following shortcuts to help filter the list of control recipes. 

The Filter box filters the list of control recipes using alphanumeric characters, 
full words, fragments of a word, or a single letter or number. Use operators 
and filters for precise filtering. For example: description:premium AND 
recipe:vanilla. 

• To filter the displayed items by using the description, use 
description:descriptiontext, desc:descriptiontext, or 
d:descriptiontext. 

• To filter the displayed items by using the recipe name, use 
recipe:recipename or r:recipename. 

• To filter the displayed items by using the batch ID, use 
batchid:batchname or b:batchname. 

• To filter the displayed items by using the equipment units, use 
units:unitname or u:unitname. 

• To filter the displayed items by using the state of the batch, use 
state:statename or s:statename. 

• To filter the displayed items by showing batches with failures or 
showing batches without failures, use failure:yes or f:yes to show 
batches with failures and failure:no or f:no to show batches 
without failures. 

• To filter the displayed items by using the phase name, use 
phases:phasename or p:phasename. 

• To filter the displayed items by using the process cells, use 
processcells:processcellname or pc:processcellname. 

• To filter the displayed items by using the create ID, use 
createid:createid or c:createid. 

• To filter the displayed items by using the mode, use m:mode or 
mode:O_auto. 

 

In the Batch Detail display, use the following shortcuts to help filter in the 
Params, Reports, and Binding tabs. 

The Filter box filters the list of parameters, reports, and binding using text 
containing alphanumeric characters, full words, fragments of a word, or a 
single letter or number. Use operators and filters for precise filtering. For 
example: name:parametername or n:parametername. 
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• To filter parameters by using the name, use name:parametername or 
n:parametername 

• To filter parameters by using the value, use value:parametervalue 
or v:parametervalue 

• To filter parameters by using the engineering unit, use 
EngUnit:parametereu, e:parametereu, or eu:parametereu 

• To filter reports by using the name, use name:reportname or 
n:reportname 

• To filter reports by using the value, use value:reportvalue or 
v:reportvalue 

• To filter reports by using the engineering unit, use 
EngUnit:reporteu, eu:reporteu, or eu:reporteu 

• To filter binding by using the name, use name:bindingname or 
n:bindingname 

• To filter binding by using the type, use type:bindingtype or 
t:bindingtype 

• To filter binding by using the class or instance, use 
ClassOrInst:bindingClassOrInst or 
ci:bindingclassorinst 

 
 

Filter shortcuts for master 
recipes 

 
 
 
 
 
 
 
 
 

Filter shortcuts for 
equipment 

The Filter box filters the list of master recipes using text containing 
alphanumeric characters, full words, fragments of a word, or a single letter or 
number. Use operators and filters for precise filtering. For example: 
description:premium AND recipe:vanilla. 

To filter the displayed items: 

• Using the description, use description:descriptiontext, 
desc:descriptiontext, or d:descriptiontext. 

• Using the recipe name, use recipe:recipename or r:recipename. 
• Using the procedure abstract, use abstract:abstractword or 

a:abstractword. 
• Using the equipment type, use equipment:equipmenttype or 

e:equipmenttype. Equipment types are: class, instance, and 
class/instance. 

• Using the recipe type, use recipetype:recipetypename or 
rt:recipetypename. Recipe types are procedure, unit procedure, 
and operation. 

• Using the product code, use productcode:productcode or 
pc:productcode. 

 

Use shortcuts to filter the list of equipment phases. 

The Filter box filters the list of equipment using text containing 
alphanumeric characters, full words, fragments of a word, or a single letter or 
number. Use operators and filters for precise filtering. For example: 
name:phasename AND failure:no. 
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The equipment data is hierarchical. Filtering is applied at all levels (process 
cells, units, phases) regardless of the level viewed. For example, entering the 
filter text phases:wp_heat_m2 in the Filter box at the process level only 
displays process cells that contain phases with the name wp_heat_m2. 

• To filter the displayed items by using the name, use name:name or 
n:name. 

• To filter the displayed items by using the equipment units, use 
units:unitname or u:unitname. 

• To filter the displayed items by using the batch ID, use 
batchid:batchname or b:batchname. 

• To filter the displayed items by using the state of the batch, use 
state:statename or s:statename. 

• To filter the displayed items by showing phases with failures or 
showing phases without failures, use failure:yes or f:yes to show 
phases with failures and failure:no or f:no to show phases without 
failures. 

• To filter the displayed items by using the mode, use mode:modename 
or m:modename. 

• To filter the displayed items by using the owner, use 
owner:ownername or o:ownername. 

• To filter the displayed items by using the process cells, use 
processcells:processcellname or pc:processcellname. 

• To filter the displayed items by using the phase name, use 
phases:phasename or p:phasename. 

• To filter the displayed items by showing phases with prompts or 
phases without prompts, use prompts:yes or pr:yes to show phases 
with prompts and prompts:no or pr:no to show phases without 
prompts. 

 

Filter shortcuts for journals 
 

Use the following shortcuts to filter the list of journals in Diagnostics > 
Journals. 

The Filter box filters the list of journals using text containing alphanumeric 
characters, full words, fragments of a word, or a single letter or number. Use 
operators and filters for precise filtering. For example: 
description:premium AND recipe:vanilla. 

• To filter the search by description, use 
description:descriptiontext, desc: descriptiontext, or 
d:descriptiontext. 

• To filter the search by recipe name, use recipe:recipename or 
r:recipename. 

• To filter the search by batch ID, use batchid:batchname or 
b:batchname. 

• To filter the search by time, use time:timestamp or t:timestamp. 
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Binding 

 
 
 
 
 
 

Unit binding 

Binding is the process of mapping steps within a control recipe to actual 
equipment in a plant. Binding occurs as follows: 

• Unit binding is the process of selecting a unit that meets the criteria of 
a recipe’s unit requirement. The binding process allows the step and 
data references to be mapped to tags and phase programs at runtime. 
Unit binding is available for class-based recipes only. 

• Material phase binding is the process of either binding unbound 
material-enabled phase steps to a material phase and associated 
container or rebinding a previously bound material-enabled phase step 
within a control recipe. 

 

Unit binding is the process of selecting a unit that meets the criteria of a 
recipe’s unit requirement. The binding process allows the step and data 
references to be mapped to tags and phase programs at runtime. Unit binding 
is available for class-based recipes only. 

Tip: Because $Null and $Timer are system procedures that are run by the FactoryTalk Batch Server 
at any level of a recipe, they do not require or display binding data. 

Unit binding can occur at each of these levels: 

• Operation recipe. Coordinates the execution of phases. An operation 
recipe is constrained to run in one unit and has one unit requirement. 
Each step of an operation recipe is mapped to a phase that performs 
the configured action. At runtime, when the operation batch is bound 
to a unit, its steps can be mapped to phase programs. 

• When an operation is a top-level procedure, the unit binding is 
either instance-based (defined to run in a specific unit) or class- 
based (uses the batch creation binding method to select a unit). 

• When an operation recipe is within a unit procedure, it is assigned 
the bound unit of the unit procedure. For example, if a unit 
procedure runs three operation recipes in series, each operation 
recipe must run in the same unit as the unit procedure. When the 
unit procedure is bound, all operations that run within it are also 
bound. 

• Unit procedure recipe. Coordinates the execution of operations. A unit 
procedure recipe is constrained to run in one unit and has one unit 
requirement. Steps referencing operation recipes use the bound unit 
to map steps to phases. 

• When a unit procedure is a top-level procedure, the unit binding is 
either instance-based (defined to run in a specific unit) or class- 
based (uses the batch creation binding method to select a unit). 

• When a unit procedure recipe is within a batch procedure, it is 
assigned the bound unit of the batch procedure step. 

• Batch procedure recipe. Coordinates the execution of unit procedures. 
A batch procedure recipe can span many units. Each unit procedure 
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step references a unit requirement. Before the step can run, its unit 
requirement must be bound to a unit. When a step is bound, the step’s 
unit procedure, the operation recipes referenced by the unit 
procedure, and all the phases the operation recipes reference are also 
bound. All the phases and operation sequences within the batch 
procedure’s step are mapped to the phases and operation sequences 
that can perform the configured actions. 

The four methods for binding units in a batch procedure recipe are: 

• First Available. The FactoryTalk Batch Server attempts to acquire all 
legal binding candidates. The first available candidate is bound. The 
remaining requests are canceled. If there are no If there are no unit 
binding candidates, the batch is held with a failure. 

Tip: In the case of a failure, the operator must clear the failure, resolve the binding candidate 
issue, and restart the batch. 

• Prompt. When a unit procedure is ready to run, the FactoryTalk Batch 
Server generates a prompt. An operator must respond to the prompt 
and assign the unit for binding. The unit instance selected by the 
operator is acquired and bound to the unit requirement. 

Tip: The order of binding candidates in a prompt reflects the application of binding 
preferences, if they are configured. 

• Batch Creation. When a batch is being created and added to the 
Batches list, the operator is prompted to select a unit from a list of unit 
candidates. If there are no binding candidates, an error message is 
displayed, indicating that no units met the recipe’s unit requirement. 
The batch is not created, and the batch is not added to the Batches list. 

Tip: When binding expressions are used with creation binding, the expressions are 
evaluated when the batch is created. In this scenario, the value of the expression can 
change after the binding occurs. To avoid this situation, use the Prompt or First 
Available options. 

• Operator Choice. When the batch is created, the operator chooses a 
unit or can select First Available or Prompt binding. 

 

Understand unit 
requirements 

 
Unit requirements are configured in the FactoryTalk Batch Recipe Editor. 
Unit requirements contain binding requirements and binding preferences. 

Tips: 
• Unit procedure recipes and operation level recipes run in one unit and have one unit 

requirement. A batch procedure recipe can have multiple unit requirements. 
• In a batch procedure recipe, the unit requirement name can be edited. In unit procedure recipes 

and operation recipes, the unit requirement is named after the Alias_<class name> unit class 
and cannot be edited. 

• A unit requirement name is displayed on a step in the Batch Detail display when a batch 
procedure step is not bound. If the step is bound, the bound unit name is displayed. 

• If the unit requirement is instance-based, it is by definition bound, and the bound unit 
name is displayed. 
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Understand creation unit 
binding and unit binding 
errors 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
View unit requirements 

Creation binding is a method that binds a unit to a unit requirement when a 
batch is being created from a recipe. Each unit requirement whose binding 
method is configured to be Creation binding prompts the operator to select a 
unit for binding before the batch is put on the Batches list. Only unit class 
members that pass all configured binding requirements are binding 
candidates. In addition: 

• The initial binding candidate list includes all unit instances. 
• The list is trimmed by the binding requirements. 
• The list is trimmed by evaluating flow paths. 
• The list is sorted based on binding preferences. 

Binding preferences provide the means to sort the candidate list to display the 
most preferred binding candidates at the top and the least preferred at the 
bottom. In addition: 

• If a unit does not meet a binding preference, it can still be selected. 
• Unmet binding preferences do not exclude units, while unmet binding 

requirements do exclude units. 

A creation binding error occurs when the FactoryTalk Batch Server cannot 
find units that meet a recipe’s unit requirement. The list of binding 
candidates is empty. The FactoryTalk Batch Server returns four kinds of data 
about a creation binding error: 

• Error message. No legal bind targets found for unit requirement: <unit 
requirement name>. 

• Why a unit instance has been rejected. For each unit instance of the 
unit class referenced by the unbound unit requirement, the error 
message displays the unit name and the reason it is not a legal binding 
candidate. 

• Identification of binding requirements applied. For each binding 
requirement of a unit requirement, the configuration of the binding 
rule is displayed. 

• Identification of binding requirements that are expressions. For each 
binding rule that is an expression, the expression and its terms are 
displayed as applied to each unit instance, as well as the expression's 
Boolean evaluation value. 

 

Unit requirements are configured in the FactoryTalk Batch Recipe Editor. 
Unit requirements contain binding requirements and binding preferences. 
View unit requirements during batch execution. 

 

To view unit requirements 
1. Select Batches. 
2. Select the batch that has the unit requirements you want to view. 
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3. In the Batch Detail display, select a top-level recipe or procedure or a 
unit procedure step. 

4. Select the Binding tab. Unit requirements summary information is 
displayed. 

Tip: To find a unit requirement in a list, select the Filter field and enter information about 
the unit. You can filter unit requirements by name, type, and class/instance. 

 

View unit binding 
requirements 

 
A binding requirement is an optional part of a unit requirement that specifies 
a logical expression (evaluating true or false) or a directive (including or 
excluding units based on configuration). A unit requirement can have any 
number of binding requirements. 

When attempting to bind a unit requirement during recipe execution, the 
entire set of binding requirements defined on the unit requirement is 
evaluated against each potential binding candidate. 

Units that are unable to meet every binding requirement defined on the unit 
requirement are eliminated as binding candidates for the unit requirement. A 
binding requirement expression, as defined within the FactoryTalk Batch 
Recipe Editor, evaluates either a True or False value (for example, 
"TEMPERATURE < 20.3"). 

View unit binding requirements during batch execution. 
 

To view unit binding requirements 
1. Select Batches. 
2. Select the batch that has the unit requirements you want to view. 
3. In the Batch Detail display, do either of the following: 

• For a unit procedure or an operation batch, select the background. 
• For a batch procedure, select a step to see that step’s unit 

requirement, or select the procedure to see all unit requirements 
associated with the batch procedure. 

4. Select the Binding tab. Summary information for the unit 
requirements is displayed. 

Tip: To find a unit requirement in a list, select the Filter field and enter information about 
the unit. You can filter unit requirements by name, type, and class/instance. 

5. Select the unit requirement. 
6. In the Unit Requirement details, view the binding requirements 

information, including type and description. 
Tip: If a binding requirement type is an expression, select the requirement to display the 
real- time dynamic values. 

7. When finished, select Close. 
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View unit binding 
preferences 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

View expression values for 
unit binding requirements 
and preferences 

A binding preference is an optional part of a unit requirement that specifies 
an arithmetic expression (evaluating to a number), a minimized or 
maximized parameter or attribute, or a directive (to prefer or avoid units 
based on configuration). A unit requirement can have any number of binding 
preferences. A binding preference can specify a preferred or avoided phase, an 
operation sequence, a unit attribute, an expression, or a minimized or 
maximized expression. 

View unit binding preferences during batch execution. 
 

To view unit binding preferences 
1. Select Batches. 
2. Select the batch that has the binding preferences you want to view. 
3. In the Batch Detail display, do either of the following: 

• For a unit procedure or an operation batch, select the procedure. 
• For a batch procedure, select a step to see that step’s unit 

requirement, or select the procedure to see all unit requirements 
associated with the batch procedure. 

4. Select the Binding tab. Summary information for the unit 
requirements is displayed. 

Tip: To find a unit requirement in a list, select the Filter field and enter information about 
the unit. You can filter unit requirements by name, type, and class/instance. 

5. Select the unit requirement. 
6. In the Unit Requirement details, view binding preferences 

information, including type and description. 
7. When finished, select Close. 

 
In the Binding Requirement Expression Values dialog box, a list of units is 
displayed that shows the potential legal binding candidates for a unit 
requirement. Each unit requirement displays: 

• The unit name 
• The current value (True or False), which shows whether unit binding 

candidates meet the selected binding requirement 
• The order of the units, based on the evaluation of the binding 

preference expressions 
Tip: If all preferences evaluate equally, the unit list is displayed with the lowest to highest 
equipment IDs, which are defined in the Area Model. 

• The current value, which dynamically updates as the inputs to the 
expression change, and which may reorder the units when the dialog 
box is closed and reopened 

• An expression value indicating whether the binding candidates meet 
the selected binding requirement 

Tip: If {???} is displayed in the dialog box, an expression cannot be evaluated by the 
FactoryTalk Batch Server. 
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View expression values for unit binding requirements and preferences during 
batch execution. 

 
To view expression values for unit binding requirements and 
preferences 

1. Select Batches. 
2. Select the batch that has the unit requirement expression data you 

want to view. 
3. In the Batch Detail display, do either of the following: 

• For a unit procedure or an operation batch, select the procedure. 
• For a batch procedure, select a step to see that step’s unit 

requirement, or select the procedure to see all unit requirements 
associated with the batch procedure. 

4. Select the Binding tab. Summary information for the unit 
requirements is displayed. 

Tip: To find a unit requirement in a list, select the Filter field and enter information about 
the unit. You can filter unit requirements by name, type, and class/instance. 

5. Select the unit requirement. 
6. In the Unit Requirement details, under Binding Requirements, select 

either a binding requirement or a binding preference to display the 
real-time values of the expressions. 

• For binding requirements, the Binding Requirement Expression 
Values dialog box is displayed. 

• For binding preferences, the Binding Preference Expression Values 
dialog box is displayed. 

7. View the expression data. 
  Tip: The current value updates in real-time. 

8. When finished, select Close. 
9. In the Unit Requirements dialog box, select Close. 

 

Manually bind a unit 
 

In a batch procedure control recipe, an operator can manually bind a unit to a 
unit requirement that is referenced by a unit procedure step. A previously 
bound unit requirement can also be manually unbound and rebound to a 
different unit. You can also reassign a unit procedure step for either Prompt 
binding or First Available binding. 

A unit requirement previously assigned to a unit can be manually reassigned 
to a different unit, as long as the unit procedure step is not active. 
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Prerequisites 
To perform manual binding to a unit procedure step in a batch procedure 
control recipe, make sure these conditions are met: 

• The unit requirement of the selected step is class-based. 
• The step is inactive or has a binding status of BINDING on the 

transition prior to the step. 
Tips: 
• When the binding workflow is initiated, the binding candidate list contains zero or more unit 

binding candidates and has First Available and Prompt binding options. 
• All steps within the batch procedure recipe that are associated with the same unit 

requirement are bound to the same unit. 
 
 

To manually bind a unit 
1. Select Batches. 
2. Select the procedure-level control recipe that has the unit procedure 

step to be bound. 
3. In the Batch Detail display, select the unit procedure step. 

4. Select Bind . 
5. In the Select Unit to Bind Unit Requirement list, select the appropriate 

binding option and select OK. 
Tip: The candidate list reflects the configuration of the unit requirement including the unit 
class, flow paths with upstream and downstream dependencies, and binding requirements. 
The list can be sorted by binding preferences. 

 

Set up prompted unit 
binding 

 
 
 
 
 
 
 

Respond to a unit binding 
prompt 

 
Prompted binding is the process of binding a unit to a unit procedure step 
after a prompt is generated. Only those unit requirements defined with the 
Prompt binding method generate a prompt. 

When prompted binding is configured, the execution of the batch pauses 
when the transition above the unbound step becomes true. 

 
To set up prompted unit binding 

1. Select Batches. 
2. Select a batch. 
3. In the Batch Detail display, select a unit procedure step. 

4. Select Bind . 
5. In Select Unit to Bind Unit Step, select Prompt. 
6. Select OK. 

 
Unit binding prompts are displayed when the operator has set up prompted 
binding for unit procedure steps. Respond to the unit binding prompts to 
select a unit to bind to a unit procedure step when the recipe is running. 
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To respond to a unit binding prompt 
1. Select Batches. 
2. Select a batch. 
3. In the Batch Detail display, select Start  to execute the recipe. 

The recipe is running, and a prompt alert is displayed. 

4. Select Prompts and select the unit binding prompt for the recipe that 
is running. 

5. Select a unit from the list. 
6. Select Acknowledge. 

 

Material Phase Binding 

 
 
 
 
 
 
 
 
 
 

Manually bind a material 
phase instance and 
associated container to a 
material phase step 

 
Material phase binding is the process of either: 

• Binding unbound material-enabled phase steps to a material phase 
and associated container 

• Rebinding a previously bound material-enabled phase step within a 
control recipe 

When configuring an operation recipe's step that references a material phase 
class, the operator can select one of the three types of binding: 

• A specific material phase and container. The operator chooses a 
specific phase and container pair from the list. 

• Automatic: The FactoryTalk Batch Server selects the equipment phase 
associated to the highest-priority container. 

• Prompt. The operator must select a phase/container while the recipe is 
running. 

To perform material binding, these criteria must be true: 

• The step is associated with a material-enabled phase class in the recipe. 
• The step is inactive or has a status of BINDING. 

 
A configured material requirement of the operation recipe’s step gives the 
FactoryTalk Batch Server and Material Server enough information to select 
and bind a phase instance and its associated material containers to a batch. 
As a result, the correct phase that has access to the ingredient required is 
selected and run. 

Manually binding a material-enabled phase step requires the operator to 
select not just a phase, but the container the phase is associated with, and 
depending on the material container type, the exact sublot (a specific 
measured amount of an ingredient) to be used. 

In an operation control recipe, an operator can manually bind a phase 
instance and associated container to a material phase that is referenced by an 
operation step. A previously bound material phase step can also be manually 
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unbound and rebound to a different phase/container. You can also reassign a 
material phase step for either Prompt binding or Automatic binding. 

A material phase step previously assigned to a phase/container can be 
reassigned manually to a different phase/container, as long as the material 
phase step has not already executed. 

 

Prerequisites 
To perform manual binding to a material phase step in a batch procedure 
control recipe, make sure these conditions are met: 

• The selected phase step is material-enabled. 
• If the step is set to Prompt binding and the FactoryTalk Batch Server 

has issued the operator bind prompt, the step is inactive or has a 
binding status of BINDING on the transition prior to the step. 

 

To manually bind a phase instance and associated container to a 
material phase step 

1. Select Batches. 
2. Select a batch that has the step that requires binding. 
3. In an operation's Batch Detail display, select the material phase step. 

4. Select Bind . 
5. In Binding a Material Phase Step, select a phase/container pair to bind 

to the material phase step. 
6. Select OK. 

 

Manually assign prompted 
material phase binding to a 
material phase step 

 
Prompted material phase binding is the process of binding a material phase 
after a prompt is generated. Only those requirements defined with the 
Prompted Binding method generate a prompt. 

When prompted material phase binding is set up, the execution of the batch 
pauses when the transition above the unbound step becomes true. 

 

Manually assign prompted material phase binding to a material phase 
step 

1. Select Batches. 
2. Select a batch. 
3. In the Batch Detail display, select a material step. 

4. Select Bind . 
5. In Binding a Material Phase Step, select Prompt. 
6. Select OK. 
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Respond to a material phase 
binding prompt 

Material phase binding prompts are displayed when the operator has set up 
prompted binding for material phase/container pairs. Respond to the binding 
prompts to select a material phase/container pair when the recipe is running. 

 

To respond to a material phase binding prompt 
1. Select Batches. 
2. Select a batch. 
3. In the Batch Detail display, select Start to execute the recipe. 

The recipe is running, and a prompt alert is displayed. 

4. Navigate to the Prompts list and select the material phase binding 
prompt for the recipe that is running. 

5. Select a material phase/container pair from the list. 

6. Select Acknowledge  
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FactoryTalk Batch View 
summary 

In this section, you: 

• Setup the connection to the FactoryTalk Batch View client. 
• Reviewed the use of prompts. 
• Created a control recipe. 
• Commanded a batch. 
• Monitored a batch. 
• Reviewed the equipment resources. 
• View diagnostic information. 
• Used filters to search for different items. 
• Reviewed the types of binding. 
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Chapter 6 
 
 

FactoryTalk Event Archiver 

 
FactoryTalk Event Archiver collects data from the batch record files (.evt files) 
generated by the FactoryTalk Batch Server, and stores the data in a SQL Server 
database. 

 

Features and capabilities 
The FactoryTalk Batch Server creates an electronic batch record for every 
batch on the Batch List. View this batch record file with a text processor or 
spreadsheet application. FactoryTalk Event Archiver collects data from each 
electronic batch record file and writes it to the database. Each electronic batch 
record file contains individual lines, each representing an event that occurred 
in a batch. FactoryTalk Event Archiver inserts a unique identifier with date 
and time to each event into the database. 

FactoryTalk Event Archiver writes data to the BatchHis SQL table in the 
BatchHistory database. FactoryTalk Event Archiver with Reporting Services 
writes data to the BHBatchHis SQL table in the BatchHistoryEx database. 

Configure FactoryTalk Event Archiver to archive data to the database in either 
of two ways: 

• End-of-Batch 
• Incremental 

With End-of-Batch archiving, FactoryTalk Event Archiver inserts records into 
the database after a batch is removed from the batch list. The FactoryTalk 
Batch Server initiates FactoryTalk Event Archiver when a batch is removed 
from the batch list to archive the removed batch. 

With Incremental archiving, FactoryTalk Event Archiver inserts records into 
the database on a pre-defined schedule. Configure this archiving time interval 
in FactoryTalk Batch Equipment Editor. 

When a control recipe on the FactoryTalk Batch Server executes, the server 
adds the name of the batch record file to the FactoryTalk Event Archiver work 
queue file (Archque.txt). After FactoryTalk Event Archiver inserts all of the 
electronic batch records into the database, and the file is marked for removal 
from the batch list, FactoryTalk Event Archiver removes the name of the batch 
record file from the work queue file. FactoryTalk Event Archiver does not 
delete the batch record file unless it is specifically configured. 



110 Rockwell Automation Publication# BATCH-GR011F-EN-P - May 
 

Chapter 6 FactoryTalk Event Archiver 
 

 

If FactoryTalk Event Archiver cannot successfully insert each item from the 
batch record file, it does not remove the name from the FactoryTalk Event 
Archiver work queue file. Each time FactoryTalk Event Archiver runs, it 
attempts to insert the records from each file listed in the queue into the 
database. In the event of a failure, FactoryTalk Event Archiver attempts to 
store the data later. This helps make sure that failures do not result in a loss of 
archived data. 

 

IMPORTANT When FactoryTalk Event Archiver runs at the end of a batch, the FactoryTalk Batch 
Server runs FactoryTalk Event Archiver as a Windows IDLE_PRIORITY process. If the 
system is busy, higher-priority functions supersede FactoryTalk Event Archiver 
slowing the 

 archiving process.  
 

System architecture 
 

FactoryTalk Event Archiver is a Windows service that archives events from 
the FactoryTalk Batch Server. Events are written to SQL database tables. View 
the events stored in the database as HTML reports with the Reporting 
Services. 

 

FactoryTalk Event Archiver with Reporting Services system 
architecture 

 

FactoryTalk Event Archiver can run incrementally while a batch is running, or 
after a batch completes. FactoryTalk Event Archiver executes in a continuous 
loop using these basic steps: 

1. The FactoryTalk Batch Server creates an event file. 
2. FactoryTalk Event Archiver reads event records from the event file and 

translates them into SQL statements. 
3. FactoryTalk Event Archiver writes the data to the SQL database. 
4. FactoryTalk Event Archiver logs all archiving activities to a log file. 
5. When Reporting Services is installed, reports can be generated from 

event data stored in the database. 
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Run the FactoryTalk Event 
Archiver to insert batch 
record data 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FactoryTalk Event Archiver 
summary 

Use the following instructions to run the FactoryTalk Event Archiver to insert 
batch record data. 

 

To run the FactoryTalk Event Archiver to insert batch record data: 
1. The operator or Manufacturing Execution System (MES) starts a 

batch. If it is to run in the incremental mode, the FactoryTalk Event 
Archiver must be enabled as a Windows service. 

2. An electronic batch record file (.evt) is created. 
3. The electronic batch record file's name is added to the electronic batch 

record directory file, EventDir.txt. 
4. The FactoryTalk Batch Server incrementally writes to the work queue 

file in FactoryTalk Event Archiver, ArchQue.txt. The data in this file 
consists of the path to the electronic batch record file and, if the batch 
has been removed from the batch list, a tab and the word REMOVED 
follows the file name. 

• End-of-Batch Archiving: When a batch is removed from the batch 
list, the FactoryTalk Batch Server sends a message to the 
FactoryTalk Event Archiver to start running. The FactoryTalk Event 
Archiver must be enabled. 

• Incremental Archiving: The FactoryTalk Event Archiver runs on a 
pre-defined schedule. The FactoryTalk Event Archiver must be 
active at all times during batch processing. 

5. The FactoryTalk Event Archiver reads the ArchQue.txt file for the 
name of the electronic batch record file and the status of the batch. 

6. The FactoryTalk Event Archiver reads the electronic batch record file. 
7. The FactoryTalk Event Archiver inserts records into the database. 
8. If electronic batch record data is successfully inserted into the 

database, the file’s name is removed from the ArchQue.txt file. 

Steps 4 through 7 are repeated until the FactoryTalk Event Archiver has 
attempted to insert each electronic batch record file listed in the ArchQue.txt 
file into the database. 

 

In this section you: 

• Learned about the system architecture of the FactoryTalk Event 
Archiver. 

This chapter provided a brief overview of the capabilities of the FactoryTalk 
Event Archiver. (See the FactoryTalk Event Archiver User Guide for more 
information.) 
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Chapter 7 
 
 

FactoryTalk Batch View HMI Controls 

 
The FactoryTalk® Batch View HMI controls provide an interface that allows 
users to monitor and interact with the production process within a 
FactoryTalk View SE Display Client. The FactoryTalk Batch View HMI controls 
consist of: 

• BatchesList control: Creates control recipes, displays current control 
recipes, and commands a control recipe. Shown as 
BatchViewHMI.BatchesList in the Insert HMI Controls dialog box 
and the Property Panel. 

• PromptsList control: Displays a list of prompts that are waiting to be 
acknowledged, a list of electronic signatures associated with a batch 
that are waiting for signoff, and instructions waiting to be 
acknowledged. Shown as BatchViewHMI.PromptsList in the Insert 
HMI Controls dialog box and the Property Panel. 

• SFC control: Enables the ability to command batches during 
FactoryTalk View SE runtime on the Details and Summary pages of the 
SFC. Shown as BatchViewHMI.SFC in the Insert HMI Controls 
dialog box and the Property Panel. 

• Full control: Accesses the entire FactoryTalk Batch View site. In 
FactoryTalk View SE, shown as BatchViewHMI.FullView in the Insert 
HMI Controls dialog box and the Property Panel. 

 

BatchesList control 

 
 
 
 
 
 

PromptsList control 

 
Use the BatchesList control to create, view, and command control recipes. 
Access the BatchesList control by placing it in a FactoryTalk View SE display. 
Control recipes are displayed on the Batches list until they are removed by the 
operator or when the FactoryTalk Batch Server is restarted with a cold boot. 

Refer to the FactoryTalk Batch View HMI Controls User Manual to learn more 
about: 

• BatchesList control methods 
• BatchesList control properties 
• BatchesList control events 
• BatchesList control scripting support 
• Base filter shortcuts for the BatchesList control 

 
The PromptsList control displays a list of prompts and instructions waiting to 
be acknowledged and a list of electronic signatures associated with a batch 
that are waiting for signoff. 
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SFC control 

 
 
 
 
 

 
Full control 

Prompts alert operators to requests for information. A control recipe cannot 
complete execution until the operator provides the requested information. A 
pending request for information remains unacknowledged until a user 
provides the information, stops, or aborts the control recipe. Requests for 
information include prompts, manual instructions, and signatures. 

• Prompts alert operators to requests for parameter values, unit binding, 
and material binding. 

• Instructions are individual steps of a manual instruction phase. As a 
batch executes, the instruction or set of instructions for each active 
step appears. Instructions execute in the order specified within the 
master recipe. 

• Signatures are requests for signoffs that require user permissions and 
optional comments. When a signature is generated against a control 
recipe, acknowledge the signature by completing the associated 
signoffs. The requested user information in a signature is determined 
by the signature template. 

Refer to the FactoryTalk Batch View HMI Controls User Manual to learn more 
about: 

• PromptsList control methods 
• PromptsList control properties 
• PromptsList control events 
• PromptsList control scripting support 
• Base filter shortcuts for the PromptsList control 

 
The SFC control displays the SFC batch structure, which is the same as the 
FactoryTalk Batch View Batch Details display page. The SFC control supports 
the set of commands an operator can perform on a selected batch or step. The 
SFC control generates events when an operator interacts with the running 
batch. Some property data of the SFC control is maintained for scripting. 

Refer to the FactoryTalk Batch View HMI Controls User Manual to learn more 
about: 

• SFC control methods 
• SFC control properties 
• SFC control events 
• SFC control scripting support 

 
The Full control displays the entire FactoryTalk Batch View site, so that an 
operator can interact with the site using a single HMI control in a FactoryTalk 
View SE Display Client. 

Use the Full control to create, view, and command control recipes, 
acknowledge prompts and signatures, view equipment phases and diagnostic 
information, and view profile information. The Full control has some 
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Diagnostic bar overview 

 
 
 
 
 
 
 
 
 
 
 

Properties, methods, and 
events 

differences from viewing the BatchesList control or PromptsList control 
individually. In the Full control: 

• The FactoryTalk Batch View navigation bar is shown instead of the 
Diagnostic bar. 

• There is no BaseFilter property. 

Refer to the FactoryTalk Batch View HMI Controls User Manual to learn more 
about: 

• Full control methods 
• Full control properties 

 
The diagnostic bar provides status information when viewing the BatchesList 
control, PromptsList control, and SFC control in a FactoryTalk View SE 
Display Client. 

 

 

Item Description 
 

 Return to the Home page to view the list of items. 
 

 View the item count notification for the control type in 
the display window. If a base filter has been applied, 
the item count is the number of items after the filter 
was applied. If there is a syntax error in the base filter, 
the item count 
remains unchanged from the unfiltered list. 

 

 View the configured base filter value. The base filter icon 
only displays if a base filter is in use. 

 

 The name of the control type in the display window. 
 

 The domain and account name information for the logged 
in user. 

 

 The status of the FactoryTalk Batch Server's associated 
data servers and the FactoryTalk Batch Material server. 

 

 Provides access to the online help. 

 

Properties, methods, and events allow you to customize objects created by the 
FactoryTalk Batch View HMI controls. An object is a combination of code that 
can be treated as a unit, such as a control, form, or application. Each object is 
defined by a class. There are four object classes provided in the FactoryTalk 
Batch View HMI controls: BatchesList, PromptsList, SFC, and Full. Each of 
these objects has associated properties, methods, and events. 

• Property: A named attribute of a control, form, application, or other 
object. Properties define object characteristics such as size, color, and 
screen location, or the state (for example, enabled, disabled) of an 
object. 

• Method: A procedure that acts on an object. 
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• Event: An action (such as clicking the mouse or pressing a key) 
recognized by an object for which you can write code to respond. 
Events can occur as a result of a user action or program code or can be 
triggered by the control. 

 

Configure the control 
property settings 

 
In FactoryTalk View SE, configure the control properties using the Property 
Page or the Property Panel and then configure the control to use Visual 
Basic®. 

Tip: Behavior of the control properties differs depending on whether display caching is used. 
If caching is not used: 
Switching screen/display: If the user changed the design time value at runtime, returns to the 
design time value. 
If caching is used: 
Switching screen/display: If the design time value was changed at runtime, the screen is not 
reloaded so it never returns to the design time value. 
To enable caching: 
1. In FactoryTalk View SE, open Display Settings. 
2. In Cache After Displaying, select Yes. 
3. Select OK. 

 

Configure the control 
properties using the 
Property Page 

 
To configure the BatchesList control, the PromptsList control, the SFC 
control, and the Full control to communicate with FactoryTalk Batch View, 
customize the settings in the Property page for the control. 

 
Prerequisites 

• Open FactoryTalk View Studio. 
• Open a display that contains a FactoryTalk Batch View HMI Control. 

 
To configure the control properties using the Property page 

1. In the display window, right-click a FactoryTalk Batch View HMI 
control and select Properties. 

2. In Node, enter the computer where the FactoryTalk Batch server and 
the FactoryTalk Batch View server is installed. 

  Tip: The computer can be the machine name, machine IP address, or localhost. 

3. In Port, enter the port where the FactoryTalk Batch View server is 
configured to receive communication. 

Tip: The default port number is 443. If the FactoryTalk Batch View Service is installed on a 
different port, launch the client on the FactoryTalk Batch View Server machine to identify 
the port number. 

4. (optional) Perform any of these steps: 

• Select the Enable Commanding option. 

• In the BatchesList control, enables the ability to create and 
command batches during FactoryTalk View SE run-time. 
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• In the PromptsList control, enables the ability to respond to 
prompts, such as to enter parameter values and to acknowledge 
prompts, enables the ability to sign-off on electronic signatures, 
and enables the ability to respond to instructions. 

• In the SFC control, enables the ability to command batches 
during FactoryTalk View SE run-time on the Details and 
Summary pages of the SFC. 

• In the Full control, enables these abilities for batches and 
prompts. This property also enables the ability to perform 
Manual Phase Control in the Equipment page. 

5. (optional) These are available in BatchesList and PromptsList controls 
only: 

• To display the filter bar during FactoryTalk View SE run-time, select 
the Show Filter Bar option. 

• To display the batches or prompts in a minimized format, select the 
Minimal View option. 

• To limit the items shown during FactoryTalk View SE run-time, 
enter an expression in Base Filter. 

6. Select Apply, and then select OK. 
7. In the FactoryTalk View SE toolbar, select Save. 

 

Configure the control 
properties using the 
Property Panel 

 
To configure the BatchesList control, the PromptsList control, the SFC 
control, and the Full control to communicate with FactoryTalk Batch View, 
customize the settings in the Property Panel for each control. 

 
Prerequisites: 

• Open FactoryTalk View Studio. 
• Open a display that contains a FactoryTalk Batch View HMI control. 

 
To configure the control properties using the Property Panel 

1. In the display window, right-click a FactoryTalk Batch View HMI 
control and if it is not already displayed, select Property Panel. 

2. In Node, enter the computer where the FactoryTalk Batch server and 
the FactoryTalk Batch View server are installed. 

  Tip: The computer can be the machine name, machine IP address, or localhost. 

3. In Port, enter the port where the FactoryTalk Batch View server is 
configured to receive communication. 

Tips: 
• The default port number is 443. If the FactoryTalk Batch View Service is installed on a different 

port, launch the client on the FactoryTalk Batch View Server machine to identify the port 
number in the URL. 

• The port number is not shown in the URL if the default port number (443) is in use. 
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4. (optional) Perform any of these actions. 

• (If available) To display the filter bar during FactoryTalk View SE 
runtime, select True for the ShowFilterBar option. 

• To enable specific behavior for controls, select True for the 
EnableCommand property option. 

• In the BatchesList control, enables the ability to create and 
command batches during FactoryTalk View SE runtime. 

• In the PromptsList control, enables the ability to respond to 
prompts, such as to enter parameter values and to acknowledge 
prompts, enables the ability to sign-off on electronic signatures, 
and enables the ability to respond to instructions. 

• In the SFC control, enables the ability to command batches 
during FactoryTalk View SE runtime on the Batch Details display 
and the Summary page of the SFC. 

• In the Full control, enables these abilities for batches and 
prompts. This property also enables the ability to perform 
Manual Phase Control in the Equipment page. 

5. (optional) Theses are available in BatchesList and PromptsList 
controls only: 

• To display the batches or prompts in a minimized format, select the 
Minimal View option. 

• To limit the items shown during FactoryTalk View SE runtime, 
enter an expression in Base Filter. 

6. Close the Property Panel. 
7. Select Save. 

 

Configure the control to use 
VBA 

 
To configure the BatchesList control, the PromptsList control, SFC control, 
and the Full control to use Visual Basic, customize the ExposeToVBA setting 
in the Property Panel. 

 
Prerequisites: 

• Open FactoryTalk View Studio. 
• Open a display that contains the FactoryTalk Batch View HMI control. 

 
To configure the control to use VBA 

1. In the display window, right-click the control. 
2. Select Property Panel. 
3. In ExposeToVBA, select VBA Control to use VBA for scripting. 
4. Close the Property Panel window. 
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5. Select Save. The control properties, methods, and events are now 
exposed to VBA, where you can modify and manipulate the control 
using VBA code. 

 

Languages 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Generate language locales 
on the FactoryTalk Batch 
View Server 

 
The HMI User Controls inherits the language configured within FactoryTalk 
View SE. 

Tip: For more information on FactoryTalk View SE language settings, see Set up languages for an 
application (General tab) in FactoryTalk View SE help. 

The language configured in FactoryTalk View SE requires corresponding files 
configured in FactoryTalk Batch View Server to support the full 
implementation of language-switching. If a FactoryTalk View SE language is 
not supported on the FactoryTalk Batch View Server, the language defaults to 
English (EN). 

The user control language can be changed at runtime using the FactoryTalk 
View SE language-switching mechanism. 

With HMI Controls, you can: 

• Generate language locales on the FactoryTalk Batch View Server: Add 
a language locale using a program that requires a .csv input file 
containing the string translations. FactoryTalk Batch View uses the 
language definition file selected in the Language list. 

• Run the localize tool via command prompt: The localize tool validates 
the .csv file that contains the languages FactoryTalk Batch View uses. 
The localize tool generates a language definition file for each locale 
definition. The language definition files allow FactoryTalk Batch View 
to select different languages in the Profile area. 

• Run the localize tool with a GUI: The localize tool validates the .csv file, 
and generates a language definition file for each locale definition. The 
language definition files allow FactoryTalk Batch View to select 
different languages in the Profile area. 

• View supported languages: Supported languages are defined in and 
can be viewed from FactoryTalk View SE. 

 
 

You can add a language locale by using an application that can read a .csv 
input file containing the string translations. FactoryTalk Batch View uses the 
language definition file selected in the Language list. 

 

To generate a language locale 
1. Navigate to the FactoryTalk Batch View install location on the 

computer. 
Tip: The default FactoryTalk Batch View install location is Program Files (x86) > Rockwell 
Software > Batch View Server > tools. 
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2. Use Microsoft Excel or another spreadsheet program to open the file: 
localized_strings.xlsm. 

3. In Row 1, add the new language name code to the next available 
column. For example, for Spanish, use es in FactoryTalk Batch View 
and use es-ES for HMI User Control integration with FactoryTalk View 
SE. 

4. Replace the English user interface term with the specific language 
translation for the user interface term in the row. Repeat until all 
terms have translations. 

5. Save the localized_strings.xlsm file. 
6. Export to .csv and save the file as localizedstrings.csv. 
7. Run the localize tool. 

 

Run the localize tool with 
command-line options 

 
 
 
 
 
 
 
 
 
 
 

Run the localize tool 
with with a GUI 

 
The localize tool validates the .csv file that contains the languages FactoryTalk 
Batch View uses. The localize tool generates a language definition file for each 
locale definition. The language definition files allow FactoryTalk Batch View 
to select different languages in the Profile area. Use command-line options to 
generate the language definition file as part of the install command. 

 

Prerequisites 
• If the locales folder does not exist, create it in the install directory. The 

default install location is Program Files (x86) > Rockwell Software > 
Batch View Server. 

 
To run the localize tool 

1. Open a command prompt. 
2. Set the command prompt path to the tools directory in the install 

directory. For example, C:/Program Files (x86)/Rockwell 
Software/Batch View Server/tools. 

3. Enter localize-tool.exe install –c 
./localizedstrings.csv –i ..\locales. 
The tool runs and generates a language definition file. 

 

The localize tool validates the .csv file and generates a language definition file 
for each locale definition. The language definition files allow FactoryTalk 
Batch View to select different languages in the Profile area. A graphical user 
interface (GUI) steps you through selecting the localized strings files and the 
directory in which to install the languages. 
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Prerequisites 
• If the locales folder does not exist, create it in the install directory. The 

default install location is Program Files (x86) > Rockwell Software > 
Batch View Server. 

 
To run the localize tool with a GUI 

1. Open a command prompt. 
2. Set the command prompt path to the tools directory in the install 

directory. For example, C:/Program Files (x86)/Rockwell 
Software/Batch View Server/tools. 

3. Enter localize-tool.exe install. 

4. In the dialog box, select the localizedstrings.csv file. 
5. In the dialog box, select the folder where the language definition 

will be saved, by default the install directory, 
C:/Program Files (x86)/Rockwell Software/Batch 
View Server/locales. 
The tool runs and generates a language definition file. 
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Chapter 8 
 
 

PC-based phases introduction 

 
The PC-Based Phase option is an ActiveX control that allows you to design 
phases for use in FactoryTalk Batch recipes. These phases can be used for a 
variety of tasks, such as operator prompts, timers and calculations. A PC- 
based phase communicates with the FactoryTalk Batch Server and does not 
require a process-connected device. It can be used in place of phase logic, 
allowing you to decrease the amount of memory required within your 
process-connected device. 

PC-based phases use the Batch Phase Execution control, which encapsulates 
the FactoryTalk Batch phase logic interface and the OPC interface. The Batch 
Phase Execution control functions as a data server for PC-based phases and 
supports the full functionality of a FactoryTalk Batch phase. It is an SP-88- 
aware component and is used to provide Level 2 control of the FactoryTalk 
Batch Control system. The Batch Phase Execution control is a persistent 
component that supports automatic checkpointing. It can be accessed directly 
from within Visual Basic, Access, or any other Microsoft-compatible control 
container. 

(See the FactoryTalk Batch PC-Based Phase Programmer’s Technical Reference for 
more information.) 

 

PC-based phases 
 

A PC-based phase allows you to program a phase outside a process-connected 
device (PCD). You can program the phase to meet your own unique 
requirements from within your Microsoft-compatible control container. The 
PC-based phase works the same as any phase defined in a PCD, 
communicating with the FactoryTalk Batch Server through the Batch Phase 
Execution control. This allows you to save your system’s valuable memory for 
processes that require interaction with hardware. 

After a PC-based phase is created, the FactoryTalk Batch area model must be 
updated to include the new phase and the appropriate phase(s). Because the 
Batch Phase Execution control behaves as a data server, a new data server 
definition must be created. The data server definition is created using the 
FactoryTalk Batch Equipment Editor and defined using the Batch Phase 
Execution control’s communication parameters. The FactoryTalk Batch phase 
can then be added to your recipes. The PC-based phase must remain active 
during recipe execution, allowing the phase to communicate with the 
FactoryTalk Batch Server through the Batch Phase Execution control. 
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Execution of a PC-based 
phase example 

An example of a PC-based phase executing within a recipe is shown. The PC- 
based phase is created to prompt the operator to take a sample to Quality 
control (QC) and then enter the results. The phase communicates with the 
FactoryTalk Batch Server by way of the Batch Phase Execution control. The 
phase can direct the server to prompt the operator, wait for results and have 
the FactoryTalk Batch Server store the result in the electronic batch record. 
The recipe will only proceed if the result is within the appropriate range. 

In Step 1, as the batch is processed, the QC_Chk phase is executed. In Step 2, 
the QC_Chk phase displays a screen to the operator, requesting that the 
operator have QC take an in-process sample. The QC_Chk phase will not 
continue processing until the operator enters the QC result. In Step 3, When 
the operator enters the result, the QC_Chk phase sends the report value to the 
FactoryTalk Batch Server, using the Batch Phase Execution control, which 
stores the value in the electronic batch record. While the phase is executing, 
an activity log file is updated with process events. In Step 4, control is 
returned to the recipe, and it continues processing the balance of the 
transitions and steps. 
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PC-based phases summary 

 
In this section you: 

Chapter 8 PC-based phases introduction 

• Learned about the execution of PC-based phases. 

This chapter provided a brief overview of the capabilities of PC-based phases. 
(See the FactoryTalk Batch PC-Based Phase Programmer Technical Reference Guide 
for more information.) 
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Appendix A 
 
 

Glossary 

 
acquire 

To gain ownership of a resource. Resources can be acquired 
automatically when a batch runs. Resources can also be acquired 
manually in the Arbitration and Phase Control processes. 

 

acquiring 
Acquiring is a possible state of the Firing attribute of a transition. 
When the transition is in the Acquiring state, it has made non-binding 
related arbitration requests for resources needed by one or more steps 
following the transition. 

 

action 
 

 
An Action is a queued Execute command to the FactoryTalk Batch 
Server that is pending one or more Signature completions prior to 
being performed. 

 

action ID 
A 32-bit unsigned integer that uniquely identifies an action. 

 

activation file 
A text file that contains all of the activation information that is 
required to license a software product and allow it to properly 
function. While the file is simply plain text, the contents of the file are 
protected by a signature. 

 

ActiveX controls library 
The ActiveX Controls Library is a set of ActiveX Custom Controls that 
allows you to create and control batches without using the FactoryTalk 
Batch View, and also provides the ActiveX tools needed to create a 
custom user interface. 
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allocation 
A form of coordination control that assigns a resource. An allocation 
can be for the entire resource or for portions of a resource. 

 

AND (Divergence) 
A structure in the sequential function chart (SFC) that indicates steps 
are activated concurrently. 

 

approval process (for a recipe) 
An umbrella term for the Primary approval and Expedited approval 
processes that are used to validate the development and maintenance 
of batch recipes. (Only one process can be used at a time.) Using 
signature certification, the approvals process for a recipe safeguards 
design workflow in a formalized manner. This ensures each recipe is 
validated by authorized personnel before being released to production. 

 

arbitration 
A form of coordination control that determines how a resource should 
be allocated when there are more requests for the resource than can be 
accommodated at one time. 

 

area 
 
 

A component of a batch manufacturing site that is identified by 
physical, geographical or logical segmentation within the site. 

 

area model 
The physical component of a batch facility. A database that consists of 
all equipment in the facility and all of the tasks that it is capable of 
performing. 

 

assigning 
The act of issuing a value to a parameter. 
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automation server 
A software application that contains objects that can be used easily by 
other applications through the encapsulation and reuse of code. 

 

batch 
 
 
An entity that represents the production at any point in the process. A 
batch is a running control recipe. The material that is being produced 
or that has been produced by a single execution of a recipe is also 
considered a batch. 

 

batch control 
Consists of a sequence of one or more steps (phases) that must be 
performed in a defined order for a finite period of time to process 
finite quantities of input material to produce finished product. 

 

batch process 
A process that leads to the production of finite quantities of material 
by subjecting quantities of input materials to a defined order of 
discontinuous processing actions using one or more pieces of 
equipment. 

 

binding 
Binding is the process of mapping steps within a control recipe to 
actual equipment in a plant. 

 
binding (in transitions) 

Binding is a possible state of the Firing attribute of a transition. When 
the transition is in the Binding state, it is in the process of attempting 
to bind one or more of the steps following the transition. The binding 
process may involve the generation of binding prompts and/or the 
generation of arbitration requests. 

 
binding preference 

A Binding Preference is an object that can be evaluated against 
instance of a unit class in order to sort the legal bind targets for a unit 
requirement into a most preferred order. 
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binding requirement 
A Binding Requirement is an object that can be evaluated against 
instances of a unit class to determine which instances of the class are 
legal bind candidates for a unit requirement. When attempting to bind 
a unit requirement during recipe execution, the entire set of binding 
requirements defined on the unit requirement is evaluated against 
each potential binding candidate. Units that are unable to meet every 
binding requirement defined on the unit requirement are eliminated 
as potential binding candidates for the unit requirement. 

 

binding requirement expression 
A Binding Requirement Expression, as defined within the Equipment 
Editor, evaluates to either a TRUE or FALSE value. An example would 
be "TEMPERATURE < 20.3". 

 

check in 
Check in creates a new version of a recipe, which is read-only and 
designated with a ~Vn suffix (where n is the version number). 
Example: Checking in Make_sauce results in the creation of the 
Make_sauce~V1 version. 

 

check out 
Check out creates an editable WIP (work-in-progress) recipe, 
designated with a ~Vn_WIP suffix (where n is incremented by one). 
Example: Checking out Make_sauce~V1 results in the creation of 
Make_sauce~V2_WIP. Subsequently, when Make_sauce~V2_WIP is 
checked in, it will result in the read-only Make_sauce~V2 version. 

 
class-based recipe 

A recipe that specifies one or more unit classes for equipment 
requirements. The operator will then be required to specify a particular 
unit at the time the batch is created. 

 

client 
 
 
A component or subsystem that uses data or functionality provided by 
some other component or subsystem (the server). The term can also 
refer to the computer that executes this software, connecting to a 
server computer across a communication network. 
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command buttons 
The buttons used to initiate functions. 

 

comm err 
Comm Err is a possible state of the Firing attribute of a transition. 
When the transition is in the Comm Err state, a communications error 
with phase logic has been detected while the transition was in the 
Stopping/Resetting/Pending states of the firing process. The 
transition has rolled back to the beginning of the 
Stopping/Resetting/Pending process and is awaiting good 
communications and a RESTART command before re-initiating the 
firing process. 

 

committed 
Committed is a possible state of the Firing attribute of a transition. 
When the transition is in the Committed state, it has committed to the 
firing process, but is not in the process of firing because either the 
transition is in the HELD state or the parent procedure is in MANUAL 
mode. 

 

common resource 
A service that is provided to more than one requester. Common 
resources are identified as either exclusive-use resources or shared-use 
resources. 

 

control module 
A regulating device, a state-oriented device, or a combination of 
regulating and state-oriented devices that are controlled as a single 
device. This term applies to both physical equipment and the 
equipment entity. 

 

control recipe 
A type of recipe, which through its execution, defines the manufacture 
of a single batch of a specific product. 
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control strategy 
A user-defined grouping of phase and report parameters associated 
with a single phase. Organizing parameters into separate control 
strategies allows phases to assume multiple roles without generating 
unnecessary phase I/O. 

 

container recipe 
A recipe that contains one or more steps assigned to a specified 
operation-level recipe or unit procedure-level recipe retrieved when 
using the Find Recipe References option. 

 

coordination control 
A type of control that directs, initiates, or modifies the execution of the 
procedural control and the utilization of equipment entities. 

 

data server 
A data server provides runtime information to the FactoryTalk Batch 
Client or the HMI software. This information comes from the PLC or 
PCD. 

 

DCS (Distributed Control System) 
A Distributed Control System (DCS) is a control device. Logic 
(programs) contained in the DCS read or write to the inputs or outputs 
of the field devices. A DCS is sometimes referred to as the process- 
connected device (PCD). 

 

dedicated resource 
A resource used by only one step at a time inside a recipe structure. 

 

deferred parameter 
Step formula value that is put off and takes on the value of another 
parameter at a higher level within the recipe. This function has the 
effect of passing Recipe formula parameter data from one level of a 
recipe down to another. 
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display parameter 
The step formula value specified as being the one to be displayed as 
part of the SFC in the Procedure as SFC View window. 

 

download 
A request from a phase to the FactoryTalk Batch Server to send it data. 

 

downstream unit requirements 
If dynamic unit allocation is enabled, downstream unit requirements 
may be defined for class-based and instance-based unit procedures. 
Downstream unit requirements are used to control batch flow and to 
make sure that the appropriate unit is selected during unit-binding. 

 

dynamic unit allocation 
The process of binding a specific unit to a class-based unit procedure 
or operation. Dynamic unit allocation can be defined only at the 
procedural level. 

 

electronic signature 
An electronic representation of a signature, including all associated 
data. Can consist of one or two signoffs. Associated data includes 
meanings for the signoffs, comments, security requirements, and 
timestamps. 

 

enterprise 
An organization that coordinates the operation of one or more sites. 

 

end of batch archiving 
The FactoryTalk Batch Server automatically runs the Archiver when a 
batch is removed from the Batch list. 

 

equipment editor 
The equipment configuration module of the FactoryTalk Batch 
components. The FactoryTalk Batch Equipment Configure resources, 
phases, units, and communications data. 
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equipment phase 
An equipment phase is the S88 terminology for the equipment phase 
and equipment phase interface. In FactoryTalk Batch, equipment 
phases are configured in the FactoryTalk Batch Equipment Editor as 
instances of the recipe phases. Equipment phases are bound to the 
recipe at runtime. 

 

exception handling 
Those functions that deal with facility or process contingencies and 
other exception conditions. 

 

exclusive-use resource 
A common resource that can only be used by one user at any given 
time. 

 

execution token 
A "marker" indicating a currently active step of an SFC. By definition, 
an SFC begins execution with a single Execution Token present in its 
Initial Step. When SFC execution reaches an "AND Divergence", a 
single Execution Token is split into two or more tokens, and when SFC 
execution passes through an "AND Convergence", two or more 
Execution Tokens are combined into a single token. 

 

expedited approval process 
An Expedited Approval Process can be used when you do not want to 
perform the Primary Approval Process, for example in the early stages 
of recipe design. A recipe can go through initial review using the 
expedited process. After the recipe is deemed ready, the approval 
process can be reverted to its starting point, and then the primary 
approval process is used to validate it for release to production. 

 

FactoryTalk Asset Centre 
Formerly RSMACC (Rockwell Software Maintenance Automation 
Control Center). 
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final (terminal) step 
The logical end of a sequential function chart (SFC). 

 

firing attribute 
The Firing Attribute (formerly the Acquiring attribute) has nine legal states, 
defined as follows: 

"0": Not Firing - The transition is not in the firing process. 

"1": Acquiring - The transition is in the process of acquiring resources for the 
following steps. 

"2": Binding - The transition is in the process of binding one or more of the 
following steps. 

"3": Committed - The transition is committed to the firing process, but is not 
proceeding due to either a HELD state, or the parent procedure being in 
MANUAL mode. 

"4": Stopping - The transition is waiting for one or more prior steps to achieve 
a terminal state after having been issued STOP commands. 

"5": Resetting - The transition is waiting for one or more prior steps to 
transition to IDLE after having been issued RESET commands. 

"6": Pending - The transition is waiting for one or more prior steps to 
transition into a legal state for a Transfer of Control operation. 

"7": Paused - The transition is waiting for a RESUME command or a 
return of the parent procedure to AUTO mode. 

 

first available binding 
• This is one of the ways that units are selected for binding. This is called 

late unit binding or dynamic unit allocation. When automatically 
selecting a unit for binding, the FactoryTalk Batch Server tries to use 
the unit that the recipe can acquire first. The acquired unit must 
belong to the unit class of the unit procedure step. Recipes can 
configure upstream and/or downstream dependencies defining a 
series of unit classes that a recipe requires as a recipe executes. The 
acquired unit supports the flow path to other units. 

 

formula 
A category of recipe information that includes process inputs, process 
parameters and process outputs. 
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formula value 
A value that is assigned to a parameter defined for a specific step of a 
phase, operation or unit procedure. A formula value may have a literal 
value assigned to it or it may receive a value from the next higher 
recipe level when the batch is run. 

 

global binding requirement 
A Global Binding Requirement is defined within the Equipment Editor 
for an area model, and is automatically applied to every unit 
requirement within a recipe. This saves the effort of having to 
manually add the binding requirement to every unit requirement in 
every recipe. 

 

global unit attribute 
A Global Unit Attribute is a unit attribute that has been configured to 
be automatically applied to all unit classes defined within the area 
model. This saves the area model author the effort of having to 
manually assign the unit attribute to every unit class. 

 

header 
General information about the recipe that includes the procedure 
identifier, version number, version date and the author. 

 
Human-Machine Interface (HMI) 

An application used in conjunction with the FactoryTalk Batch View to 
control the manufacturing equipment within a plant. The HMI 
software allows the operator to view actual process values and 
equipment states, such as Valve 101 = Open or TempCtrl 202 = 90° F. 

 

incremental archiving 
The Archiver, running as a Windows service, inserts records from the 
electronic batch record file into the specified database at a pre-defined 
interval. The Archiver is controlled from the FactoryTalk Batch Service 
Manager dialog box or the Windows Control Panel Services window. 
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initial step 
The logical start of a sequential function chart (SFC). 

 

input parameter 
A parameter holding a value designed to specify how a sequence or 
procedure is to execute. 

 
instance-based recipe 

Recipe that uses unit instances for the equipment requirements. 
 

key parameter 
The step parameter specified as being the one to display as part of the 
SFC in the FactoryTalk Batch Recipe Editor SFC view window. 

 

late binding 
This is a binding method where a step is bound to equipment just 
before it is used. For unit procedure steps, this is also called dynamic 
unit allocation. 

 

linear segment 
The collective set of steps and transitions bounded by a Divergence 
and a Convergence. 

 
manual mode 

The mode of a control recipe when the procedure does not sequence 
automatically. Transitions are not checked, therefore the step 
performs its assigned functions and no further action is taken without 
operator intervention. 

 

master recipe 
A type of recipe that accounts for equipment capabilities and may 
include process cell-specific information. 
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mode  

The manner in which the transition of sequential functions are carried 
out within a procedural element and the accessibility for manipulating 
the states (manually or by other control functions) of equipment. 

 

not firing 
Not Firing is a possible state of the Firing attribute of a transition. 
When the transition is in the Not Firing state, it is not in the process of 
firing and not committed to the firing process. 

 

null procedure 
A non-expandable procedure that does not refer to any logical 
definition in the area model nor any lower level recipe procedure. A 
null procedure executes automatically and plays a role in material 
loops where it is used for rebinding purposes. 

 

O-Auto mode 
The mode of a control recipe when the operator initiates all commands 
and functions. 

 
obsolete recipe 

An Obsolete recipe is a versioned recipe that has failed verification due 
to a change in the recipe's underlying area model. A versioned recipe is 
a read-only snapshot of a recipe that uses strict, system-enforced 
naming conventions. 

 

ODBC (Open Database Connectivity) 

A database connectivity standard written by Microsoft. 
 

OLE (Object Linking & Embedding) 
Method used to allow two different applications to share live 
information, which makes HMI connectivity much more robust. 
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OPC (Open Platform Communications) 
A communications protocol that provides a defined set of COM 
interfaces that in turn provide data access functions. OPC can be used 
by the FactoryTalk Batch Server as a more flexible and powerful 
alternative to the Dynamic Data Exchange (DDE) communications 
protocol when communicating with process-connected devices 
(PCDs). 

 

operation/operation level 
The operation segment of a recipe. A procedural element defining an 
independent processing activity consisting of the algorithm necessary 
for the initiation, organization and control of phases. 

 

OR (Divergence) 
A structure within an SFC that represents a decision where recipe 
control is passed to only one of the subsequent steps. 

 

owned list 
When the perspective in the Arbitration Focus window is designated 
owner, the owned list consists of all running recipes, resources and 
operators that are displayed in the Owned By portion of the 
Arbitration window. 

 

owner list 
List of all running recipes, resources and operators that displays in the 
Arbitration Focus window when the perspective is owner. 

 
owner’s perspective 

Function of the arbitration focus in which a resource or running recipe 
owns, or is requesting to own, other resources. 

 
owner’s list 

When the perspective is resource, the owner’s list is the roster of 
owners for all running recipes, resources and operators. 
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P-Auto mode 
The mode of a control recipe when the procedure is sequencing 
automatically. 

 

PCD (Process-connected Device) 
Hardware that allows the FactoryTalk Batch Server to communicate 
with the equipment in a facility. 

 

PLC (Programmable Logic Controller) 
A control device. Logic (programs) contained in the PLC read or write 
to the inputs or outputs of the field devices. Referred to as the process- 
connected device in FactoryTalk Batch documentation. 

 

parameter 
Used to allow for flexibility in the recipe creation process. Parameter 
values are used in transition conditions or for substitution of phase 
parameters. A parameter is created for these recipe levels: operation, 
unit procedure or procedure. Values are assigned when a unit 
procedure or operation step is added to a recipe. 

 
parameter deviation 

A parameter deviation exists when a parameter value is not within the 
limits defined in the recipe. 

 

parameter expression 
An arithmetic expression that may be assigned to an input parameter 
or output parameter of a phase, operation, or unit procedure step that 
can reference other parameters and recipe header data within a recipe. 
The expression is evaluated and the result stored as the value of the 
parameter. 

 
path (stream) 

The order of equipment within a process cell that is used, or is 
expected to be used, in the production of a specific batch. 
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paused 
Paused is a possible state of the Firing attribute of a transition. When 
the transition is in the Paused state, it’s expression has evaluated to 
TRUE and it is ready to fire. It is suspended the firing process due to 
the parent procedure being in SEMI-AUTO mode. It is awaiting either 
a RESUME command or a transition of the parent procedure to AUTO 
mode before continuing with the firing process. 

 

pending 
Pending is a possible state of the Firing attribute of a transition. When 
the transition is in the Pending state, it is waiting for one or more 
prior steps to transition into a legal state for a Transfer of Control 
operation. 

 

phase 
 
 
The lowest level procedural element in the procedural control model. 
The phase provides an interface to basic control. 

 

phase link group 
Group that identifies phases that may communicate and work 
together. 

 

phase state 
Term that appears inside the State Frame declaring the phase’s current 
condition: IDLE, READY, RUNNING, ARMING, ARMED, FIRING, 
CONNECTING, DOWNLOADING, UPLOADING, UPLOADHELD, 
STARTING, COMPLETE, HOLDING, HELD, RESTARTING, 
STOPPING, STOPPED, ABORTING, ABORTED or UNKNOWN. 

 

primary approval process 
A full and formal approval process to validate the development and 
maintenance of batch recipes. In addition to the Primary Approval 
process with up to six approval steps (three optional), a two-step 
Expedited Approval process is available. 
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procedure/procedure level 
The procedure segment of a recipe, such as the strategy for 
accomplishing a process. Procedure level is a general term for the three 
segments of a recipe: operation, unit procedure, and procedure. 

 

procedural control 
Control that directs equipment-oriented actions to take place in an 
ordered sequence to carry out a process-oriented task. 

 
procedure file 

The saved file of a completed recipe. 
 

procedural element 
A building block for procedural control that is defined by the 
procedure model. 

 

process 
A sequence of chemical, physical or biological activities for the 
conversion, transport or storage of material or energy. 

 

process cell 
A logical grouping of equipment, which includes the equipment 
required for the production of one or more batches. The process cell 
defines the span of logical control of one set of process equipment 
within an area. 

 

process control 
The regulation or manipulation of variables (output) influencing the 
conduct of a process (or part of a process) in such a way as to obtain a 
product of desired quality and quantity (set point) in an efficient 
manner. 

 

process management 
The activities necessary to manage batch production within a process 
cell. 
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process operation 
A major processing activity that usually results in a chemical or 
physical change in the material being processed and that is defined 
without consideration of the actual target equipment configuration. 

 

providers 
System components that provide diagnostic information to the 
FactoryTalk Diagnostics system. Providers can be FactoryTalk system 
elements or applications such as the FactoryTalk Batch Equipment 
Editor and FactoryTalk Batch Recipe Editor. 

 

recipe approvals process 
An umbrella term for the Primary approval and Expedited approval 
processes that are used to validate the development and maintenance 
of batch recipes. (Only one process can be used at a time.) Using 
signature certification, the recipe approvals process safeguards design 
workflow in a formalized manner. This ensures each recipe is validated 
by authorized personnel before being released to production. 

 

recipe directory 
Directory of saved recipes. 

 

Recipe Editor 
The master recipe building application of the FactoryTalk Batch 
system. The FactoryTalk Batch Recipe allows the user to perform recipe 
management. 

 

recipe formula parameter 
A parameter specific to a recipe. A parameter can be used to pass 
values from one level of a recipe to the next lower level. A recipe 
formula parameter is configured in the FactoryTalk Batch Recipe 
Editor on a procedure or operation step. Recipe parameters can be 
deferred to recipe formula parameters. 
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recipe management 
The control activity that includes creating, editing, storing and 
retrieving general, site and master recipes. 

 

recipe parameter 
A parameter specific to a recipe. A parameter can be used to pass 
values from one level of a recipe to the next lower level. A recipe 
parameter is configured on the recipe phase and downloaded to the 
equipment phase at runtime. 

 

recipe phase 
A Recipe Phase is the S88 terminology for the lowest level of procedural 
element in the procedural control model, which is in a master or 
control recipe. In FactoryTalk Batch, recipe phases are configured in 
the FactoryTalk Batch Equipment Editor and used to build recipes in 
the FactoryTalk Batch Recipe Editor. 

 

recipe verification 
A function of the FactoryTalk Batch Recipe Editor, recipe verification 
performs a set of error checks on a recipe. 

 

recipe version control 
When Recipe Version Control is enabled in an area model, a versioned 
recipe is created with the File > Check in command in the FactoryTalk 
Batch Recipe Editor. A versioned recipe is a read-only snapshot of a 
recipe that uses strict, system-enforced naming conventions. Editable 
copies of versioned recipes are created using the File > Check out 
command in the FactoryTalk Batch Recipe Editor--these are called WIP 
(work-in-progress) recipes. If the area model that underlies a 
versioned recipe changes, the recipe becomes an Obsolete recipe. 

 

reference list 
The list of all container recipes with steps that reference a specified 
recipe retrieved when using the Find Recipe References option. 
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reference recipe 
The operation or unit procedure referenced in container recipes 
searched when using the Find Recipe References option. 

 

release 
Function in the arbitration process that allows the operator to release a 
resource that is currently owned by the operator. 

 

release recipe as step 
A property of a recipe that signifies it is approved for release as a step, 
procedure, or operation to be used in a larger, more complex recipe. A 
recipe can only be added to the Batch list if all its children recipes have 
their Release Recipe as Step properties checked (set to true). 

 
release recipe to production 

A property of a recipe that signifies it is approved for release to 
production. When this property is true, the recipe is shown on the 
Recipe List in FactoryTalk Batch View, eProcedure, or ActiveX controls. 
When all aspects of the recipe are verified and all steps are marked as 
Release Recipe as Step, batches can be created against the recipe. 

 
report aggregation - batch 

In the Recipe Editor, a report parameter (output) that is defined to add 
each uploaded value to the report to its current value and store that 
value for the duration of the batch. 

 

report aggregation - none 
In the Recipe Editor, a report parameter (output) that is defined to 
store an uploaded value, overwriting any value previously there. This is 
the behavior of report parameters in versions before FactoryTalk Batch 
11.0 and is still the default behavior. 

 

report aggregation - phase 
In the Recipe Editor, a report parameter (output) that is defined to add 
each uploaded value to the report to its current value and store that 
value until the phase is reset. 
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report parameter 
A value specific to a phase. It is a value that is passed from the process- 
connected device (PCD) to the FactoryTalk Batch Server where it can 
be used in reports. Typically, the report parameter is a process value. 

 

requested list 
When the arbitration focus is in the owner perspective, this list 
displays the roster of resources requested by the resource or recipe that 
is identified in the Name box. 

 
resetting 

Resetting is a possible state of the Firing attribute of a transition. 
When the transition is in the Resetting state, it has issued RESET 
commands to the preceding steps and is waiting for them to transition 
to IDLE states in response to the command. 

 

resource 
A general term for equipment including process cells, units, phases, 
and shared control modules. 

 
resource’s perspective 

Function in the Arbitration Focus window that allows the viewing, 
acquiring or releasing of resources or running recipes that currently 
own or are requesting to own a selected resource. 

 

resource list 
When the perspective is resource in the Arbitration Focus window, the 
roster of resources is the resource list. 

 
resource user 

An object that either owns or is requesting to own a resource. Can be 
the operator, a running recipe or another resource. 
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resource 
A general term for equipment including process cells, units, phases, 
and shared control modules. 

 

scalable 
Located in the Recipe formula parameter list, this field indicates if the 
parameter is scalable with the scale of the recipe. 

 

semi-Auto mode 
The mode of a recipe level or phase that allows the operator to 
manually step through the recipe level or each line of the phase’s 
program. This mode requires that the transitions be programmed to 
check the phase’s paused bit. Each time the Resume button is pressed, 
the paused bit is reset. 

 

sequential function chart 
Sequential Function Chart is a graphical programming language that 
defines the logical flow of the recipe’s procedure. 

 

sequential function chart step 
The structure in the SFC that references a subordinate phase or 
procedure. 

 

server 
 
 
A software application that communicates with another software 
application (the client). The server normally supplies data or functions 
to the client. The FactoryTalk Batch Server is both a client and a server. 
When communicating with the FactoryTalk Batch View component, 
the FactoryTalk Batch Server acts as the server; when communicating 
with a data server, it acts as the client. 

 

service 
A process that performs a specific system function, but that does not 
include a graphic user interface. Services often include an application 
programming interface that can be called by other processes and 
remotely from other computer nodes. 
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service manager 
A software application that allows a user to remotely monitor and/or 
control Windows services. The FactoryTalk Batch Service Manager 
allows an operator to control all batch-related services, as well as access 
the Server Statistics dialog box. 

 

SFC 
 

 
Sequential Function Chart. 

 

SFC validation 
A function of the FactoryTalk Batch Recipe Editor, this error check 
looks for "logic" errors in the SFC structure defined within a recipe. 

 

shared resource 
A resource used in parallel by an unlimited number of steps at a time 
inside a recipe structure. 

 

shared-use resource 
A common resource that can be used by more than one user at a time. 

 

simulator 
The FactoryTalk Batch phase logic simulation program allows you to 
run the FactoryTalk Batch components and simulate your batch 
process without being connected to a PCD. The simulator can be used 
for testing, experimentation and demonstration purposes. 

 

site 
 

 
A component of a batch manufacturing enterprise that is identified by 
physical, geographical or logical segmentation within the enterprise. 

 

state 
 
 

The condition of equipment or a procedural element at a given time. 
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static binding 
A binding method where a step or set of steps is bound to equipment 
when the recipe is built in the FactoryTalk Batch Recipe Editor 
(equipment bindings are specified in the master recipe). Material 
phase steps are never statically bound. 

 

step reference 
A step within a container recipe that is configured to reference an 
operation or unit procedure specified when using the Find Recipe 
References option. 

 

stopping 
Stopping is a possible state of the Firing attribute of a transition. 
When the transition is in the Stopping state, it has issued STOP 
commands to one or more of the preceding steps and is waiting for 
them to transition to terminal states. 

 

subarbitration 
The process of arbitrating the use of a dedicated resource required by 
phases operating in parallel within a control recipe. 

 

tag 
 
 

A named area of the process-connected device or controller’s memory 
where data is stored. It is the basic mechanism for allocating memory, 
referencing data from logic, and monitoring data. 

 

terminal (final) step 
The logical end of an SFC. 

 

transition 
Defines how recipe control moves from step to step. When a step is 
complete, the transition designates the criteria that must be met 
before the recipe continues to its next logical step. 
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unacknowledged prompt parameter 
A step parameter directed to prompt the operator for data when a 
phase requests a download. 

 

unit 
 
 

A collection of associated control modules and/or equipment modules 
that can carry out one or more major processing activities such as 
react, crystallize, make a solution, etc. 

 

unit-based recipe 
A recipe that specifies a specific unit for equipment requirements. 

 

unit class 
A means of categorizing units into groups of similar or identical sets of 
equipment. Recipes can be written specifying a unit class (class-based), 
or a specific unit (unit-based). 

 

unit procedure/unit procedure level 
A production sequence (consisting of contiguous operations and 
algorithms necessary for the initiation, organization, and control of 
those operations) executed within a unit. The unit procedure level is a 
general term for the level that contains unit procedures in a recipe. 

 

upload 
A request from a phase to send data to a batch server. 

 

verification limits 
Verification limits are the values against which a recipe parameter or 
report value are checked. Three types have been identified: Absolute, 
Percentage, and Value. 

 

verification method 
An algorithm specified in the equipment editor associated with each 
parameter or report parameter. The algorithm specifies what set of 
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limits are used for each parameter. For example: High-High-High/ 
Low-Low-Low, High-High / Low-Low, High / Low or None. 

 
verification policies 

The verification policies specify the actions that are taken if an entered 
parameter or report parameter is outside the specified verification 
limits. The current options are: none, require confirm, single 
signature, dual signature and not allowed. 

 

verification signature 
A new type of prompt that is used to display the deviation information 
and request the confirmation or signatures required according to the 
configured verification policies. 

 

verify recipe 
Process in which a recipe is checked for completion and accuracy. 

 

versioned recipe 
A read-only snapshot of a recipe that uses strict, system-enforced 
naming conventions. When Recipe Version Control is enabled in an 
area model, a versioned recipe is created with the File>Check in 
command in the FactoryTalk Batch Recipe Editor. See also WIP (work- 
in-progress) recipe and Obsolete recipe. 

 

view 
 

 
The recipe execution application of the FactoryTalk Batch components. 
The FactoryTalk Batch View allows the operator to create and run a 
batch, control phases, arbitrate resources, and view event data. 

 

WIP (work-in-progress) recipe 
An editable copy of a versioned recipe. When Recipe Version Control is 
enabled, a WIP copy is created. 
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At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation support 
Use these resources to access support information. 

 

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 
updates. 

rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and 
find associated firmware. 

rok.auto/pcdc 

 
 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

 

Waste Electrical and Electronic Equipment (WEEE) 
 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 
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